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Introduction to TS/PP-Draft

TS/PP-Draft is a work-sheet for drafting Time-Space, Platoon-Progression, or Time-Location
diagrams.  Using TS/PP-Draft you can quickly develop either type diagram for an artery, a set of intersecting
arteries, or a signalized network.  You may view the entire diagram or set of diagrams in high resolution on
the screen at once.  You can easily adjust any parameter (Cycle Length, offset, Phase Sequence, Splits,
scales, green bands, volumes, etc.) for any intersection as often as desired.  TS/PP-Draft accommodates any
number of intersections and arteries (limited only by available memory), double or half cycling, English or
metric units, nine different Offset Reference Points, and all phase sequences: two-phase, leading protected
turn phases, lagging protected turn phases, permitted turns, and lead-lag combinations.

You may plot diagrams, copy them to the Windows clipboard, or print them out along with a report
of the timing parameters necessary to implement it.  Diagrams can be saved for future reference.  TS/PP-
Draft can import and export UTDF files (for sharing files with Synchro and traffic signal control systems
from Naztec, Gardner, Eagle, and Peek) and it may integrate with TEAPAC via PRETSPPD, both available
from Strong Concepts (www.StrongConcepts.com).

By connecting a GPS receiver to your computer, TS/PP-Draft can read the current position and speed
information.  This can be used to record trip logs and prepare comparative travel time and delay reports.  Trip
logs may be plotted  as trajectories on the diagram, and you may create speed vs. distance plots from trip
logs.

TS/PP-Draft requires Windows 98, Windows ME, or Windows NT 4.0 or greater, or Windows 2000
or Window XP.

If you have any suggestions, questions, problems, or comments about the program, please call or
write:

Greg Bullock
757 Bayview Avenue
Pacific Grove CA 93950-2508  USA
(831) 642-9641
bullock@tsppd.com
www.tsppd.com
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License Information

The licensing information is in the License Information dialog box, available by selecting the About
command from the Help menu, then clicking the "License" button.  The information includes

the License Terms,
the "Licensed To" name, and
the License Number.

In order to have full access to all the features of TS/PP-Draft, you must enter both the "Licensed To"
and the License Number.  Be sure to enter both of these exactly as they were provided to you, including any
spaces, punctuation, and upper or lower case letters but without the quotation marks.

If you have already purchased a full license, the Licensed To name and the License Number are on
the cover letter included in the TS/PP-Draft packet mailed to you.

If you haven't already purchased a full license you may get a free, evaluation license (which allows
you to run TS/PP-Draft without restrictions for a limited time), by e-mailing license@tsppd.com or by calling
831-642-9641.

If there is no license information entered, or if the information is invalid, TS/PP-Draft will run in
"Demonstration Mode," which means you will not be able to save any of your files, import or export UTDF
files, or share files with TEAPAC.
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Getting Started

To install TS/PP-Draft, run the SETUP program on the installation disk.  The SETUP program will
let you choose the subdirectory where you wish to install TS/PP-Draft and will include uninstall information
to help you remove TS/PP-Draft and undo the changes SETUP made to your system.

After installing TS/PP-Draft, you may run the program by double clicking (using the left mouse
button) on the TS/PP-Draft icon.

There are a few things you’ll want to do when you run TS/PP-Draft for the first time:

• You should enter your license information in the License Information dialog box, available by
selecting the About command from the Help menu, then clicking the "License" button.  If there is
no license information entered, or if the information is invalid, TS/PP-Draft will run in "Demonstra-
tion Mode," which means you will not be able to save any of your files,  import or export UTDF
files, or share files with TEAPAC.

• You should verify that the “Drive Rule” is set properly (to either left-hand side or right-hand side,
depending on which side of a two-way road traffic uses in your region) in the Layout page of the
Preferences dialog accessible from the View menu (see page 127).  The default is right-hand side,
which is appropriate for North and South America, China and continental Europe.  If traffic drives
on the left in your region, you should set the Drive Rule before creating any of your own diagrams.

• You may want to load the example diagram files, typically in the folder 
C:\Program Files\TS-PP-Draft\Samples

to inspect the parameters of the diagrams to get a feel for how TS/PP-Draft works.  How to do this
is described in the following chapters.
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Operating TS/PP-Draft

To run TS/PP-Draft, click the Start Button (usually in the lower left corner of your screen), then
choose the Programs menu and find the TS-PP-Draft submenu.  From there, select the TS/PP-Draft icon.

Pull Down Menus

TS/PP-Draft uses a pull down menu system.  The top menu is a horizontal bar with a few commands
that can be performed.  You use the mouse to select and click on a command to execute it.  This pulls down
a vertical menu in a window, and you again select and click on command with the mouse.  You can also
select an item in the top menu by pressing the first letter of the item by itself or while holding down the Alt
key.  

The Help System

TS/PP-Draft features an on-line, context-sensitive, cross-referenced, indexed help system.  In it,
you'll find explanations of every feature of TS/PP-Draft.  To get help on any item in TS/PP-Draft, simply
move the cursor to that item and press F1.  Or use the commands under the Help Menu to view the Help
Contents or to search the Help Index on a topic.

The help system is cross-referenced.  When an explanation refers to items that are explained
elsewhere (as separate help topics), the references are displayed as underlined, green text.  Left click on a
cross-referenced item to get help on that item.
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Creating a Network

In TS/PP-Draft, the fundamental concept is the arterial diagram, which includes two or more signalized
intersections.  Consequently, TS/PP-Draft views a signalized network as a series of intersecting arteries, each
represented in its own diagram window.

Below are the steps to create a signalized network in TS/PP-Draft.  You may choose between three different
possible starting points, depending on what you already have: 
• nothing, 
• a single diagram file for one of the arteries in the network, or
• multiple diagram files, each for a different artery in the network.

Starting from nothing:

1 Click the  button on the Tool Bar or the New command under the File Menu to create a blank
diagram for the first artery.  You'll be prompted to enter the number of signalized intersections along
this artery.  It isn't necessary for now to set the signal timing parameters at each intersection, but you
may do so in the  Intersection Parameters window if you wish.

2 In the  Diagram/Arterial Parameters window, set the Forward Direction or Orientation of the
diagram.  Proceed to Step 4.

Starting from a single diagram file for one of the arteries in the network:
3 If you already have a diagram file representing an artery in the network, open that file and use it as

a starting point.  In this case, you might want to use Save As... in the File Menu and give the open
diagram file a new name so you don't overwrite the original file.

4 Open the Outline View by clicking on

the  in the Tool Bar or by selecting
the Outline View command under the
View Menu.

5 Select the first (and only) diagram/artery

in the arterial outline list, then click the 
button to add a new diagram/artery.  Be
sure you first collapse the diagram/artery
(so that its intersections are hidden)
before clicking this button, as you will add a new intersection, instead of a new diagram/artery, if
it's expanded.
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6 In the  Diagram/Arterial Parameters window, set the Forward Direction or Orientation of the
newly added diagram.

7 Repeat Step 5 & 6 for each artery in your network.

8 Click the   button to expand all diagram/arteries so their intersections are visible.
9 For each unnamed artery or intersection, click the item once to select it, then a second time to

rename it. Give each item a meaningful name, typically the name of the artery or cross street.
Proceed to Step 13.

Starting from multiple diagram files, each for a different artery in the network:
10 If you already have a diagram file representing each (or more than one) artery in the network, choose

one diagram file to be the first artery, open that file and use it as a starting point.  You might want
to use Save As... in the File Menu and give the open diagram file a new name so you don't overwrite
the original file.

11 Merge the diagram file for the second artery by using the Merge command on the File Menu.
12 Repeat Step 11 for each additional artery in the network.

13 At this point, there is a diagram for each artery in your network, but the diagrams are not yet linked
together. For linking two diagrams together at their common intersection, it's usually best to collapse
all but the two diagrams (so that their intersections are hidden) in the arterial outline list.  If there

are many arteries, you might want to click the   button then click the [+] icon in front of each of
the two diagrams to expand just those two.

14 Identify the common intersection in each of the two diagram/arteries. Select it in one of the dia-
gram/arteries and drag it to the other one to establish a link between them.  If the intersection in one
of these diagrams does not have correct signal timing information (typically because it was created
in Step 5) and the other does, then select first the correct-timings intersection and drag it to the
incorrect one.  This will ensure that the correct timings are preserved as the link is established.

15 You'll have a choice of which type of
link to create.  By default, "Offsets
Only" will be selected, but change this to
"Everything" before clicking the OK
button.

16 Repeat Steps 13 - 15 for each of the
intersecting arteries in the network.

17 You now have at least the skeleton of a
signalized network. Some of the inter-
sections, notably those created in Step 4,
may not have the correct parameters yet.
Edit the Diagram/Aterial Parameters and
Intersection Parameters as needed to
complete the network. For the most part,
intersections that are linked between diagrams (because they're common to two crossing arteries)
may be edited in either diagram, and the parameter changes will automatically appear in both
diagrams. An exception is the Green Band Action, which affects only the diagram with that
intersection but not the diagram with the crossing artery.
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How to Perform a Travel Time and Delay Study

The following tutorial gives a step by step example of how to create a Travel Time and Delay Report
from scratch.  It is assumed that you
• have a portable computer with TS/PP-Draft installed,
• are already familiar with how to create a diagram for an artery or a set of intersecting arteries,
• have a compatible GPS receiver, but
• don't yet know how to operate TS/PP-Draft with a GPS receiver.

The order in which some of the steps are performed is not critical.
For example, you could perform steps 1, 2, 3, and 4 in any order.
Nonetheless, the steps are presented in an order that works fine for most
purposes.

1. Create a diagram window for the artery you wish to study, or open
an existing diagram data file for this artery.

2. Travel to one of the intersections along this artery, taking the
portable computer and GPS receiver with you.

3. Connect an RS 232 cable from your GPS receiver to the serial port
of your laptop.

4. Click the  button on the Tool Bar to open the GPS Tracking
view.
5. In the Setup page, specify the type of GPS receiver you have and

the serial port to which it is connected.  The default values for the
other setup parameters are usually ok.

6. Click the  button or say "Start GPS" (if

 voice command recognition is enabled) to initialize the GPS
receiver.  The status on the Position page will soon change from
"Not Connected" to "Searching for Fix" and eventually to

"Tracking."  This may take anywhere from a few seconds to a few
minutes, depending on what type of GPS receiver you have, how far you
are from where you last used the GPS receiver, and how long it has been
since you last used it.
7. While you're waiting for the GPS receiver to start tracking, you

may monitor the progress on the Satellite page, which shows the
current status of the signals from the GPS satellites currently
visible in the sky and their current position.  Once the GPS
receiver begins tracking, TS/PP-Draft will check your computer
systems clock and offer to update it if necessary.  This offer is
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merely a courtesy to you.  Nothing involved in tracking
trips and preparing travel time and delay reports re-
quires that your computer system have an accurate
clock.

8. Open the  Intersection Parameters for the
intersection you've traveled to.  Click the

 button to open the list of Geo-
graphic Coordinates measurements.
9. Stand at each corner of the intersection and

click the  button to
add the current GPS coordinates to the list of measurements.  

10. Travel to the next intersection in the artery, repeating steps 8 and 9 for each intersection in the artery.
Note that it is also possible to perform these steps while in a moving vehicle.  For example, you can
drive the artery in both directions, opening the Intersection Parameters and clicking the

 button or say "Mark Point" (if  voice command recognition is
enabled) as you cross the stop bar at each intersection.  But it is safe to do
so only if you're not driving the vehicle at the same time as you're

operating the portable computer.  Using  voice command recognition
here improves safety and saves time.

11. Close the Intersection Parameters, and open the  Network
View.
12. Right click anywhere on the Network View and choose "Layout
Grid with GPS" from the pop-up menu.
13. At this point, you may see a marker in both the Network View

and on the top-most diagram window indicating your current
position along the artery; however, the time-offset of this marker in the diagram will not be accurate
until after you perform the next step.

14. Synchronize the traffic signals clocks with that of the GPS
satellites using the controls on the Clocks page.  First, specify the
signal with the phase you'll be observing by choosing from the drop
down lists the Artery and Intersection of the signal you're watching.
Then indicate the phase transition (start of Green, Flashing Don't
Walk, Yellow, or Red) and the phase and direction of travel at the
signal.  This should be a phase and transition whose occurrence is
not sensitive to whether a movement "gaps out."  Typically, this is
the yield point of the synchronized phase.  I prefer the start of a red,
so when I see the start of a yellow it alerts me that the synch point
is about to arrive.  Once these are specified, click the

 button or say "Synchronize Now" (if 
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voice command recognition is enabled) when you see the phase transition occur.  If any of the intersections
in any of diagrams is operating at double cycle length, you should synchronize the clocks using a phase of
one of those intersections.

15. When you're ready to record a trip through the artery, click the  button on the

Trip Logs page or say "Start Trip" (if  voice command recognition is enabled) to begin a trip
log.  Although a single trip may comprise multiple runs through more than one artery, you'll have
more flexibility later if you make a separate trip log for each run.  I recommend you start the
recording at least 6 to 8 seconds before entering the first intersection.  Even sooner to be safer.
There's no real penalty for beginning the recording too early.

16. Click the  button or say "Stop Trip" (if  voice command recognition is
enabled) to end the current trip log.  I recommend stopping the recording at least 6 to 8 seconds after
passing through the last intersection.  Even later to be safer.  You'll see the newly recorded trip
appear at the end of the list on the Trip Log page.

17. Right click on the new trip log in the list and choose "Rename Trip" from the pop-up menu.  Give
the trip log a descriptive name such as "EB, moderate traffic, before offset adjustment".

18. Repeat steps 15 - 17 as often as desired.

19. Click the  button on the Tool Bar to create a Travel Time and Delay Report (page 55) from the

trip logs you've recorded for the artery.  Click the  button to make Plots of Speed vs. Distance
or Travel Time vs. Distance.  You may choose which Trip Logs to include in the report or plot from
a list of trip logs involving the selected diagram/artery. 

See How Trip Logs are Processed (page 131) for additional comments and definitions.
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Figure 27. A sample diagram.  The numbered regions are discussed in the text.

Diagram Windows

A diagram window is a window which contains any type of diagram. It is the fundamental window
of TS/PP-Draft.

To provide support for signalized networks or multiple intersecting arteries, TS/PP-Draft allows you
to have multiple diagram windows.  You may have virtually any number of diagram windows, each
containing a particular type of diagram for a particular artery.  The diagram windows have different sizes and
horizontal and Vertical Scales, or you may have TS/PP-Draft maintain synchronized scales across all diagram
windows.

When you have two (or more) diagram windows representing intersecting arteries, you should
establish a link between the common intersection(s) so TS/PP-Draft can ensure that the intersection
parameters remain consistent.
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A cross-traffic turn is a 
1

• left-turn in right-hand Drive Rule regions (North & South America, China and continental Europe).
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With the belief that a picture is worth a thousand words, we'll use Figure 27 to explain how TS/PP-
Draft draws diagrams.  The numbered ("#") regions are described below the figure.

#1 The diagram/arterial name, cycle length, current time and date.
#2 Beginning of network cycle (Offset=0 line).
#3 Timer Markers: regular tic marks or grid lines (as specified in the Preferences: Layout

dialog).
#4 Intersection names and their corresponding offsets on alternating lines to reduce crowding.
#5 Red signal for arterial through traffic (both directions), green signal for side street.
#6 Red signal for right-bound, arterial through, green for left-bound through and cross-traffic-

turners.1

#7 Green signal for arterial through traffic in both directions along artery.
#8 Red signal for left-bound, arterial through, green for right-bound through and cross-traffic-

turners.
#9 Green signal for arterial cross-traffic-turners (both directions), red for through traffic.

The size and weight of the character font for the various text on the diagram may be set along with
other parameters in the Diagram/Arterial Parameters dialog.
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Figure 28 An example of a Time-Space diagram.

On Time-Space diagrams, the green bands are drawn as dotted, diagonal lines (shown in Figure 28).
At your option, the various Design Speeds may be shown explicitly.
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Figure 29 An example of a Platoon-Progression diagram.

On Platoon-Progression diagrams, the area between the intersection strips is filled in to show the
platoons and queues (as shown in Figure 29).  The dot density corresponds to the vehicle density.  Drawing
the platoons and queues is slower than drawing the green bands, and can take a long time (more than 4
minutes) depending on the complexity of the artery and your computer system.

On  Time-Location diagrams, the green bands are drawn as dotted, horizontal lines, and the
Horizontal Scale has no meaning other than to indicate the sequence of the intersections.  This is
accomplished by artificially offseting each ring in the signal timing strip by the travel time from the upstream
intersection in the direction of travel corresponding to that ring.  This effectively removes the meaning of
"Space" in the Time-Space diagram, and the diagram is then collapsed so the intersections are displayed with
a small, uniform spacing, independent of the true distance between intersections.  For this type of diagram,
it's best to choose a Vertical Scale such that at least 4 cycles are visible in the diagram.  The lower half of
the diagram shows the signal rings and bands corresponding to the forward-bound traffic (from left to right
on the screen), and the upper half shows the rings and bands corresponding to the reverse-bound traffic.  At
your option, the various Design Speeds may be shown explicitly.
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Note that in Figure 27, Park Avenue has no protected cross-traffic-turning  movement in the right-2

bound direction, and a leading protected turning movement in the left-bound direction.  Lincoln Blvd. has
leading protected turning movements in both directions of travel.  Ridge Drive has no protected turning
movement in the left-bound direction, and a lagging protected turning movement in the right-bound direction.

Understanding the Diagram Symbols

The vertical strips above the intersection names show the color of the signal along the artery for each
direction of travel.  The solid lines represent red time (green for the cross street), and the clear sections
represent green time.  Thus, you can think of the lines that you can see as barriers to the through traffic.

If the diagram is not on a one-way street, then each strip is constituted of two vertical stripes.  The
stripe on the left (right) represents the signal that the traffic moving to the right (left) sees.  Thus, the traffic
for each direction of travel "sees" only the side of the strip that is closest to it.

If, at a particular intersection, the traffic moving to the right has a protected cross-traffic-turning2

movement but the traffic moving to the left has none, then on the signal strip of that intersection, the stripe
on the left will be shorter than the stripe on the right, as indicated by region #8 in Figure 27.  The additional
red time for the left-bound traffic represents the interval of time during which the right-bound turners are
completing their movement.  The other protected turn Phase Sequences may be interpreted in a similar way.

If the protected turn Phase Sequences for both directions of travel are "Lead" or "Lag", the signal
strip will have a section that is comprised of zig-zag or hatched lines (region #9 in Figure 27).  These
represent the interval of time during which the cross-traffic-turners  on the artery complete their movement.2

As a convenience, these intervals are thus distinguished from those in which the cross street has its green
time.  This feature is helpful in systems running on actuated controllers because if the turning volumes are
small, you may choose to optimize the signal timings with the assumption that the turning phases will "gap
out" early.  In this case, you need to be able to see the cross-traffic-turning  intervals on the diagram.2

If you wish, TS/PP-Draft can display the Splits (and optionally, the Minimum Splits and Splits
Units) next to each phase along with a small arrow to indicate the movement using that phase.  See the
Layout page of the Preferences dialog for more information (page 119).

On the diagram, TS/PP-Draft draws horizontal lines (labelled as #2 in Figure 27) representing the
moments in time at which the Offset is zero for intersections not operating at double the network Cycle
Length.  Thus, the distance between these lines is equal to the network Cycle Length.

On the left and right edges of the diagram, TS/PP-Draft draws tic marks or grid lines representing
regular intervals (determined by the Seconds Per Mark parameter).  These are labelled #3 in Figure 27.
You may set your choice of tic marks or grid lines in the Layout page of the Preferences dialog (see page
119).
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If you have any recorded Trip Logs with a GPS receiver (see page 34), they may be plotted on the
diagram as trajectories, graphically showing where delay occurred, which signals you stopped at, how long
the queue was, and where you entered or left the green bands or platoons.  If you observe any spurious
points in any of the trip logs, you may manually delete these points by carefully pointing to them with the
mouse cursor, then clicking Alt + right-button.  You may also use the Trip Log Filter (page 41) to
automatically identify and remove spurious points.

TS/PP-Draft places the name of the diagram, cycle length, and the current date and time across the
top of the diagram (region #1 in Figure 27).  If you prefer, you can suppress the date and time in the Layout
page of the Preferences dialog (page 119).

Finally, TS/PP-Draft places the name of each intersection below the corresponding signal strip
(region #4 in Figure 27).  If the names of the intersections are too long or the intersections are too close
together, then TS/PP-Draft will write the name of one intersection on top of that of another.  To reduce the
likelihood of this occurring, TS/PP-Draft places the names of adjacent intersections on alternating lines.
You may zoom in on a section of the diagram to further resolve regions that are crowded by left-dragging
to select a group of intersections.  When zoomed in, think of the diagram or plot as spanning multiple

"pages."  Page Up  & Page Down  jump to the next page.
Below the intersection names, TS/PP-Draft may place the intersection offset, as specified on the

Layout page of the Preferences dialog (page 119).
You may independently select the weight and size of the fonts TS/PP-Draft uses for drawing the

various text in diagram in the Diagram/Arterial Parameters dialog.
Caution!  On Platoon-Progression diagrams, if the queue at an intersection backs up beyond the

upstream intersection, then usually the flow and queues on the Platoon-Progression diagram will be
inaccurate.  The flow and queue can still be accurate if the queue backs up into the upstream intersection 

(1) during the green time of the upstream intersection, and 
(2) when there are no vehicles leaving the upstream intersection.  

The second restriction means that when the queue backs up into the upstream intersection, there are no
vehicles arriving at the upstream intersection and there is no queue waiting at the upstream intersection.
These criteria are strict, so a queue backing up into the upstream intersection usually indicates that you
should not trust the diagram.  Unless you are sure these criteria are met, you should either adjust the timing
parameters of the diagram to prevent the back up, adjust them to allow plenty of time for the backed up
queue to clear, or not use a Platoon-Progression diagram at all for that artery.

Add diagram window

Use the  button on the Outline View to create a new diagram window, in which you can place a diagram
of any type for any artery.  To add a new diagram/artery to the currently open diagram data file,

(1) Collapse the diagram/artery after which you wish to add a new diagram/artery (so that its
intersections are hidden), then

(2) Select the diagram/artery after which you wish to add a new diagram/artery, and press the 
button.
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Delete diagram window

Use the   button on the Outline View to delete a diagram window.  You may also delete a diagram or an
intersection (and save it to the Windows Clipboard) using the Cut command under the Edit Menu.  When
you delete a diagram window, TS/PP-Draft automatically breaks any links to intersections in that window.

Deleting one of the interior intersections (not one of the boundary intersections) causes TS/PP-Draft
to reset the Distance between the intersections on either side of the one deleted so that the arterial length is
unchanged.

Deleting one of the boundary intersections of the diagram causes TS/PP-Draft to reset the Offset,
Width, and Design Speed of any green band that begins at that intersection. TS/PP-Draft also recalculates
the optimal Horizontal Scale (if it is unlocked) and the Distance to the first intersection from the left margin.

Duplicate diagram window

Use the  button on the Outline View to duplicate the diagram from one diagram window and
place it in another.  You may also copy a diagram to the Windows Clipboard using the Copy and Paste
commands under the Edit Menu.

When you duplicate a diagram window, TS/PP-Draft offers to link the duplicated intersections to

the originals.  Answer Yes if you wish to maintain two different  types of diagrams for a given artery in
two separate diagram windows.  If you answer No, TS/PP-Draft then offers to link any intersections in the
original diagram window that are linked to intersections in other diagram windows.

Tile diagram windows

Use the Tile command of the Window menu to arrange all visible diagram windows (setting their
margins and sizes) such that they fill the screen without overlap.

Editing in diagram windows

You may edit some Diagram/Arterial Parameters directly in the Diagram Window.  You may edit
the Adjusted Cycle Lengths, Offsets, protected Turn Phase Sequences, and Green Band Actions of the
selected intersection while studying the diagram and noting the possible improvements.  This feature greatly
simplifies the task of optimizing these parameters.

The following table lists the ways in which you may edit parameters directly on the Diagram
Window.
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Key Mouse Action

Up Left “drag”
(over signal)

Raise the Offset a moderate amount.

Down Left “drag”
(over signal)

Lower the Offset a moderate amount.

Alt-Up Left “drag”
(over signal)

Raise the Offset a small amount.

Alt-Down Left “drag”
(over signal)

Lower the Offset a small amount.

Ctrl-Up Left “drag”
(over signal)

Raise the Offset a large amount.

Ctrl-Down Left “drag”
(over signal)

Lower the Offset a large amount.

Ctrl-L Change the Adjusted Cycle Length.

Ctrl-P Change the protected Turn Phase Sequence.

Ctrl-F Change the forward- or right-bound Green Band Action.

Ctrl-R Change the reverse- or left-bound Green Band Action.

Left “drag”
(starting and
ending
between sig-
nals)

Zoom in the horizontal scale of the arterial diagram to view
the selected signal(s).  This creates a multi-page diagram.

Left “drag”
in reverse
(from right
to left).

Zoom out the horizontal scale of the arterial diagram to view
the entire artery. This creates a single-page diagram.

Page Up Jump to the previous page of a multi-page arterial diagram.

Page Down Jump to the next page of a multi-page arterial diagram.

Right Click Use pop-up menu to select the Type of Diagram (Time-Space,
Platoon-Progression, or Time-Location) or any of the above
mentioned options as well as other options.

On Time-Space or Time-Location diagrams, changing the Offsets, protected Turn Phase Sequences,
or Adjusted Cycle Lengths can cause TS/PP-Draft to reset parameters of green bands starting,  tapering, or
clipping at the intersection to their default values as follows:
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Changing intersection:
Resets green band

Offset:

Resets green band

width:

Offset Yes Yes

Protected Turn Phase

Sequence

Yes No

Adjusted Cycle Length *(see note) Yes

*Note: This parameter is reset only if the green band tapers there.

The ability to change the protected turn Phase Sequences of the selected intersection directly on the
Diagram Window is limited.  Each time you press the Ctrl-P key, TS/PP-Draft changes to the protected turn
Phase Sequences to a valid alternative, that is, one that has the same protected turns defined.  Thus, a
"Lead" is swapped with a "Lag" but not with a "None."  Successively striking the Ctrl-P key causes TS/PP-
Draft to cycle through all valid combinations of protected turn Phase Sequences.  If the protected turn Phase
Sequence for one direction of travel is "None" (no protected turn), then striking the Ctrl-P key has no effect
on that protected turn Phase Sequence.

Zoom in on diagram window

Use the Zoom Factor drop-down list box on the Tool Bar to set a factor by which the Horizontal and
Vertical Scales are multiplied for the diagram displayed in the window. This can aid you in viewing
diagrams which would otherwise be too large to fit on the screen. It is also useful when you wish to zoom
in on a particular region of the artery for greater detail.

The Zoom Factor can be any of a variety of values, such 60%, 100%, and 200%, or it may be "To
Fit", which will ensure that the diagram is zoomed to fit the current window size.  While the Zoom Factor
is To Fit, you may resize the Diagram Window to zoom in and out on the diagram.

The printed diagram always uses the unadjusted Scales (i.e., without the Zoom Factor applied).
You may set the Default Zoom Factor on the Defaults page of the Preferences dialog.
For long arteries, or arteries with many intersections, the spacing of the intersections on the diagram

can become crowded at the default Horizontal Scale, making it difficult to see the green bands or make out
the signal timing details.  Zooming doesn't help because the text grows with the rest of the diagram.  In these
cases, you may drag a box on the Diagram Window to select the intersection(s) of interest.  TS/PP-Draft
zooms to the selected region of the diagram by adjusting the Horizontal Scale and the Distance from the left
margin to the first intersection.  Think of the zoomed diagram as being split into multiple pages.  Use the

 Page Up &  Page Down keys to jump to the next page.  The Print dialog allows you to select
more than one page for printing.  These overlap a little, so you can tape the multiple printed pages together
to form one long diagram.
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Annotate Diagram Window

Use the  Create Annotation command in the pop up menu (after right clicking on the diagram window
where you wish to annotation to appear) to annotate the diagram at the mouse location.

Click on an existing annotation in the diagram window to edit it.

A border (edit box) appears around the selected annotation when it's in edit mode.  Annotations may be
pretty much any length.  You may change the font size or style of the entire annotation by right clicking
within the edit box and choosing the  Font command.  The font change applies to the selected text or to the
entire annotation, if no text is selected.  Note that annotations look most realistic in the edit box  when the
diagram window's Zoom Factor is 100%.

Annotations may have an opaque or transparent background, depending on whether you want its
bounding box to hide what's underneath on the diagram.  Right click within the edit box and choose
Background Mode to toggle between opaque and transparent backgrounds.  The edit box is always opaque,
so a change to a transparent background is not evident until you close the edit box.

Double click on the selected annotation's edit box to move it (by dragging the interior) or resize it
(by dragging one of the edge controls).  Annotations may be pretty much any size.

To delete an annotation, either
• Right click on the selected annotation and choose the  Delete Annotation command from the pop up

menu, or
• Delete the entire text of the annotation.  When the edit box is closed, the entire annotation is deleted

if it contains no text.

Click anywhere else on the diagram window to close the selected annotation's edit box.
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Outline View

The Outline View of the diagram data file shows all of the diagram/arteries and links between
intersections in a pair of list boxes. Next to each diagram/arterial is a + or - sign on which you can double
click to reveal or hide the intersections in the corresponding diagram/artery.

To link two intersections together, select one intersection in this list and drag it to the one to which
you wish to link it.

The lower list box is a list of all intersection links in Outline View the diagram data file.  A thick
red line indicates everything is linked, a thin green line indicates only the offset is linked

You may show the Outline View by clicking on the  in the Tool Bar or by selecting the
Outline View command under the View Menu.

Use the  button to edit the parameters of the selected Diagram/Artery or Intersection.

Use the  button in the Outline View to add a new diagram/artery to the open diagram data file
or to add a new Intersection to the current diagram/artery.

To add a new diagram/artery to the currently open diagram data file,
(1) Collapse the diagram/artery after which you wish to add a new diagram/artery (so that its
intersections are hidden), then

(2) Selected the diagram/artery after which you wish to add a new diagram/artery, and click the 
button.

To add a new intersection to a diagram/artery,
(1) Expand the diagram/artery in which you wish to add a new intersection (so that its intersections
are visible), then
(2) Select the intersection after which you wish to add a new intersection (or the diagram/artery, if
you want to add a new intersection before any current intersections), then

(3) Press the  button.

If you are adding an intersection an interior intersection, TS/PP-Draft will ask you to enter the
Distance from the Previous Intersection to the newly-added one. It then automatically calculates the distance
from the newly-inserted intersection to the following one, if any, so the arterial length is unchanged.

If you're adding a boundary intersection, TS/PP-Draft arbitrarily assigns the Distance, and you must
change it in the Intersection Parameters dialog. In doing this, TS/PP-Draft automatically recalculates the
optimal Horizontal Scale (if it is unlocked) and the Distance to the first intersection from the left margin.
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Use the  button in the Outline View to delete the currently selected diagram/artery or
intersection. You may also delete a diagram or an intersection (and save it to the Windows Clipboard) using
the Cut command under the Edit Menu.

When you delete a diagram/artery, TS/PP-Draft automatically breaks any links to intersections in
that diagram/artery.

Deleting one of the interior intersections (not one of the boundary intersections) causes TS/PP-Draft
to reset the Distance between the intersections on either side of the one deleted so that the arterial length is
unchanged.

Deleting one of the boundary intersections of the diagram causes TS/PP-Draft to reset the Offset,
Width, and Design Speed of any green band that begins at that intersection. TS/PP-Draft also recalculates
the optimal Horizontal Scale (if it is unlocked) and the Distance to the first intersection from the left margin.

Use the  button in the Outline View to copy the currently selected diagram or intersection to the
Windows clipboard.  You may then Paste the diagram back into TS/PP-Draft or into another Windows
application (one that can accept the pasted information).

TS/PP-Draft copies the diagram to the clipboard in the following formats:
• a "TSPPD Diagram", a native format which is equivalent to a Diagram data (*.Dgm) file,
• a Windows bitmap,
• a Windows Enhanced Metafile (or Picture).

This is a useful way of transferring diagram information from one diagram data file to another.
For duplicating diagram/arteries within the currently open diagram data file, it is usually better to

use the  button (discussed below) in the Outline View because this latter allows you to link all
intersections between the original and the duplicated diagram.

Use the  button in the Outline View to paste the contents of the Clipboard (diagram or
intersection) to the currently selected position in the Outline View.

Use the  button in the Outline View to duplicate the currently selected diagram/artery.  You may
also copy a diagram to the Windows Clipboard using the Copy and Paste commands under the Edit Menu.

When you duplicate a Diagram Window, TS/PP-Draft offers to link the duplicated intersections to
the originals. Answer Yes if you wish to maintain two different Types of Diagrams for a given artery in two
separate Diagram Windows. If you answer No, TS/PP-Draft then offers to link any intersections in the
original Diagram Window that are linked to intersections in other Diagram Windows.

Use the  button to show the intersections of all Diagram/Arteries in the Diagram/Artery list.

Use the  button to hide the intersections of all Diagram/Arteries in the Diagram/Artery list.

Use the  button in the Outline View to find all links to the intersection selected in the
Arterial/Diagram Outline List. The links to the selected intersection are moved to the top of the Intersection
Links List, and if necessary, the list is scrolled so the first link at the top of the list is visible.
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Use the  button in the Outline View to remove the link to an intersection selected in the
Intersection Links List. Only the link which you select is broken; any other linked intersections remain
linked.

Use the  button in the Outline View to view (bring to the front) the currently selected diagram.
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Network View

The Network View of the diagram data file shows a sort of bird's eye view of all arteries and
intersections. Arteries are shown as lines, and intersections are shown as dots on the lines. 

If everything is linked between two or more intersections along different arterial diagrams, the
arteries are shown as intersecting at the common intersection. Sometimes TS/PP-Draft lays out the
intersecting arteries in an especially crude approximation to reality. See Adjusting the Network View for
information on how to improve the representation.

You may show the Network View by clicking on the  button in the Tool Bar or by selecting
the Network View command under the View Menu.

With the Network View, you may:

1. Edit the Diagram/Artery Parameters by selecting an intersection along the artery and either clicking

the  button on the Tool Bar, choosing the Diagram/Arterial command under the View Menu,
or by clicking the right mouse button and choosing the Diagram/Arterial command from the pop-up
menu.

2. Edit the Intersection Parameters by selecting the intersection along an artery and either clicking the 
button on the Tool Bar, choosing the Intersection command under the View Menu, or by clicking
the right mouse button and choosing the Intersection command from the pop-up menu.

3. View the Diagram Window for an artery by selecting an intersection along the artery, clicking the
right mouse button, and choosing the View Diagram command from the pop-up menu.

4. Link intersections together by selecting one intersection and dragging it to the one to which you
wish to link it.

5. Monitor your current position, if you are  tracking with a GPS receiver.  In this case, an icon
appears on the Network View showing your current position and direction of travel.  Before the can
icon appear in the correct location, you need to Layout the Grid with GPS Coordinatess.
Right-click anywhere on the Network View and choose this command from the pop up menu.  You
only need to do this once, unless you add more diagrams or intersections or change the Geographic
Coordinates of any of the intersections.
The accuracy of this tracking depends on many things, including
a. The accuracy of the GPS receiver (based on time of day, time of year, location, and weather

conditions, among other things)
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b. The rate at which the GPS receiver supplies information

6. View the path of any recorded trip logs.  If you observe any spurious points in any of the trip logs,
you may manually delete these points by carefully pointing to them with the mouse cursor, then
clicking Alt + right-button.  Increasing the zoom level of the Network View can make it easier to
spot spurious points in the trip logs.  You may also use the Trip Log Filter (page 41) to automati-
cally identify and remove spurious points.

7. View the effective extent of the intersections.  This is a circle centered at the intersection with a
radius equal to the half-width of the intersection.  A trip log must cross this region to count as
passing through the intersection.  Viewing the extent makes it easier to diagnose why a trip log is
either skipping an intersection or passing through one twice. You can also detect when an extent is
too large, usually due to a bad or misplaced coordinate measurement.  Right-click on the Network
View to toggle the item "Show Intersection Extents."

Adjusting the Network View

If Geographic Coordinates (from the GPS receiver) are available for the intersections, they are used to
layout the Network View with high acccuracy.  Otherwise, by default, the Network View will show a
rectilinear grid, which it builds entirely from the declared Distances between intersections and the
orientations (or Forward Directions) of arteries.  But this information does not necessarily define a unique
grid, depending on how the distances add up. For example, if four intersections lie on the corners of a
parallelogram, there are infinitely many parallelograms with the given four distances (of which no more
than two are unique), each with a different acute angle--including 90 degrees which gives a rectangle.

If there are enough trapezoids in the grid, then the Distances can define their shapes uniquely, but even then,
the declared distances along the legs of the various trapezoids won't necessarily "agree" with each other to
define a unique shape for the whole grid.

The result is that TS/PP-Draft builds a (possibly crude) rectilinear grid which satisfies some, but not
necessarily all, of the given constraints. There are several things you can do to improve the accuracy of the
grid:

Layout Grid with GPS
If you don't already have the geographic coordinates of the all intersections, you may either
import, get them from the GPS receiver, extrapolate them, or enter them manually.  The by
clicking the right mouse button with the mouse cursor on the Network View, you may use
the pop-up menu to layout the grid with the geographic coordinates.

Stiffen the Grid
By clicking the right mouse button with the mouse cursor on the Network View, you may
use the pop-up menu to "Stiffen" the grid, which will rebuild the default rectilinear grid,
undoing any Relaxation or other adjustments you may have made.



User's Manual

31

Reposition individual nodes
By holding down the Shift key, you may drag (using the left mouse button) individual
nodes on the Network view to more realistic positions.

Note that none of these adjustments to the Network View affect the declared Distance between
intersections.

You may use the Edit: Undo command to restore the Network View to its previous layout, before
the adjustment was made.
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Timings Report

You may preview, save, or print out a report of all of the diagram/arterial timing parameters using

the the  button on the Tool Bar, or the Timings Report command in the View Menu.

Before preparing the timings report, TS/PP-Draft allows you to select which diagram/arteries to
include in the report.

You may save the timings report in a variety of file formats, including .pdf, .html, .rtf, or .txt.
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GPS Receiver and Trip Tracking

The GPS (Global Positioning System) Receiver View shows the status of the GPS receiver unit (if any)
and contains parameters affecting the connection to and operation of the GPS receiver and the synchroni-
zation of the network's traffic signal clocks with the satellite clocks.  You may also control the trip logs,
the records of trips taken through the network, in this window.

To quickly show the Diagram/Arterial parameters for the selected diagram, you may use

• the  button on the Tool Bar, or
• the GPS Receiver command under the View Menu.

The GPS Receiver parameters grouped in the following tabbed pages:
Position Showing the status of the GPS receiver and its current position and speed.  The status of

the GPS receiver is "Not Connected" until you start tracking with the GPS receiver.
Satellites Showing the status of the signals from the GPS satellites and their current position in the

sky.  The status of the GPS satellites is not available until you start tracking with the
GPS receiver.

Clocks Allows you to synchronize the traffic signal clocks with the GPS satellite clocks.
Trip Logs Providing control over the recording of trip logs.
Options Providing operational options while tracking with the GPS receiver.
Setup Providing control over the type of GPS receiver and its connection to your computer.

In order to track your current location with the GPS receiver, measure the geographic coordinates of an

intersection, or record Trip Logs (for  Travel Time and Delay Reports, or  Plots of Speed or
Travel Time vs. Distance, and other purposes), you must start tracking with the GPS receiver.

Tracking with the GPS Receiver

You may control the GPS Receiver with the  GPS Receiver View.  In order to track your current
location with the GPS receiver, measure the geographic coordinates of an intersection, or record Trip

Logs to prepare  Travel Time and Delay Reports, you must start tracking with the GPS receiver.  To
do this,
1. Connect the GPS receiver to your computer with a serial port cable.
2. Ensure that TS/PP-Draft knows the type of GPS receiver and serial port connection using the

parameters on the Setup page of the  GPS Receiver View.
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3. Click the  button on the  GPS Receiver View, or right-click on the view

and choose the "Start GPS Tracking" command from the pop up menu, or click the  on the Tool

Bar, or say "Start GPS" (if  voice command recognition is enabled)..

If these steps are all performed properly, the status on the Position page will soon change from "Not
Connected" to "Tracking."  This may take anywhere from a few seconds to a few minutes, depending on
what type of GPS receiver you have, how far you are from where you last used the GPS receiver, and
how long it has been since you last used it.

Once tracking is started, you may 
• Take measurements of the Geographic Coordinates of intersections,
• Synchronize the network's signal clocks with the GPS satellites,
• Monitor your current position and speed in Diagram Windows or the  Network View,
• Play specific sounds to indicate that you're projected to arrive at the next signal near a red-to-green

transition.

• Record Trip Logs with the   GPS Receiver View for preparing  Travel Time and Delay

Reports, making  Plots of Speed vs. Distance or Travel Time vs. Distance, measuring the
distance between intersections, calculating the "optimal" relative offset between intersections for a
given direction of travel, calculating the Design Speed between intersections, or calculating the start
up lost time for the through movement along the artery at an intersection..

The Diagnostics page of the  GPS Receiver View can help you troubleshoot the connection with the
GPS receiver, as it will show you the raw data that's arriving over the serial port.

To stop GPS tracking, click the  button on the  GPS Receiver View, or right-
click on the view and choose the "Stop GPS Tracking" command from the pop up menu, or say "Stop

GPS" (if  voice command recognition is enabled).

See also the tutorial on How to Perform a Travel Time and Delay Study (page 11) for step by step
instructions on how to operate TS/PP-Draft with the GPS receiver.

Warning: It is not safe to operate a computer (including laptop and notebook computers) while operating
a vehicle!  If you wish to perform any of the above procedures while in a moving vehicle, have someone
else drive the vehicle while you operate the computer.  You take full responsibility and accept all liability
for any damage or injury that may occur as a result of your operating a computer while driving a vehicle.



User's Manual

37

GPS Clocks Page

The Clocks page of the  GPS Receiver View allows you to synchronize the traffic signal clocks with
the GPS satellite clocks.

To synchronize the clocks, you must click the  button at the moment you
observe a given phase transition at a given signal.  First, specify which phase transition you'll be
observing by choosing from the drop down lists the Artery and Intersection of the signal you're watching. 
Then indicate phase transition (start of Green, Flashing Don't Walk, Yellow, or Red) and the phase and

direction of travel at the signal.  Once these are specified, click the  button or say

"Synchronize Now" (if  voice command recognition is enabled) when you see the phase transition
occur.

The moment you click the button, the Synchronized Time, is displayed in the controls at the bottom
of the page.  You may also use these controls to fine tune the time.  This can be useful if you clicked the
button a second or two too early or late, or if the signals clocks have drifted since you last synchronized
them.  The Synchronized Time is the satellites' time (adjust for your local time zone), based on extremely
accurate atomic clocks, so it is not dependent on your computer system's time.

If any of the intersections in any of diagrams is operating at double cycle length, you should
synchronize the clocks using a phase of one of those intersections.

The  button is not available until you  start tracking with the GPS receiver. 
You can tell whether the clocks are synchronized by observing the GPS tracking marker on the diagram. 
If the marker crosses the cycle boundaries (the offset=0 lines) at the correct moments, so the phases of
the signals in the field coincide with the GPS tracking marker crossing the corresponding signal phases in
the diagram, then the clocks are synchronized.  TS/PP-Draft can mark the current time with a horizontal
line to make this comparison easier.

The clock synchronization is used to determine
• The offset of the current position marker on diagram windows when tracking your position and speed

with the GPS receiver.  This being the case, the Synchronized Time affects the playing of sounds to
alert you that your vehicle is projected to arrive at the next signal near a red-to-green transition.

• The offset on the diagrams of any trip logs you record.  Once recorded, the trip logs retain a record of
the Synchronized Time in effect while they were recorded, so thereafter their offsets do not depend
on the satellites' time or your computer system's time.

It is useful to know what the clock synchronization does not affect.  There are many useful things
you can do with GPS tracking even when the Synchronized Time is not quite accurate.  The current
position displayed on the  Network View is not affected by the Synchronized Time.  And although the
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offsets on the diagrams of trip logs is determined by the Synchronized Time, even trip logs with an
inaccurate offset contain otherwise correct information and serve perfectly well for

• Preparing  Travel Time and Delay Reports.

• Making  Plots of Speed vs. Distance or Travel Time vs. Distance.
• Measuring the travel distance between intersections.
• Calculating the "optimal" relative offset between intersections for a given direction of travel.
• Calculating the Design Speed between intersections.
• Calculating the start up lost time for the through movement along the artery at an intersection.

The Synchronized Time and the parameters indicating the synchronized phase transition are stored in
the Diagram Data file.

GPS Trip Logs Page

The Trip Logs page of the  GPS Receiver View allows you to record, view, and control logs of trips
you take through the signalized network.

Trip Logs are useful for multiple purposes:
• Plotting trajectories on the diagram windows, graphically showing where delay occurs, which signals

you've stopped at, and where you entered or left the green bands.

• Preparing  Travel Time and Delay Reports.

• Making  Plots of Speed vs. Distance or Travel Time vs. Distance.
• Measuring the travel distance between intersections.
• Calculating the "optimal" relative offset between intersections for a given direction of travel.
• Calculating the Design Speed between intersections.
• Calculating the start up lost time for the through movement along the artery at an intersection.

To display trip logs on a diagram window at the correct offset, you should synchronize the clocks
before you record the trip log.  All other purposes are served by trip logs independent of whether the
clocks were synchronized.

To record a trip log, you must first start tracking with the GPS receiver.  Once tracking begins, click

the  button, or say "Start Trip" (if  voice command recognition is enabled), to

begin recording a trip log.  Click the  button, or say "Stop Trip" (if  voice
command recognition is enabled), to stop the recording.

Warning: It is not safe to operate a computer (including laptop and notebook computers) while
operating a vehicle!  If you wish to record a trip log, have someone else drive the vehicle while you
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operate the computer.  You take full responsibility and accept all liability for any damage or injury that
may occur as a result of your operating a computer while driving a vehicle.

If you have a Garmin GPS receiver, and you're using the Garmin Proprietary interface mode, you
may download pre-recorded trip logs from the GPS receiver.  This allows you to take just the GPS out in
the field, record the trip logs, then download them when you get back to the office using the

 button.  The downloaded trip logs don't provide any speed or heading measurements --
these have to be inferred.  This reduces the accuracy of Speed vs. Distance plots and the effectiveness of
the Trip Log Filter (page 41).  Some Garmin GPS receivers offer a variety of ways to record a trip log,
taking readings at a fixed rate (which you specify), whenever a fixed distance is traveled (again, you
specify the distance), or whenever it thinks necessary according to its own internal rules.  I haven't tried
all the options, but for consistency with the trip logs recorded "live", I've set mine to take readings at a
fixed rate, every 1 or 2 seconds.

The following figure illustrates some of the features of the trip log list.

Right click on the trip log list or on a selected trip log for a pop up menu with additional options, such as
copying, deleting, exporting, or filtering a trip log or editing its properties.

The Size column of the trip log list shows the number of time-position measurements contained in
the given trip log.  A measurement is taken every 1 or 2 seconds, depending on the type of your GPS
receiver; however, TS/PP-Draft discards redundant measurements while you're not moving (e.g., while
you're waiting in a queue).
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Each trip log has a "type," either Before, After, or Neither.  The type of the trip log is used for
calculating averages and differences in the Travel Time and Delay Reports (page 55).  Use the Trip Log
Properties dialog to set the type of a single trip log.  You may set the type of multiple trip logs in one
operation selecting one or more trip logs, right clicking on the list, and choosing Trip Log Type from the
popup menu.

The Size column of the trip log list shows the number of time-position measurements contained in
the given trip log.  A measurement is taken every 1 or 2 seconds, depending on the type of your GPS
receiver; however, TS/PP-Draft discards redundant measurements while you're not moving (e.g., while
you're waiting in a queue).

The Trip Logs are stored in the Diagram Data file.

Trip Log Properties

The Trip Log Properties dialog is accessible from the GPS Trip Logs Page by right clicking on a
selected trip log and choosing Properties from the pop-up menu.

In this dialog, you may edit 
• The Name of the trip log.
• The "type" of the trip log, either Before, After, or Neither.  The type of the trip log is used for

calculating averages and differences in the  Travel Time and Delay Reports.  You may set the type of
multiple trip logs in one operation selecting one or more trip logs in the list of trip logs, right clicking
on the list, and choosing Trip Log Type from the popup menu.

• The time shift on the diagram.  This number affects how the trip log trajectory is plotted on the
arterial diagram and how the Start Up Lost Time is calculated from the trip Log, but nothing else.  If
the GPS satellite and signal clocks were synchronized when the trip log was recorded, each trip log
trajectory on the diagram should show when, in the signal cycle, the trip entered the artery and
passed through each intersection.  But if the signal timings have changed since the trip log was
recorded, or if the clocks weren't synchronized, the trajectory may show the trip log passing through
the red time or waiting at a green signal.  You may use this parameter to offset the trip log's plotted
trajectory on the diagram by a given number of seconds (either positive or negative).  This time shift
does not affect  Travel Time and Delay Reports or  Trip Log Plots.

• The color of the trip log trajectory, as plotted on the arterial diagram.  By default, the color depends
on the trip log type (i.e., Before, After, or Neither), but you may override this default for any trip log.

Exporting Trip Logs

You may export a trip log to a text file for importing into GIS software or Excel.  Right click on a
trip log in the Trip Logs page of the  GPS Receiver View to select the Export command from the pop up
menu.
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The first few lines of the exported file look something like

Trip #6 started at Wednesday 8/27/2003 8:08:18 AM
"Time (seconds)" "East Longitude (radians)" "North Latitude (radians)" "Altitude (m)"
"Speed (m/s)" "Heading (radians)"
0.0 -1.413699677 0.615081692 198.00 17.08 1.8012
1.0 -1.413696477 0.615081110 198.00 17.23 1.7715
2.0 -1.413693161 0.615080586 198.00 17.70 1.7523
...

The first line is text identifying the trip log.  There are no quotes around this line.  Quotes might be
preferable to simplify importing into Excel, but including the quotes would create some problems if your
trip log name also happened to include some quotes.

The second line includes text labels identifying the columns, enclosed in quotes, and separated by
tabs.

The remaining lines are the raw data of the trip log.  The angles are in radians, distances in meters. 
Again, the columns are separated by tabs.

At present TS/PP-Draft does not import trip logs from these files.  I'm disinclined to allow this, as we
would all lose confidence in the time stamp of a trip log thereafter, since these text files allow someone
to easily edit the time.

Trip Log Filter

Sometimes a  trip log may include some erroneous readings from the GPS receiver.  This can happen
for a variety of reasons, usually involving interference (noisy transmission channels, a partially blocked
view of the sky, etc.).

The Trip Log Filter can be used to identify and remove "bad" points.  The trick, of course, is how to
tell whether a point is bad.  A number of user-settable parameters are used to determine whether a point
is bad.

Invoke the Filter by right-clicking on a trip log in the GPS Trip Logs page and choosing Filter Points
from the pop-up menu.  The Filter compares consecutive GPS readings, calculating 

• Distance -- The distance is calculated from the difference in the position from reading A to reading
B.  If this distance is small, the Filter will just do no further tests on these points to determine
whether one of them is bad.  The assumption is that the GPS was probably not moving much, or just
standing still, and the random errors that occur in GPS readings might artificially introduce an
apparent speed or acceleration that are unrealistic.  With this assumption, the conservative approach
is to preserve the readings in this case; although it may not matter much if you should prefer to delete
these points since, by definition, they are having a mostly negligible affect on the trip log anyway. 
You get to specify the Minimum Distance as the testing threshold.

• Speed -- The speed is calculated from the difference in the position and time from reading A to
reading B.  For trip logs recorded "live" (i.e., not downloaded), readings A and B include the speed
as a separate measurement by the GPS receiver, independent of the position information.  The speed
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(and heading) are measured by the Doppler shift in the frequency.  The measured speed should be a
good indication of the instantaneous speed at each reading, whereas the calculated speed is a pretty
fair estimate of the average speed over the time interval between the two readings.  I believe that the
measured speed, if available, is usually more accurate, but two are generally comparable for short
time intervals.  The Filter will compare this measured speed to the calculated speed and, if the
difference exceeds a given value, point B is marked as "bad."  You get to specify the Maximum
Speed Difference as the criterion for a "bad" reading.  For trip logs downloaded (not recorded
"live"), the speed associated with each reading is already the calculated speed (which is usually less
accurate), making this test by the Filter useless.

• Acceleration -- The acceleration is calculated two different ways, speed-only and position-and-speed. 
The speed-only calculation takes into account only the difference in the measured speed (assuming
the trip log was recorded "live," not downloaded) from reading A to reading B and the difference in
their times.  The position-and-speed calculation takes into account the position, speed, and heading at
points A and B.  It finds the two accelerations, initial and final acceleration, including the braking
and centripetal acceleration from turning, that are required to be applied constantly for half the time
interval to start at point A with its speed and heading, and end up at point B at its speed and heading. 
The maximum of the magnitude of these two accelerations is then used.  The Filter marks point B as
"bad" if either the speed-only acceleration or the position-and-speed acceleration exceeds the
Maximum Accelerations, which you may separately specify.

Once a point is marked "bad", subsequent comparisons may be to the last "good" point.  This can be
useful in filtering out a series of consecutive, spurious points, but there's a risk when there's just one
spurious point.  When the time interval between the two compared readings gets large, the calculation of
the speed (the average over the time interval) may legitimately show a large discrepancy from the
measured (instantaneous) speed.  This makes the speed test more likely to catch points, including false
alarms.  That is, based on the speed criterion, the Filter may falsely identify subsequent points as bad. 
You might want to raise the Maximum Speed Difference when comparing to the last "good" point to
reduce this risk.  

When comparing to the last "good" point, the acceleration tests become weaker, so they won't catch
as many points, but any points they catch are more likely to be truly bad. 

You might want to try the Filter both ways, comparing to the last point or the last "good" point, to see
what points it catches in each case before committing to removing any marked points.  

When the Filter is finished, it displays a prunable list to you of the points it caught.  You get final
approval before any points are removed.

You may manually "filter" spurious points you see from trip logs in the arterial diagram window, the
trip log plots, or the Network View, by carefully pointing to them with the mouse cursor, then using Alt
+ right-click.
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GPS Options Page

The Options page of the  GPS Receiver View provides operational options while tracking with the
GPS receiver.

Make sounds when I'm going to arrive within.  This check box gives the option to make
sounds to alert you that your vehicle is projected to arrive at the next signal near a red-to-green transition. 
The accuracy of this projection is determined partly by the Synchronized Time and the Offsets and Splits
at the downstream signal.

You may specify the number of seconds defined to be "near the transition."

If this option is checked, TS/PP-Draft will play a sound after you start tracking with the GPS receiver
whenever you are projected to arrive at the next signal on the top-most diagram window within the given
number of seconds of a red-to-green transition, assuming you maintain your current speed.  No sound is
made if your current speed is less than about 11 miles per hour (18 km per hour).

There are four different possible sounds, to indicate:
1. An early arrival (near the beginning of green), or
2. A too early arrival (before the beginning of green), or
3. A late arrival (near the end of yellow or all-red), or
4. A too late arrival (after the end of yellow or all-red).

This can be useful if you're trying to stay within a theoretical green band, but note that the sounds
don't necessarily alert you when you are nearing the edge of the green band shown on the time-space
diagram.  Instead, they alert you when you are nearing the edge of what might be called the acceptance
band, a band emerging upstream from the green time of the next signal with a slope determined by your
current speed (which may be varying).

Make sounds when tracking starts or trip log recording is interrupted.  This check box
gives the option to make sounds to alert you when the GPS receiver has started tracking (indicating that
you may now start recording trip logs or collecting geographic coordinates) or when the recording of a
trip log is interrupted (possibly due to a disconnected cable, loss of power, or poor reception from the
satellites resulting in too long of a time without a good reading).

Mark all positions at current time with a horizontal line.  This check box gives the option
to draw a horizontal line on the diagram at the current time in the cycle to mark all positions.  The
horizontal line can be useful in verifying that the traffic signal and GPS satellite clocks are synchronized.

Mark all times at current position with a vertical line.  This check box gives the option to
draw a a vertical line on the diagram at the current position to mark all times.  The vertical line, with the
horizontal line, forms cross-hairs to quickly pinpoint the current time and position.
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When recording trip logs, tolerate interruptions from the GPS data stream.  The option
to tolerate a certain number of seconds interruption in the GPS data stream when recording trip logs
requires a little background.  GPS receivers will sometimes fail to provide an updated position for some
interval of time.  This can be for various reasons, including
• Loss of contact with a sufficient number of GPS satellites
• Disconnected or poorly connected (serial) data cable
• Loss of power to the GPS receiver
• Weak batteries in the GPS receiver
• A slow-acquisition GPS receiver (I've worked with a Magellan that seems to be more flaky in this

regard than the Garmins or the Earthmate that I've tested -- it can go tens of seconds without updating
the position information while it recovers from a lost fix)

While merely tracking with the GPS receiver, this usually isn't a problem.  TS/PP-Draft just ignores the
missing information and updates the position when it's available again.  But for recording trip logs, a long
gap in the recording is of more concern as it may lead to inaccurate Travel Time and Delay Reports.  The
GPS receiver reports the time accurately whenever it reports the position, so when the information flow
resumes after an interruption, TS/PP-Draft will still know the current position and time, but there may
still be inaccuracies:
• If you've been stopped at that location for some time, TS/PP-Draft won't be able to determine the

actual travel time to that location. 
• If you briefly stopped somewhere during the interruption, TS/PP-Draft won't know where or for how

long.
• If you passed through an intersection during the interruption, TS/PP-Draft won't know at precisely

what time.
As a result, you may specify the number of seconds of interruption to tolerate when recording trip logs. 
The default is 7 seconds, but you may want to increase this number if you're experiencing frequent and
inexplicable interruptions.  You may want to reduce this number if your GPS receiver is generally
reliable and you want to reduce the chances for even minor errors creeping into the TT&D reports as a
result of a rare interruption.

Use voice command recognition.  Check this box or click the  button on the Toolbar to
use speech recognition for controlling the operation with the GPS receiver.  

If you are alone in the vehicle, the only safe way to operate TS/PP-Draft is to pull off the road to a
nearby parking space whenever you need to do interact with the computer.  For collecting trip logs, this
often presents minimal inconvenience, but when collecting the geographic coordinates of the intersec-
tions, this can take considerably more time.

Using voice command recognition gives you a fairly safe way to perform the most likely operations
with TS/PP-Draft while driving a vehicle without touching or looking at the computer.  See the topic
Voice Command Recognition for more information and a list of recognized commands.  See the section
Tips on Using the Speech Recognition Engine (page 53) for additional tips on using the speech recogni-
tion engine with TS/PP-Draft.
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Audibly acknowledge recognized commands.  When using  voice command recogni-
tion, you may have TS/PP-Draft play an audible sound to acknowledge when a command has been
recognized.  The moment the sound begins playing is the moment the command is processed.  Knowing
this can help you learn the anticipation time required for time-sensitive commands.  This time can vary
depending on the speed of your computer, the level of noise, and how well your speech recognition
engine has been trained.

Warning: It is not safe to operate a computer (including laptop and notebook computers) while
operating a vehicle!  If you wish to view or change the GPS options while moving in a vehicle, have
someone else drive the vehicle while you operate the computer.  You take full responsibility and accept
all liability for any damage or injury that may occur as a result of your operating a computer while
driving a vehicle.

The GPS Options are stored in your personal preferences, not in the Diagram Data file.

GPS Setup Page

The Setup page of the  GPS Receiver View is where you specify the type of GPS receiver and its
connection to your computer.

There are two types of GPS receivers supported:
• NMEA 0183 Standard Compatible
• DeLorme Earthmate

The vast majority of GPS receivers comply with the NMEA (National Marine Electronics Association
www.nmea.org) 0183 Standard.  TS/PP-Draft has been tested with GPS receivers from Magellan
(www.magellan.com.au), Garmin (www.garmin.com), and Pharos (www.pharosgps.com) and they all
work fine.

The Earthmate from DeLorme (www.delorme.com) does not comply with the NMEA 0183 Standard,
but it is supported separately by TS/PP-Draft.  The newer, USB-interface Earthmate should work with
TS/PP-Draft, but you may need to download the "COM Port Emulation Drivers for the USB Earthmate
GPS Receiver" from the DeLorme web site.

The table below lists some of the advantages and disadvantages of the respective GPS receiver types.
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GPS Receiver Type Advantages Disadvantages

NMEA-compliant Most can function as stand-
alone units.
Compatible with a wider vari-
ety of software.
Batteries on many can last for
a day or more.
Many can be initialized and
start tracking within a few
seconds.

Report the position and speed to TS/PP-
Draft only once every 2 seconds.
Tend to be more expensive (typically $200 -
$300).
Doesn't necessarily include map/navigation
software; although it can use it if you buy it
separately.

Earthmate
(Here I mean the
original, serial-port
device. The newer,
USB port devices fall
under the NMEA-
compliant catagory
above)

Reports the position and speed
to TS/PP-Draft once every
second.
Relatively inexpensive (typi-
cally around $120).
Comes with map/navigation
software.

Not compatible with the NMEA standard.
Can function only when connected to a com-
puter (or other device) over the serial port.
Batteries last for only a few hours -- the cig-
arette lighter power adapter is practically
mandatory.
Usually takes several minutes to initialize
and start tracking.
The cigarette lighter power adapter is prone
to breaking. A wire in the cigarette lighter
connector is cut too short, and once assem-
bled, it's under constant tension. Thus, it's
likely to break. If you have a soldering iron,
you can replace this wire with a longer one
for more reliable operation.

Garmin (Proprietary) Reports the position and speed
to TS/PP-Draft once every
second.
Allows you to download pre-
recorded trip logs into TS/PP-
Draft.

Works only with Garmin GPS receivers, and
it may not work with some older models.
Tend to be more expensive (typically $200 -
$300); although, the basic Garmin eTrex and
it's data cable are about $160 total.
Doesn't necessarily include map/navigation
software; although it can use it if you buy it
separately.
The downloaded trip logs don't provide any
speed or heading measurements. These have
to be inferred. This affects the accuracy of
Speed vs. Distance plots and the effective-
ness of the Trip Log Filter (page 41).
Does not provide any satellite information
(position or signal strength).
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Pharos i360 (USB
configuration)

Reports the position and speed
to TS/PP-Draft once every
second.
Takes power from the USB
port.
Relatively inexpensive (under
$200 with the data cable and
mapping software included).

Can function only when connected to a com-
puter (or other device).

If you have a GPS receiver that is not supported by TS/PP-Draft, please let me know, and I will be
happy to add it if possible.

You must specify which serial port (usually COM1 or COM2) your GPS receiver is connected to.  If
you don't have a serial port, you may connect the GPS to the USB port with a serial-to-USB adapter. 
Version 6.0 of TS/PP-Draft is able to connect to the GPS through such an adapter, but ver. 5.0 had
trouble with most adapters.

The NMEA-compliant GPS receivers may support a number of different serial port connection
speeds and settings.  For this reason, TS/PP-Draft lets you specify other parameters associated with the
connection.  The default settings have been found to work with all tested GPS receivers, so you'll
probably only need to change them if you wish to use a different serial port speed or if you have a
receiver unlike any those that have been tested.

The Diagnostics page can help you troubleshoot the connection with the GPS receiver, as it will
show you the raw data that's arriving over the serial port.

GPS Diagnostics Page

The Diagnostics page of the  GPS Receiver View allows you to view the raw data arriving over the
serial port to which TS/PP-Draft is listening.  This can be useful in diagnosing problems with the
connection to the GPS receiver.

If your GPS receiver is connected to the serial port and setup correctly, the raw data will start

arriving (and appearing) a few seconds after you click the  button.  The appear-
ance of the data depends on which type of GPS receiver is connected to your computer:
• NMEA 0183 Standard Compatible
• DeLorme Earthmate
• Garmin (Proprietary)
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Receivers compatible with the NMEA 0183 Standard will send data that should look something like the
following:

$GPRMC,204520,A,3634.6681,N,12149.4375,W,0.0,0.0,260602,14.7,E,A*3B
$GPRMB,A,,,,,,,,,,,,A,A*0B
$GPGGA,204520,3634.6681,N,12149.4375,W,1,05,3.0,56.5,M,-29.6,M,,*40
$GPGLL,3634.6681,N,12149.4375,W,204520,A,A*55
$GPBOD,,T,,M,,*47
$GPBWC,204520,,,,,,T,,M,,N,,A*7A
$GPVTG,0.0,T,345.3,M,0.0,N,0.0,K*4F
$GPXTE,A,A,,,N,A*51
$PGRME,12.4,M,18.4,M,22.2,M*16
$PGRMZ,185,f,3*17
$PGRMM,WGS 84*06
$GPRMC,204522,A,3634.6680,N,12149.4374,W,0.0,0.0,260602,14.7,E,A*39
$GPRMB,A,,,,,,,,,,,,A,A*0B
$GPGGA,204522,3634.6680,N,12149.4374,W,1,05,3.0,55.4,M,-29.6,M,,*40
$GPGLL,3634.6680,N,12149.4374,W,204522,A,A*57
$GPBOD,,T,,M,,*47
$GPBWC,204522,,,,,,T,,M,,N,,A*78
$GPVTG,0.0,T,345.3,M,0.0,N,0.0,K*4F
$GPXTE,A,A,,,N,A*51
$PGRME,12.4,M,18.3,M,22.1,M*12
$PGRMZ,182,f,3*10
$PGRMM,WGS 84*06

Every 1 or 2 seconds, another set of lines should arrive.  If you don't see anything and you're sure the
cable is attached properly, then you may have the serial port declared incorrectly or your GPS receiver
may be expecting to send data in a different format.  Many of the GPS receivers compatible with the
NMEA 0183 Standard are also capable of sending data in other formats and will do so by default.  You'll
need to adjust the settings of these receivers so they use an NMEA / NMEA (in / out) interface.  See the
receiver's owner's manual for information on how to change the interface.

The (original, serial-interface only) DeLorme Earthmate will initially send data that looks something like 
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Note the text strings "EARTHA" in the first few lines of this sample of raw data.  This text appears only

in the first few lines after you click the  button.  Once tracking begins (which can
take several more minutes), the raw data from the Earthmate will look something like
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Every second another set of lines should arrive.
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Voice Command Recognition

TS/PP-Draft can recognize  voice commands for the operations most frequently used while
driving a vehicle with the software connected to a GPS receiver.  This option is available under the GPS
Options page.

TS/PP-Draft uses SAPI 5 (Speech Application Programming Interface version 5) to interact with the
speech recognition engine.  Various incarnations of MS Office XP include Speech Tools by default,
which has an SAPI 5 compatible speech recognition engine.  Speech Tools is accessible from the Control
Panel.  See the operating system's online help for more details on installing and using the Speech Tools. 
If you don't already have one, you may download a free SAPI 5 speech recognition engine from
http://www.microsoft.com/speech, but I think that requires downloading the entire “SDK,” which you
probably don’t want to do.

The voice command recognition works best with a high-quality, head-mounted microphone.  You'll
may also want to get one with an ear piece so you can hear the audible sound TS/PP-Draft can make to
acknowledge when a command has been recognized.

The speech recognition takes a few moments to identify the spoken command.  If you've opted to
play a sound to acknowledge a recognized command, the moment the sound begins playing is the
moment the command is processed.  Knowing this can help you learn the anticipation time required for
time-sensitive commands.  This time can vary depending on the speed of your computer, the level of
noise, and how well your speech recognition engine has been trained.

The accuracy of the speech recognition engine is greatly improved with training sessions.  See the
Speech Tools' or the operating system's online help for more details.  The first time through the speech
recognition training session took me about 10 minutes or so.  After that it got much faster.  Each time you
do it, the speech recognition becomes more reliable in the future.

See the section Tips on Using the Speech Recognition Engine (page 53) for additional tips on using
the speech recognition engine with TS/PP-Draft.

At present, there are 12 operations that TS/PP-Draft can perform in response to voice commands. 
Each operation can be invoked by more than one spoken phrase, listed below.  For each operation, you
may use whichever spoken phrase(s) you find most convenient, and you don't need to be consistent; you
may switch phrases at any time.  You'll probably want to use the spoken phrases that you find easiest to
remember and that seem most reliably recognized and distinguished by the speech recognition engine.  I
find that the recognition engine is sometimes more reliable when I speak some phrases quickly and
slightly slurred rather than slowly and clearly enunciated.

http://www.microsoft.com/speech,


TS/PP-Draft 6.0: Time-Space/Platoon-Progression Diagram Generator

52

Operation Spoke Phrase Comments

Listen "Start Listening"
"Listen"
"Pay Attention"
"Wake Up"

When you first start voice command recog-
nition, or after you give it the Stop Listen-
ing command, TS/PP-Draft ignores almost
everything you say until you give it this
command. See Tips (page 53) on using this
command.

Stop Listening "Stop Listening"
"Don't Listen"
"Sleep"

Give this command to effectively pause
voice command recognition. While paused,
TS/PP-Draft ignores almost everything you
say until you give it the Listen command.
See Tips (page 53) on using this command.

Save Diagram File "Save File"
"Save Diagram"
"File Save"

This is equivalent to clicking the  but-
ton on the Tool Bar or the Save command
under the File Menu to save the diagram
currently open.  This command works only
if the diagram already has a file name, so if
you've just created a new diagram file, be
sure to save it first, giving it a name, before
attempting to use this voice command.

Start GPS Tracking "Start Tracking"
"Start GPS"
"GPS On"
"Connect GPS"

This is equivalent to clicking the

 on the GPS

Receiver View or the  button on the
Tool Bar to make the connection to the
GPS receiver.

Stop GPS Tracking "Stop Tracking"
"Stop GPS"
"GPS Off"
"Disconnect GPS"

This is equivalent to clicking the

 on the GPS Re-
ceiver View or the corresponding button on
the Tool Bar to disconnect to the GPS re-
ceiver.

Start Recording Trip
Log

"Start Recording"
"Start Logging"
"Start Trip"
"Start Trip Log"

This is equivalent to clicking the

 button on the GPS
Trip Logs page or the corresponding button
on the Tool Bar to start recording a trip log.
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Stop Recording Trip
Log

"Stop Recording"
"Stop Logging"
"Stop Trip"
"Stop Trip Log"

This is equivalent to clicking the

 button on the GPS
Trip Logs page or the corresponding button
on the Tool Bar to stop the recording of the
trip log.

Get Geographic Coordi-
nates

"Mark Location"
"Mark Position"
"Mark Reading"
"Mark Spot"
"Mark Coordinates"
"Mark Measurement"
"Mark Point"
"Get Location"
"Get Position"
"Get Reading"
"Get Spot"
"Get Coordinates"
"Get Measurement"
"Get Point"
"Take Location"
"Take Position"
"Take Reading"
"Take Spot"
"Take Coordinates"
"Take Measurement"
"Take Point"
"Add Location"
"Add Position"
"Add Reading"
"Add Spot"
"Add Coordinates"
"Add Measurement"
"Add Point"

This is equivalent to clicking the

 button on the
geographic coordinates window to add the
current GPS reading to the list for the cur-
rently selected intersection.  To use this
command, you must first (manually) open
the Intersection Parameters window and

click the  button.  Once
you have this window open for any inter-
section, you may use voice commands to
advance the window to neighboring inter-
sections.
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Next Intersection (in
Forward direction)

"Next Intersection"
"Next Signal"
"Next Node"
"Go Forward"
"Step Forward"

This is equivalent to clicking the

 button on the geographic coor-
dinates window to advance the window to
next intersection in the "forward" direction. 
This prepares TS/PP-Draft to accept the
geographic coordinates of the next intersec-
tion by voice command.  To use this com-
mand, you must first (manually) open the
Intersection Parameters window and click

the  button.

Previous Intersection (in
Reverse direction)

"Previous Intersection"
"Previous Signal"
"Previous Node"
"Go Backward"
"Step Backward"

This is equivalent to clicking the

 button on the geographic co-
ordinates window to advance the window
to next intersection in the "reverse" direc-
tion.  This prepares TS/PP-Draft to accept
the geographic coordinates of the previous
intersection by voice command.  To use
this command, you must first (manually)
open the Intersection Parameters window

and click the  button.

Next or Previous Inter-
section

"Go North"
"Go South"
"Go East"
"Go West"
"Step North"
"Step South"
"Step East"
"Step West"

This can be equivalent to clicking the

 ( ) button on the
geographic coordinates window to advance
the window to next (previous) intersection
in the "forward" ("reverse") direction. 
Whether it's Next or Previous, and whether
it does anything at all, depends on the ori-
entation of the diagram.  That is, if you say
"North", then the Forward Direction must
be either "North" or "South" for this opera-
tion to take effect.

Synchronize Clocks "Synchronize Clocks"
"Synchronize Now"
"Synch Point"

This is equivalent to clicking the

 button on the GPS
Clocks Page to synchronize the traffic sig-
nal clocks with the GPS satellite clocks.
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Any of the spoken phrases can include "please" at the end, but TS/PP-Draft responds even without
hearing the magic word.

Tips on Using the Speech Recognition Engine

The following tips come in handy in using  Voice Commands to control the data collection through
a GPS receiver.

1. Use a head-mounted microphone.  The proximity to your mouth increases the signal-to-noise ratio
(i.e., it reduces background noise).

2. I'm told it's important to use a high-quality microphone.  For me, this advice is almost too vague to be
of value.  I don't know how to choose a "high-quality" mic; I know how to choose a high-priced mic,
but does that give me a high-quality mic?  I can only hope so.  One thing I do take from this advice is:
if you're having problems, a different microphone may help.

The display of head-mounted microphone at a local retail store shows that some manufacturers
mention "Speech Recognition" (or something equivalent) on the packages for some the microphone
models, but not for others.  That's probably an indicator of which of their models are high-quality. 

3. Position the mic a bit to the side of the mouth so air puffs don't get overamplified -- these are
especially associated with the consonants P and T.

4. Work through a few speech training sessions.  Speak naturally.  Do the speech training sessions in a
quiet space, free of the background noises of the vehicle and the road.

5. Use the Stop/Start Listening voice commands only for short intervals when you don't want the
software to respond to anything while you're doing some unrelated talking but expect to resume the
voice commands soon.  If you can easily turn the mic on & off, that would be even better.

6. When not using the speech recognition commands, turn off the Speech Recognition Engine entirely. 

I'm referring to either the  button on the Toolbar or the check box "Use voice command
recognition."  Toggle that button or uncheck that box when not in use.  When the button is down (and
the box is checked), the SRE continues to listen and learn.  So while you're cursing at traffic, it's
picking up bad habits.  (One day, it will start cursing back at you :-))  Over time, its performance will
deteriorate.

After you say Stop Listening, the SRE is still listening, and learning, it's just that TS/PP-Draft is
ignoring any recognized commands except for the Start Listening one.  For long intervals, it's best to
turn off the SRE altogether – toggle the button or uncheck the box "Use voice command recogni-
tion."  As long as the SRE is running and the mic is on, you're dealing with HAL in 2001.  If the
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button is still down (and the box is still checked) when you get back to the office, the SRE is still
listening and learning whenever you run TS/PP-Draft even though you no longer have the GPS
connected or anything.

7. If the performance deteriorates to the point of being too unreliable, create a new Speech Recognition
profile, delete your old one, and work through the speech training sessions all over again.
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Travel Time and Delay Report

You may preview and print out a report of the travel time and delay for logged trips along a dia-

gram/artery using the  button on the Tool Bar, or the TT & D Report command in the View Menu.
See the tutorial on How to Perform a Travel Time and Delay Study (page 11) for step by step

instructions on how to prepare a travel time and delay report from scratch.

You may choose which Trip Logs to include in the report from a list of trip logs involving the selected
diagram/artery.  The following figure illustrates some of the features of the trip log list.
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The report may optionally include, for each run  in each selected trip log, 3

• The name of the trip log and exact date and time it began,
• The intersection and direction of travel at which the trip entered the artery,
• The clock time and elapsed time (since the start of the trip log) at which the trip entered the artery,
• The Name of each subsequent intersection in the artery through which the trip passes,
• The clock time and elapsed time (since the start of the run) at which the trip crosses the intersection,
• The travel time from the previous intersection,
• The cumulative travel time to this intersection from the point of entry onto the artery,
• The distance traveled to this intersection from the previous intersection,
• The cumulative distance traveled to this intersection from the point of entry onto the artery,
• This distance traveled before the declared Design Speed was reached,
• The delay in traveling to this intersection from the previous intersection (calculated as the difference

between the actual travel time and the expected travel time as determined by the declared Design
Speed and Distance),

• The cumulative delay in traveling to this intersection from the point of entry onto the artery,
• The running time (i.e., travel time - delay) or expected travel time as determined by the declared

Design Speed and Distance),
• The cumulative running time since the beginning of the run,
• The delay in maximum-speed travel time from the previous intersection (calculated as the difference

between the actual travel time and the expected travel time as determined by the maximum speed and
Distance),

• The cumulative maximum-speed delay since the beginning of the run,
• The stopped delay, or time spent waiting in a queue while traveling from the previous node,
• The cumulative stopped delay since the beginning of the run,
• The time spent below two user-specified speeds while traveling from the previous node,
• The cumulative time spent below two user-specified speeds since the beginning of the run,
• The "free-flow" travel time (spent above the two user-specified speeds) while Traveling from the

previous node,
• The cumulative free-flow travel time (spent above the two user-specified speeds) since the beginning

of the run,
• The actual average or effective speed in travel from the previous intersection,
• The cumulative actual average speed in travel to this intersection from the point of entry onto the

artery,
• The user-specified Design Speed (or expected speed) in travel from the previous intersection,
• The maximum speed reached in travel from the previous intersection,
• The number of stops in travel from the previous intersection,
• The cumulative number of stops in the run,
• The travel distance before be stopped (or nearly stopped) at the first blockage,
• The travel distance from the first blockage to the center of the next intersection (this is an estimate of

the length of the queue), and
• The through movement volume.
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Use the  Preferences: Layout: TT&D Report section to choose which items to include in the report.  See
How Trip Logs are Processed (page 131) for some comments and definitions on how these items are
determined.

The end of the report includes summaries of these numbers, averaged over all trip logs of each type
(Before, After, and Neither).  Finally, it includes a Before & After difference -- that is, the difference
between the average of the "Befores" and the average of the "Afters".  The Before & After difference
shows how the average changes going from before to after.  Expect some of these numbers to be positive
and some to be negative.  For example, if the delay goes down (a negative number), then the average
speed goes up (a positive number).

Many users will wish to extract numbers from the trip log to include in a report formatted to local
specifications.  For this purpose, TS/PP-Draft makes it easy to copy and paste the report into spread-
sheets (e.g., Excel) or word processing documents (e.g., Word).

Click the  button to save the report in a file which can be imported into a spreadsheet or
word processing document.

Select the contents of the report and press Ctrl+C or right click and use the pop up menu to copy the
report to the clipboard for pasting into a spreadsheet or word processing document.

Click the  button to print the report.

TS/PP-Draft detects which intersections each trip log passes through by determining whether the trip
passes close to the center of the intersection.  "Close" means roughly within the intersection's radius,
allowing some tolerance for error in the GPS measurements.  If there is no median, the intersection's
radius is the Number of Lanes mutiplied by the Average Lane Width.  But if there is a wide median, this
calculation gives a width too narrow, and TS/PP-Draft may incorrectly decide that a trip log bypasses an
intersection it really passes through.  For this case, multiple GPS measurements, taken on the opposite
sides of the median or on opposite corners, allow TS/PP-Draft to estimate the intersection width
including the median.
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Plots from Trip Logs

You may generate plots, of Speed vs. Distance or Time vs. Distance, from logged trips along a

diagram/artery using the  button on the Tool Bar, or the Plots from Trip Logs command in the View
Menu.

When you use this command, the plot is initially of Speed vs. Distance.  Once the plot is displayed,
you may right-click on it and change to Plot Type from Speed vs. Distance to Time vs. Distance.

You're given a list of trip log runs involving the currently selected artery.  You may choose which
trip log runs to include in the plot; although, the plot will only include runs in the same direction of travel
-- that of the first selected run.  In addition, you have a choice of whether to include the
• Average Instantaneous Speed -- for a given distance along the artery, this is the average speed of all

the trip logs that pass through that location.
• Average Link Speed -- this is the average of the average link speeds of all the trip logs along the

given link.   The average link speed of a trip log is the total travel distance divided by the total travel
time along the given link.

• Design Speed from the Arterial Diagram -- the user-declared design speed, which can change from
link to link.

• Only the Averages, not the Trips -- the plot can get a little cluttered when there are many trip logs
included; in such cases, you may prefer to plot only the selected averages. 

By default, the plots are shown at an "optimal scale" -- a scale that shows all data with essentially no
extra space left over.  You may zoom by left-dragging a box around the region of interest.  Once zoomed,
you may right-drag to scroll through the plot and see regions off the screen.  While zoomed, TS/PP-Draft
treats the plot as though it were divided into multiple pages.  You may use the Page Up and Page Down
keys to quickly scroll to different regions of the artery, and when you print, you may choose to print one
or more pages.

If you observe any spurious points in the plot of any of the trip logs, you may manually delete these
points by carefully pointing to them with the mouse cursor, then clicking Alt + right-button.  You may
also use the Trip Log Filter (page 41) to automatically identify and remove spurious points.

For trip logs recorded "live" (i.e., not downloaded), the speed is a separate measurement by the GPS
receiver, independent of the position information.  The speed (and heading) are measured by the Doppler
shift in the frequency.  As a result, the plotted speed is a pretty good indication of the instantaneous
speed, not the average speed between two readings.

For trip logs downloaded (not recorded "live"), the speed is calculated as the average speed between
two readings.  This is usually less accurate.
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At first glance, it seems that the Time vs. Distance plot gives the same information as the trip logs
plotted as trajectories on the arterial diagram.  Nonetheless, there are some important differences, mostly
due to the Time vs. Distance plots' not including the signal timing information.

Time vs. Distance Plots
(which have no signal timing information)

Arterial Diagrams
(which include signal timing information)

The default vertical (time) scale is sufficient to
show the entire arterial travel time for each run.  

The vertical scale typically shows a user-selected
number of signal cycle lengths, and the plotted
trajectories wrap around to the first visible cycle
whenever they depart from the last cycle.

The plots mainly show the relation of trip log
trajectories to each other.

The diagrams mainly show the relation of trip log
trajectories to the signal timings.

The trip log trajectories all start with time=0 at
the point they enter the artery.  

The trip log trajectories are plotted, based on the
clock synchronization, to show the point in the
cycle at which the trip entered the artery.

Trip log trajectories for only one direction of
travel may be included on the plot.  This ensures
greater accuracy in the travel distances between
links.  To see the trajectories for the other direc-
tion of travel, you must create a second plot.

Trip log trajectories for both directions of travel
may be viewed on the diagram.  This is important
since the diagram is already showing the signal
timings for both directions of travel as well.

The position of the intersections on the plot is
always determined by the average of the actual
travel distance of each trip log included in the
plot.

The position of the intersections on the diagrams
is determined entirely by the user-declared dis-
tance from the previous intersection.

This last item has an implication worth mention.  The various plotted trip logs don't all necessarily agree
on what the travel distance is for a given link, regardless of whether this distance is determined by an
average of the plotted trip logs or a user-declared value.  Where the travel distance for a particular plotted
trip logs doesn't quite agree with the plotted travel distance along a given link, the error is divided over
the entire link (uniformly, in the case of the Speed or Time vs. Distance plots).  As a result, the horizontal
scales can differ (generally only slightly) between the trip logs on a link, and they can differ for a given
trip log over the various links.  This is true for both the Trip Log Plots (either Speed vs. Distance or Time
vs. Distance) and the Arterial Diagrams.

You may control the appearance of the plot labels in the Layout page the Preferences dialog.
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Viewing & Editing Parameters

The View pull down menu contains various commands to view and edit the parameters.  You may
edit the Network, Diagram/Arterial, or Intersection parameters, or edit the diagram directly in the
diagram window.

Network Parameters

These are parameters which affect all arteries and diagram windows in the diagram file. They are
displayed in Network Parameters dialog where you can examine and change them at will.

Use the  button on the Tool Bar to quickly show the Network parameters. You may also use the
Network command in the View Menu.

Cycle Length.  The Cycle Length of the signals on the artery is measured in seconds.
If the Vertical Scale of any diagram window isn't locked (as described on page 64), then changing the

Cycle Length causes TS/PP-Draft to automatically reset the Vertical Scale of the diagram to accommo-
date exactly the desired number of cycles on the diagram (you can then override this Vertical Scale if you
desire).

You can prevent the automatic resetting of the Vertical Scale by setting the number of cycles
parameter (next to the Vertical Scale in the Diagram/Arterial Parameters dialog) to "Locked."  You can
also have TS/PP-Draft recalculate the default scale at any time by setting the desired number of cycles.  

On Time-Space diagrams, changing the Cycle Length also causes TS/PP-Draft to reset the Width of
the Green Bands to the Split for the through traffic at the intersection at which the green band originates,
minus the Start Up and Clearance Lost Times.

Finally, changing the Cycle Length resets the Adjusted Cycle Lengths (when measured in seconds)
of all of the intersections in all diagram windows.  The ratio of these Cycle Lengths, as specified in the
Intersection Parameters dialog, is unaltered.

When you change the Cycle Length, TS/PP-Draft offers to change all the Design Speeds along the
arteries in all diagram windows in order to preserve the signal coordination.  This is especially useful
when you already have a satisfactory coordination plan for a set of arteries at a certain time of day, and
wish to use essentially the same coordination a another time of day during which the Design Speeds are
different. If the Design Speeds are, say, 10% greater at the new time of day, simply reduce the Cycle
Length by 10% and TS/PP-Draft offers to adjust all Design Speeds accordingly (while maintaining the
coordination).
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Synchronize Scales.  These check boxes indicate whether TS/PP-Draft should ensure that the
horizontal or Vertical Scale is consistent across all diagram windows.  When this is checked for one of
the scales, then changing that scale in any diagram window causes TS/PP-Draft to change that scale in all
diagram windows.

Flow Baseline on Platoon-Progression Diagrams.  These radio buttons determine the flow
levels displayed on Platoon-Progression diagrams.  

The flow is depicted as a series of bands with dot patterns  (in which the dot density is proportional
to the vehicle density) and colors.  These bands indicate what percentage of a saturation flow uses the
corresponding section of the artery at the corresponding time in the cycle.  The Saturation Flow Baseline
determines which saturation flow is used as a reference for displaying these flow bands.

Choose between
• Link Downstream Saturation Flow
• Arterial Maximum Downstream Saturation Flow
• Network-wide Maximum Downstream Saturation Flow

The default is Link Downstream Saturation Flow, meaning the flow bands along each link reference
that link's Downstream Saturation Flow.  As the downstream saturation flow can change from link to link
(as, for example, the Number of Lanes changes), it can be difficult to fairly compare the flow between
adjacent links using the default.

The second choice, Arterial Maximum Downstream Saturation Flow, uses a common saturation flow
baseline for all links in a given direction of travel along the artery.  This baseline is the maximum of the
intersections' Downstream Saturation Flows in the given direction on the artery.

The third choice, Network-wide Maximum Downstream Saturation Flow, uses a common saturation
flow baseline for all links in all directions of travel along all arteries.  This baseline is the maximum of
all intersections' Downstream Saturation Flows in either direction on all arteries.

Diagram/Arterial Parameters

These are parameters which affect the entire diagram and artery and every intersection along the
artery. They are displayed in the Diagram/Arterial dialog box where you can examine and change them at
will.
To quickly show the Diagram/Arterial parameters for the selected diagram, you may use

• the  button on the Tool Bar, or

• the  button in the Outline View, or 
• a double click on the title or intersection names in the diagram window, or 
• the Diagram/Arterial command under the View Menu.
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Some Diagram/Arterial parameters are ignored by TS/PP-Draft depending on the Type of Diagram. 
TS/PP-Draft disables these parameters (i.e., shows them in grey) or, in some cases, doesn't show them at
all.

Changing the values of certain parameters alters the values of other parameters. For example, if you
change the diagram Height or the Cycle Length, TS/PP-Draft automatically changes the Vertical Scale so
as to show the desired number cycles on the diagram. As a result, you shouldn't set the value of those
parameters which will be altered by your later editing other parameters. To facilitate this, TS/PP-Draft
positions, as much as possible, the "affected" parameters somewhere below the "affecting" parameters, so
generally if you work from top to bottom then TS/PP-Draft won't change any of your work.  The
parameters which are affected by changes in other parameters are described herein along with the other
Diagram/Arterial parameters, and for convenient reference, a table of these parameters is given in
Appendix A.

Type of Diagram.  Use this set of radio buttons to indicate whether the diagram is a

• Time-Space diagram – with green bands showing the approximate location of the platoon), 
• Platoon-Progression diagram – showing the traffic flow and queue length with dot density corre-

sponding to vehicle density.
• Time-Location (I've heard this also called a "compressed time-space diagram") – showing the green

bands, but in such a way that they're horizontal rather than slanted, and the Horizontal Scale has no
meaning other than to indicate the sequence of the intersections.  This is accomplished by artificially
offseting each ring in the signal timing strip by the travel time from the upstream intersection in the
direction of travel corresponding to that ring.  This effectively removes the meaning of "Space" in the
Time-Space diagram, and the diagram is then collapsed so the intersections are displayed with a
small, uniform spacing, independent of the true distance between intersections.  For this type of
diagram, it's best to choose a Vertical Scale such that at least 4 cycles are visible in the diagram.  The
lower half of the diagram shows the signal rings and bands corresponding to the forward-bound
traffic (from left to right on the screen), and the upper half shows the rings and bands corresponding
to the reverse-bound traffic.

You may also edit the type of diagram by

• using the  button on the Tool Bar, or
• directly on the Diagram Window by clicking the right mouse button and selecting "Type of Diagram"

from the pop up menu, or
• by simply pressing Control+T with the diagram in the foreground.

Diagram Position.  This specifies the position on the page of the printed diagram in the units
specified in the Units of Measurement page of the Preferences dialog box (inches or centimeters).

These margins are ignored if the Center on the Page check box is checked.  In this case the margins
are calculated for you automatically based on the paper size and the Diagram Size.
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The margins refer to the diagram, not to the page. Thus, the top margin is always the distance
between the top of the diagram and the edge of the page. Of course, whether this is the top edge or the
left edge of the page depends on the paper orientation (Portrait or Landscape).

You may save the diagram Position along with other basic Diagram/Arterial Parameters in a
Template, which you may then apply to other diagrams to ensure a consistent appearance.  See page 108
for more information.

Diagram Size.  This specifies the size of the diagram on the page, independent of the page
orientation (Portrait or Landscape).  (Thus, "width" refers to width across the diagram, not across the
page).  The size is measured in the units specified in the Units of Measurement page of the Preferences
dialog box (inches or centimeters).

Changing the diagram width causes TS/PP-Draft to reset the horizontal scale (if it is unlocked). The
scale is chosen so that the entire artery may be seen without any "excess" space; this enables you to make
efficient use of the diagram space while maintaining high resolution. Similarly, changing the diagram
height causes TS/PP-Draft to reset the Vertical Scale (if it is not locked) so that exactly the desired
number of cycles are shown on the diagram.

The diagram is displayed in its window with the same "aspect ratio" (height-to-width) as you specify,
but compressed or expanded according to the Zoom Factor set on the Tool Bar.  This helps you manage
diagrams too large to fit on the screen.

You may save the diagram Size along with other basic Diagram/Arterial Parameters in a Template,
which you may then apply to other diagrams to ensure a consistent appearance.  See page 108 for more
information.

Vertical Scale.  The Vertical Scale is measured in seconds per screen length unit (inch or
centimeter, as specified in the Units of Measurement page of the Preferences dialog box described on
page 126).

The Vertical Scale is accurate on the printed diagram.  The scale of the diagram window on the
screen is modified by the Zoom Factor on the Tool Bar.

To help you take accurate measurements from the diagram, TS/PP-Draft draws tic marks on the
edges of the diagram or grid lines (as selected in the Layout page of the Preferences dialog; see page 119)
marking off regular intervals (determined by the Seconds Per Mark parameter).  In addition, TS/PP-Draft
prints out all of the necessary timings when you print-out the parameters reports, making most measure-
ments unnecessary.

Next to the Vertical Scale edit field is a drop down list box which indicates whether the scale is
locked or, if not, how many cycles are shown on the diagram.

Selecting "Locked" locks the Vertical Scale so it is unaffected by any other changes you may make. 
Selecting a value other than "Locked", such as "2 cycles", 3"cycles", . . ., or "8 cycles" indicates that
TS/PP-Draft should automatically reset the Vertical Scale to show the desired number of cycles each
time a parameter is changed that would affect these scales. In this case, TS/PP-Draft automatically resets
it whenever you change the Cycle Length, Diagram Height, or Font Size. 

Depending on your settings in the Layout parameters, TS/PP-Draft will ensure that this is a standard
scale.
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Choosing "4 cycles" is especially useful on Platoon-Progression diagrams when you are showing the
flow on alternate pairs of cycles and on Time-Location diagrams when you are not showing both rings on
all cycles.

When it isn't locked, you shouldn't set the Vertical Scale until after the Cycle Length has been set,
and only then if you need a different scale. The cases where you need to change the Vertical Scale will
probably be rare and restricted to those times when you need a standard scale (such as 30 or 50 seconds
per inch) or when you need to see more cycles in the diagram.

You can easily reset the Vertical Scale to the default value by clicking on the drop down list box and
selecting the desired number of cycles (even if the number is already selected). This always resets the
scale if it isn't locked.

Horizontal Scale.  The Horizontal Scale is measured in the units specified in the Units of
Measurement page of the Preferences dialog box (feet per inch, meters per centimeter, etc.).

The Horizontal Scale is accurate on the printed diagram. The scale of the diagram window on the
screen is modified by the Zoom Factor on the Tool Bar.

TS/PP-Draft prints the specified Distances between intersections when you print the report of
parameters of the diagram, making most measurements unnecessary.

Next to the Horizontal Scale edit field is the Unlocked check box, indicating whether TS/PP-Draft
should automatically reset the Horizontal Scale each time a parameter is changed that would affect it.
Leaving the Unlocked box blank locks the corresponding scale so it is unaffected by any other changes
you may make. 

When this box is checked, TS/PP-Draft automatically resets the Horizontal Scale each time you
change the diagram Width, specify the Distance between consecutive intersections, add an intersection,
or delete one of the boundary intersections. The scale is chosen so that the entire artery may be seen
without any "excess" space; this enables you to make efficient use of the diagram space while maintain-
ing high resolution. Depending on your settings in the Layout parameters, TS/PP-Draft will ensure that
this is a standard scale.

As a result, you shouldn't  set the Horizontal Scale until after you specify the Distances between the
intersections, and only then if you need a scale other than the one selected by default. The cases where
you need to change the Horizontal Scale will probably be rare and restricted to those times when you
need a standard scale (such as 300 or 500 feet per inch) or when you need to see more detail in certain
sections of the artery. 

You can easily reset the Horizontal Scale to the default value by checking the Unlocked check box.
To do this, you may have to first uncheck the box, then rechecking it will reset the Horizontal Scale.

For long arteries, or arteries with many intersections, the spacing of the intersections can become
crowded at the default Horizontal Scale, making it difficult to see the green bands or make out the signal
timing details.  In these cases, you may drag a box on the diagram window to select the intersection(s) of
interest.  TS/PP-Draft zooms to the selected region of the diagram by adjusting the Horizontal Scale and
the Distance from the left margin to the first intersection.  Think of the zoomed diagram as being split
into multiple pages.  Use the Page Up & Page Down keys to jump to the next page.  The Print dialog
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allows you to select more than one page for printing.  These overlap a little, so you could tape the
multiple printed pages together to form one long diagram.

Name of Diagram/Arterial.  The Diagram/Arterial name is used at the top of the drawn diagram,
at the top of the Diagram/Arterial Parameters Report, and at the beginning of the exported ASCII file.

The name may be up to 60 characters long.  You may use those characters to give any information
useful to you: diagram title, arterial name, time of day of signal timing plan, peak time, etc.

Under the Fonts tab in the Diagram/Artery dialog box, you may select the size and style of the font
used for showing the name on the drawn diagram.

Notes.  The diagram/arterial Notes is strictly for your use, to store any additional information you
wish to associate with the diagram or artery: group number, time of day, signal timing plan, etc.  The
notes appear at the top of the diagram/arterial parameters report, but are otherwise unused by TS/PP-
Draft. 

The notes may be up to 60 characters long. 

Forward Direction.  This is a drop down list box indicating the direction to your right as you view
the diagram: North, South, East, or West.  It should be specified so that TS/PP-Draft can refer to the
various movements by their proper names.

You may locally override the arterial Forward Direction at any intersection.  This allows turning
arteries and triangular blocks.

When you have linked everything between two intersections in different diagram windows (see page
106), TS/PP-Draft relies on the Forward Directions of the two arteries, or the locally overridden Forward
Direction at their common intersection (to model turning arteries and triangular blocks),  to maintain
consistency between the directional parameters at the two intersections.  If you change the Forward
Direction of one of these arteries, TS/PP-Draft must reset the directional parameters at the intersections
to restore consistency.  If you don't want TS/PP-Draft to do this, you must break the link before changing
the Forward Direction.  In either case, be wary of changing the Forward Direction along an artery which
has intersections linked to arteries in other diagram windows!
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Offset Reference Point Refers to

Start of first through movement Beginning of the green time for the first through move-
ment of the artery to be served, regardless of direction of
travel.

Start of second through move-
ment

The beginning of the green time for the second through
movement of the artery to be served, regardless of direc-
tion of travel.

Start of the arterial phase The beginning of the service to the artery, regardless of
the movement (turning,  through, or pedestrian).

End of the last through move-
ment green

The end of the green time (or beginning of yellow) for
the last through movement of the artery to be served,
regardless of direction of travel.

End of the penultimate through
movement green

The end of the green time (or beginning of yellow) for
the second-to-last through movement of the artery to be
served, regardless of direction of travel.

End of the arterial phase green The end of the service to the artery, regardless of the
movement (turning, through, or pedestrian).

End of last through movement
walk

The end of the walk time (or beginning of flashing don't
walk) for the last through movement of the artery to be
served, regardless of direction of travel

End penultimate through move-
ment walk

The end of the walk time (or beginning of flashing don't
walk) for the second-to-last through movement of the
artery to be served, regardless of direction of travel.

End of arterial phase walk The end of walk time (or beginning of flashing don't
walk) to the artery, regardless of the movement, turning,
through.

Table I. The choices for the Offset Reference Point and their meanings.

Offset Reference Point.  The Offset Reference Point is a drop-down list box that determines the
point in the cycle to which the intersection signal offsets refer.  The reference points are listed and de-
scribed in Table I and depicted graphically in Table II.
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Table II.  The location of the Offset Reference Points for different left-turn Phase Sequences.  The
solid black lines indicate red time for the artery.  Time increases in the upward direction.  The walk
and flashing don't walk phases are shown only implicitly (not explicitly).
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A cross-traffic turn is a 
4

• left-turn in right-hand Drive Rule regions (North & South America, China and continental Europe).
• right-turn in left-hand Drive Rule regions (Great Britain, Australia, New Zealand, South Africa, and much of

Asia).
See page 127 for details.
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Example: Suppose at a certain intersection the Adjusted Cycle Length is 80 seconds, there is no
protected cross-traffic  turning movement in the South-bound direction, and there is a leading cross-4

traffic turning movement in the North-bound direction beginning 20 seconds after time zero.  If the
Offset Reference Point is the start of the first through movement, then the offset would be set to 25% and
would reference the North-bound through/cross-traffic-turning movement.

The Offset Reference Points "start of first through movement" and "start of arterial phase" are
identical for all protected turn Phase Sequences except for the one where both directions of travel have
leading turning movements.  In all other cases, the beginning of the first through movement coincides
with the beginning of service to the artery.  Similarly, the reference points "end of last through move-
ment" and "end of arterial phase" are identical except for where both directions of travel have lagging
cross-traffic turns.

The default Offset Reference Point may be specified in the Defaults page of the Preferences dialog
(see page 128), but setting it as a diagram/arterial parameter overrides the default.  In addition, any
intersection can override the diagram/arterial parameter.

Changing the Offset Reference Point causes TS/PP-Draft to change that of every intersection in the
diagram.  Changing the Offset Reference Point does not affect the value of any of the intersection signal
offsets; however, it does affect the point to which the signal offsets refer.  Thus, changing the Offset
Reference Point does shift the signals in time, resulting in an effective change in offsets, but the values of
the offsets themselves are unchanged.

The Offset Reference Point does not affect the reference point of the offsets of the green band bands
(on Time-Space diagrams).  These always refer to the point at which the green bands begin, which will
be near the front of the platoon if a queue has built up.  However, since changing the Offset Reference
Point does effectively shift the intersection signals in time, this change will cause TS/PP-Draft to reset
the offsets of all of the green bands (both arterial and new) to their default values.

Vehicle Length.  This is used on Platoon-Progression diagrams only.  It is the average length
occupied by a vehicle stopped along the artery, and it is measured in units set in the Units of Measure-
ment page of the Preferences dialog box (feet, yards, meters, etc.) described on page 126 (feet, yards,
meters, etc.).  The default is set in the Defaults page of the Preferences dialog box (page 128), but any
diagram can override the default.

The Vehicle Length is used to calculate the length of the queues for a particular lane group, so it
applies only to the traffic in that lane group on the artery.  The queue length is calculated as NL/n where

N = Number of vehicles in queue
L = Vehicle Length
n = Number of lanes in the lane group

Caution!  If the queue at an intersection backs up beyond the upstream intersection, then usually the
flow and queues on the Platoon-Progression diagram will be inaccurate.  The flow and queue can still be
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Dispersion
Factor

Roadway Condition Description

0.50 Heavy friction Combination of parking, moderate to heavy turns or pedestrian traffic, nar-
row lane width.

0.35 Moderate friction Light turning and pedestrian traffic, 11 to 12 foot lanes (3.4 to 3.7 meter),
possibly divided.

0.25 Low friction No parking, divided, turning provisions, 12 foot (3.7 meter) lane width.

Table III. The Platoon Dispersion Factors recommended by the TRANSYT-7F manual.

accurate if the queue backs up into the upstream intersection (1) during the green time of the upstream
intersection, and (2) when there are no vehicles leaving the upstream intersection.  The second restriction
means that at the time when the queue backs up into upstream intersection, there are no vehicles arriving
at the upstream intersection and there is no queue waiting at the upstream intersection.  These criteria are
strict, so a queue backing up into the upstream intersection usually indicates that you should not trust the
diagram.  Unless you are sure these criteria are met, you should either adjust the timing parameters of the
diagram to prevent the back up or not use a Platoon-Progression diagram at all for that artery. 

Dispersion Factor.  This is used on Platoon-Progression diagrams only.  It is the arterial platoon-
dispersion factor.  The default may be set in the Defaults page of the Preferences dialog (page 128), but
any diagram can override the default.

TS/PP-Draft uses the platoon dispersion model developed for TRANSYT-7F.  Table III gives the
values the TRANSYT-7F manual suggests using.

The higher the Dispersion Factor, the more the platoon disperses as it travels downstream.  The
platoon does not disperse if the Dispersion Factor is zero.

You may limit the time for which the Dispersion Factor is applied (and thereby limit the long-term
platoon dispersion) by setting the maximum Dispersion Time.

Refer to the TRANSYT-7F manual for a detailed description of the dispersion model.  It is available
from the Center for Microcomputers in Transportation (McTrans) at the University of Florida.

Dispersion Time.  This is used on Platoon-Progression diagrams only. It is a means of limiting the
arterial platoon-dispersion.

TS/PP-Draft uses the platoon dispersion model developed for TRANSYT-7F. Some traffic engineers
feel that this model allows more dispersion between widely-separated intersections than they observe in
the field. They observe that platoons tend to disperse noticeably for a short time, after which the platoons
stop dispersing (and the platoons remain roughly intact for long times).
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You may simulate this behavior with the maximum Dispersion Time, which sets an upper limit to the
amount of time TS/PP-Draft allows platoons along the artery to disperse.  After platoons have progressed
for this amount of time, TS/PP-Draft effectively sets the Dispersion Factor to zero.

I know of no accepted "best value" for the maximum dispersion time, but I believe it should not be
less than the time it takes the platoon to accelerate to constant speed. Strictly speaking, the maximum
dispersion time should be the sum of a constant term plus a term proportional to the average platoon
speed, but this would introduce only a minor correction for which there is no accepted measure as far as I
know.

One-way.   The One-way check box indicates whether the (entire) artery allows traffic flow in only
one direction.  This option can be set for at most one direction of travel.

If the One-way box is checked for one of the directions of travel, TS/PP-Draft:
• Does not draw the side of the intersection signal strips or the green band that correspond to that

direction of travel.
• Changes the protected Turn Phase Sequences of the intersections to "None" since there is usually no

protected cross-traffic turning movement on a one-way street.
• Prevents you from changing the cross-traffic Turn Phase Sequences or the Green Band Action at an

intersection in the nonexistent direction of travel.
• Does not show the Split for the nonexistent through movement on the  report of the diagram

parameters.

Show Flow on )))) Cycles.  This is a drop down list box indicating the cycles on which the
flow is shown on a Platoon-Progression diagram.  For each direction of travel, the flow may be shown
on: all cycles, alternating cycles, alternate two cycles, or no cycles.

When the flow is shown on alternating cycles, it starts with the first (bottom most) cycle for right-
bound÷ traffic, and with the second cycle for ²left-bound traffic.

When the flow is shown on alternate two cycles, it starts with the first (bottom most) pair of cycles
for right-bound÷ traffic, and with the second pair of cycles for ²left-bound traffic. In this case, you may
wish to set the Vertical Scale to show exactly four cycles by selecting 4 Cycles in the Vertical Scale drop
down list box.

You may also edit the flow directly on the Diagram Window by clicking the right mouse button and
selecting "X-bound Flow" from the pop up menu (where X is the direction of travel of the band to be
altered, North, South, East, or West).

Show All-Clipped Band.  This check box allows you to overlay a "traditional," all-clipped band
on top of any  Type of Diagram.  This band is one for which the Green Band Action is set to "Clip" for
all interior intersections.  This is the same type of band that PASSER calculates and optimizes, and it's
what many traffic engineers think of when they hear The Green Band.

When overlayed on top of a  Platoon-Progression diagram, this band gives an indication of how
representative the traditional green band is of the actual arterial flow.  When there are heavy volumes
from the side streets, or when the band arrives late in the green time and a red indication stops a fair
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amount of traffic (resulting in an appreciable queue), then the traditional green band is often a poor
description of actual arterial flow. 

Diagram Fonts.  Under the Fonts tab, you may indicates the size and style of the character font
used at different locations in drawing the diagram. You may set different fonts for the Diagram Name (or
title), the Intersection Names, (on Time-Space and Time-Location diagrams) the Band Design Speed (if
you've opted to Show the Band Speeds in the Layout page of the Preferences dialog), or the Splits (if
you've opted to Show the Splits)..

Changing the font size of the diagram name or intersection names causes TS/PP-Draft to reset the
Vertical Scale (if it isn't locked) to accommodate exactly the desired number of cycles on the diagram.
You can then override this Vertical Scale if you wish.

You may save the Fonts along with other basic Diagram/Arterial Parameters in a Template, which
you may then apply to other diagrams to ensure a consistent appearance.  See page 108 for more
information.

Intersection Parameters

These are parameters which affect only a specific intersection.  They are displayed in the Intersection
Parameters dialog box where you can examine and change them at will.

To quickly show the Intersection parameters for the selected intersection, you may use

• the  button on the Tool Bar, or

• the  button in the Outline View, or
• a right click on a selected intersection in the diagram window, selecting "Intersection" from the pop

up menu, or
• a double click on the intersection in the diagram window, or
• the Intersection command under the View Menu

Some of the Intersection Parameters are ignored, depending on the Type of Diagram.  The
ignored parameters include the Lanes, Volumes, and Saturation Flows, among others.  Although these
aren't needed for Time-Space diagrams, they are used when exporting UTDF (Universal Traffic Data
Format) files (see page 133) for use in other programs.  As a result, TS/PP-Draft displays these parame-
ters and lets you edit them, even though they might not be necessary for your diagram.  If you don't need
to view  Platoon-Progression diagrams, and won't need to export UTDF files, you may safely ignore these
parameters.

Changing the values of certain parameters alters the values of other parameters.  For example, if
you change the Distance from the previous intersection, TS/PP-Draft automatically changes the Horizon-
tal Scale so the entire diagram may be seen on the screen without any "excess" space.  As a result, you
shouldn't set the value of those parameters which will be altered by your later editing  other parameters. 
To facilitate this, TS/PP-Draft puts the "affected" parameters somewhere below the "affecting" parame-
ters, so if you work from top to bottom TS/PP-Draft won't change any of your work.  The parameters
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which are affected by changes in other parameters are described herein along with the other intersection
parameters, and for convenient reference, a table of these parameters is given in Appendix A.

Name of the Intersection.  For maximum clarity, TS/PP-Draft allows you to refer to the
intersections by their true names. The intersection name is displayed on the diagram window and in the
report of the diagram/arterial parameters as well as in the exported ASCII file.

The intersection name may be up to 60 characters in length. You may use these characters to
show any information useful to you: name of cross street, controller group number, node number, etc.

In the Diagram/Arterial Parameters dialog, you may select the size and style of the Font used for
showing the Intersection Names on the diagram.

You may set the number of lines or rows on which TS/PP-Draft shows the Intersection Names on
the diagram in the Layout page of the Preferences dialog (see page 119).  TS/PP-Draft shows the names
on alternating lines to reduce the chance of adjacent names overlapping.

Distance from Previous Intersection.  The Distance from the previous intersection is
measured in the units specified in the Units of Measurement page of the Preferences dialog described on
page 126 (feet, yards, meters, etc.).

Click the  button to determine the actual travel distance using one or more
Trip Logs (page 38).  This button is enabled only if there are trip logs involving travel between these two
intersections.  You may select which trip logs to use in the calculation from a list of all trip logs that
include these two intersections.  The figure below illustrates some of the features of the list of trip logs.
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If there are bends or an appreciable grade between the intersections, the trip logs usually give more
accurate calculation of the travel distance than using the Geographic Coordinates of the intersections.

TS/PP-Draft automatically resets the Horizontal Scale (provided it is unlocked) and the Distance
to the first intersection from the left margin each time you change the Distance between two intersec-
tions, Add an intersection, or Delete one of the boundary intersections. Consequently, you should refrain
from setting the Distance to the first intersection from the left margin until after you set the Distances
between the other intersections, and only then if you need the first intersection located at some position
other than the left margin. 

For example, you can zoom in on certain sections of the artery by setting the Horizontal Scale to
a small value (thereby magnifying the artery) then setting the Distance to the first intersection from the
left margin to whatever value is necessary to position the desired section on the diagram. For this
purpose, the Distance to the first intersection from the left margin can be negative, shifting the artery off
of the diagram to the left.  This zooming is most easily accomplished by dragging directly on the diagram
to select one or more intersections.

Note that locating the first intersection further in on the screen will push the last intersection off
of the screen unless you have first set the Horizontal Scale to account for this.

You can prevent the automatic resetting of the Horizontal Scale by not checking the Unlocked
check box parameter (described on page 65) to "No."  You can also have TS/PP-Draft recalculate the
default scale at any time by checking the Unlocked check box.
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ID Number.  This is a number you can use to identify the intersection.  
TS/PP-Draft uses it only when importing or exporting UTDF files (see page 133) and importing

or exporting geographic coordinates.  The companion utility CopyFromDgmFile (page 139) also uses the
ID number when copying intersection parameters from one Diagram File (*.Dgm) to another. If you're
not going to be using UTDF files, geographic coordinate files, or the CopyFromDgmFile utility, you may
safely ignore this number.

 The ID Number must be greater than or equal to 0.
TS/PP-Draft allows node ID numbers as high as 2,147,483,647, but Synchro requires them to be

in the range 1...9999, so if you're exporting UTDF files to import into Synchro (page 133), you'll want to
keep them within the lower range.

Notes.  The intersection Notes is strictly for your use, to store any additional information you
wish to associate with the intersection: controller number, signal timing plan, etc.  The notes appear in
the intersection parameters  report, but are otherwise unused by TS/PP-Draft.

The notes may be up to 60 characters long. 

Forward Direction.  This is a drop down list box indicating the direction to your right at this
intersection as you view the diagram: North, South, East, or West.   By default, it is the arterial Forward
Direction, but you may locally override it at any intersection to model turning arteries and triangular
blocks.

It should be specified so that TS/PP-Draft can refer to the various movements by their proper
names.

It is necessary to specify a Forward Direction when linking two different arteries at their
common intersection.

Geographic Coordinates.  The Geographic Coordinates are the East longitude and North
latitude of the center of the intersection, as reported by the GPS receiver.

The Geographic Coordinates are used when tracking your current location with the GPS receiver

on the diagram window, or displaying recorded Trip Logs (page 38) in the diagram, preparing 
Travel Time and Delay Reports (page 55), measuring the distance between intersections (using either trip
logs or Geographic Coordinates directly), measuring the average speed between intersections using trip
logs, and laying out the Network View.

Click the  button to view or modify the list of measurements used to deter-
mine the geographic coordinates.

There are 4 ways to enter the geographic coordinates:
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1. To add the current GPS coordinates as a measurement, click the  button, or

say "Mark Point" (if  voice command recognition is enabled).  Although you must start
tracking with the GPS receiver in order to add a measurement, clicking the

 button will initialize the connection to the GPS receiver, provided it's
already plugged into the serial port and configured correctly.  Once GPS tracking has begun,

each click of the  button will add the current GPS reading to the list of
measurements.

2. To enter the geographic coordinates manually, click the  button.  The
manually entered coordinates must be in the same geodetic datum in which the GPS receiver
supplies coordinates by default (typically WGS-84).  Don’t worry too much if this is not the best
geodetic datum to use in your region of the globe – using the “wrong” geodetic datum results in a
net bias on the coordinates, but TS/PP-Draft’s calculations are based only on relative positions,
so the net bias has no significant affect.  Consistency is more important.

3. The  button is available only if the current intersection already has geographic
coordinates information and there are intersections, besides the current one, with no geographic
coordinates information but with valid X-Y grid coordinates.  Typically, this occurs after
importing from UTDF files, which contain X-Y grid coordinates but no geographic coordinates.

Clicking the  button will use the current intersection's geographic coordinates along
with the X-Y grid coordinates of the this intersection and the other intersections to calculate their
geographic coordinates.  This can save time collecting geographic coordinates, but there can be
some drawbacks: Some initial tests suggest that the X-Y grid coordinates are often considerably
less accurate than GPS measurements.  The resulting inaccuracy will be carried over into Travel
Time and Delay reports.  Also, with just the one calculated geographic coordinates, the width
(and its standard deviation in GPS readings) of these intersections is known with less certainty
than when there is more than one measurement, as discussed below.

4. At present, the  button is available only for Garmin GPS receivers and only if
the type of GPS receiver is set to Garmin (Proprietary).  Click this button to download a list of all
waypoints stored in the GPS receiver.  Once the list is downloaded, you may assign each
waypoint to an intersection.

5. To import a text file containing the geographic coordinates of some or all the intersections in the
system, right-click in the list of measurements and choose Export Coordinates from the pop-up
menu.  Text files can be exported from mapping software for importing into TS/PP-Draft.  The
text file has one intersection with its set of coordinates per line.  As far as TS/PP-Draft is
concerned, there must be at least 3 numbers on each line, and any other characters surrounding
the numbers are ignored; although, characters between the numbers act as delimiters. The first
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two number are the North Latitude and East Longitude (degrees). The third number is the
intersection ID Number.  When TS/PP-Draft exports these files, it adds the Name of the intersec-
tion to the end of the line, but as mentioned above, this text is ignored upon importing the file. 
As an example, two lines from this file might look like

42.1199347,-80.1108715,ID:25;Cranberry St.
42.1208706,-80.1083663,ID:27;Raspberry St.

The red bolding indicates the text from these lines meaningful to TS/PP-Draft; the rest is
ignored (except as delimiters). 

Note that when practical, it's best to include more than one set of coordinates for each
intersection -- possibly coordinates of the different corners of the intersection.  As discussed
below, when there are multiple coordinates, TS/PP-Draft determines the intersection's width (and
its standard deviation in GPS readings) with more certainty than when there is just one measure-
ment.

There are two reasons for taking the average of a list of GPS measurements to determine the
geographic coordinates:
• Safety -- The geographic coordinates of the center of the intersection is given by the average of

measurements straddling the center.  Thus, rather than risking your personal safety by standing in
the center of the intersection to take a GPS reading, you may stand at each of the corners of the
intersection, or any other set of points that straddle the center, and take measurements at each of
those points.  Or you may take measurements while riding in a moving vehicle, by clicking the

 button when you cross, say, the stop bar in each direction of travel.
• Accuracy -- On average, GPS receivers can provide the horizontal position accurate to within

about 15 meters.  The actual accuracy is dependent on many things, including time of day, time
of year, and weather conditions especially in the upper atmosphere (the ionosphere).  Some of
the errors in the measurement are random (as opposed to biased or systematic).  The random
errors can be reduced by averaging multiple measurements together.  So to improve the accuracy
of the measurement of the geographic coordinates of the center of the intersection, you can take
multiple measurements at different times of day, different times of year, and under different
weather conditions.

• Width -- Two or more of GPS measurements, taken on opposite sides of the street, allow
TS/PP-Draft to estimate the width of the intersection.  In preparing  Travel Time and Delay
Reports, TS/PP-Draft detects which intersections each trip log passes through by determining
whether the trip passes close to the center of the intersection.  "Close" means roughly within the
intersection's radius, allowing some tolerance for error in the GPS measurements.  If there is no
median, the intersection's radius is the Number of Lanes multiplied by the Lane Width.  But if
there is a wide median, this calculation gives a width too narrow, and TS/PP-Draft may incor-
rectly decide that a trip log bypasses an intersection it really passes through.  For this case,
multiple GPS measurements, taken on the opposite sides of the median or on opposite corners,
allow TS/PP-Draft to estimate the intersection width, including the median, and the standard
deviation of the width from GPS readings.  See How Trip Logs are Processed for additional
details.
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Warning: It is not safe to operate a computer (including laptop and notebook computers) while
operating a vehicle!  If you wish to perform any of the above procedures while in a moving vehicle, have
someone else drive the vehicle while you operate the computer.  You take full responsibility and accept
all liability for any damage or injury that may occur as a result of your operating a computer while
driving a vehicle.

When taking measurements in a moving vehicle, TS/PP-Draft tries to compensate for the lag time
since the GPS receiver last reported the position.  Since the GPS receiver provides a reading only once
every 1 or 2 seconds, depending on the type of GPS receiver, the reported position may be off by up to
the distance travelled in that time.  To compensate for this possible error, when you click the

 button, TS/PP-Draft takes the last-reported position and adds the last-reported
speed multiplied by the time elapsed since the reading.  Thus, the compensated measurement is accurate
provided you're moving at a fairly uniform speed (not braking or accelerating) around the time you click
the button.

The figure below illustrates some of the features of the list of measurements.

You may also right-click on the list or on a selected measurement for a pop up menu with additional
options, such as copying, pasting, deleting, importing, and exporting measurements.

Clicking the  ( ) button advances the window to the next (previous)
intersection in the "forward" ("reverse") direction unconditionally -- there is no error checking or
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offering to calculate the distance to the neighboring intersections.  This prepares TS/PP-Draft to accept

the geographic coordinates of the next intersection.  If  voice command recognition is enabled, you
may say "Next Intersection" ("Previous Intersection") instead of clicking this button.  

The Displacement column shows the distance from the measurement to the average of all
measurements, which it taken as the center of the intersection. This can be useful in identifying bad
measurements or measurements that are applied to the wrong intersection.  Another useful tool is to
right-click on the Network View and check the item "Show Intersection Extents" to view the effective
extent of the intersections.  This is a circle centered at the intersection with a radius equal to the
half-width of the intersection.  A trip log must cross this region to count as passing through the intersec-
tion.  Viewing the extent makes it easier to diagnose why a trip log is either skipping an intersection or
passing through one twice. You can also detect when an extent is too large, usually due to a bad or
misplaced coordinate measurement.

When you close the list of measurements, TS/PP-Draft calculates the “straight-line” distance to
the neighboring intersections and compares it to the distance already entered.  If it thinks its calculation
may be more accurate than the distance entered, and there are no trip logs available to calculate the actual
travel distance, it offers to replace the declared distance with its calculation.  If the street between the
intersections is fairly straight and level, this calculated distance is likely to be quite accurate.  If there are
bends or an appreciable grade between the intersections, it's usually better to use trip logs to calculate the
actual travel distance.  TS/PP-Draft won't offer to supply the calculated distance if it thinks the declared
distance is more accurate, but you can trick it into making this offer by first setting the distance to a

number absurdly too small, then clicking  button followed by the 
button.

Click the  button on the list of Geographic Coordinates to download a list of all
waypoints stored in the GPS receiver.  At present, this option is available only for Garmin GPS receivers
and only if the type of GPS receiver is set to Garmin (Proprietary).

The downloaded list is displayed in the Assign Downloaded Waypoints dialog, which you may use to
assign each waypoint to an intersection.

The figure below illustrates some of the features of the list of waypoints.
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Adjusted Cycle Length.  This is a set of radio buttons indicating the amount of the network
Cycle Length that is used as the intersection's Cycle Length.  Thus, the Adjusted Cycle Length is the
Cycle Length at which the intersection's signal actually operates.  The intersection may use the full, half,
or double the network Cycle Length (specified in the Network Parameters dialog).  Thus, if the network
Cycle Length is 80 seconds, then "Half" indicates that the intersection operates at 40 seconds, and
"Double" indicates that it operates at 160 seconds.

For convenience, the Adjusted Cycle Length is displayed in seconds next to the key word. 
However, you should remember that the parameter you set is a ratio (determined by the radio button), not
the number of seconds in the cycle.  As a result, changing the network Cycle Length changes the number
of seconds displayed as the Adjusted Cycle Length, but the ratio remains unaffected.

You may edit the Adjusted Cycle Length in the Intersection Parameters dialog or in the Diagram
Window by selecting the intersection and using the right mouse button and selecting "Cycle Length"
from the pop up menu. You may also select the intersection and press Ctrl+L to edit the Adjusted Cycle
Length.

On Time-Space and Time-Location diagrams only: If you have started a green band at the
intersection, then changing the Adjusted Cycle Length causes TS/PP-Draft to automatically reset:
• the New Green Band Offset to the beginning of the green time plus the Start Up Lost Time, and
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• the New Green Band Width to the split, minus the Start Up and Clearance Lost Times
for the through (or left- or right-turn) movement in the appropriate direction of travel

Offset.  This measures the delay after time zero until a point is reached in the signal's cycle
called the Offset Reference Point.  For example, suppose at a certain intersection the Adjusted Cycle
Length is 80 seconds, there is no cross-traffic turning  movement in the South-bound direction, and there5

is a leading cross-traffic turning movement in the North-bound direction beginning 20 seconds after time
zero. If the Offset Reference Point is the start of the first through movement, then the Offset is 25% and
references the North-bound through/turning movement. 

The Offset is measured in either seconds or percent of the Adjusted Cycle Length of the
intersection, as specified in the Setup: Units of Measurement dialog (described on page 126).  In that
dialog box, you may also set the number of decimal places to which the Offset is shown.  Be warned: In
order to avoid internal conflicts, TS/PP-Draft stores the Offset internally in percent of the Adjusted Cycle
Length, even if it is entered in seconds.  Thus, if you change the Cycle Length, the Offset will assume a
new value in seconds, maintaining its value in percent unchanged.

Click one of the  buttons to determine the actual travel offset relative to a
neighboring upstream intersection using one or more Trip Logs (page 38).  Note that the arrows on the
buttons indicate direction of travel.  These button are enabled only if there are trip logs involving travel
to this intersection from the corresponding neighboring upstream intersection.  You may select which trip
logs to use in the calculation from a list of all relevant trip logs.  The figure below illustrates some of the
features of the list of trip logs.
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The relative offset is calculated from the average travel time of the selected trip logs such that the
start of the through movement in the given direction of travel is delayed from the start of the correspond-
ing through movement at the upstream intersection by the average travel time.

The Offset may be edited in the Intersection Parameters dialog or directly on the Diagram
Window by selecting an intersection and dragging the signal to a new Offset or by using the up and down
cursor keys (optionally while pressing the Control or Alt keys) to increase or decrease the Offset. The
latter method is usually the simplest for finding Offsets leading to the widest green bands.

Since the Offset is measured in percent of the Adjusted Cycle Length, changing the adjusted the
Cycle Length (doubling or halving the Cycle Length) will change the number of seconds corresponding
to the Offset, but the percent will remain unchanged.

You may link the Offsets of neighboring intersections so that any changes you make to the Offset
of one intersection affect the Offsets of the linked intersections.  In order to change the Offset of an
intersection relative to its linked intersections, you must (temporarily) break the link to that intersection.

On Time-Space and Time-Location diagrams only:
If you have started a new green band at the intersection, changing the Offset causes TS/PP-Draft

to reset the New Green Band Offset that begins at that intersection to the beginning of the green time,
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plus the Start Up Lost Time, for the through (or left- or right-turn) movement in the appropriate direction
of travel.

Offset Reference Point.  The Offset Reference Point is a drop down list box that determines
the point in the cycle to which this particular intersection's signal Offset refers.  The reference points are
listed and described in Table I and depicted graphically in Table II.

Example: Suppose at a certain intersection the Adjusted Cycle Length is 80 seconds, there is no
protected cross-traffic turning  movement in the South-bound direction, and there is a leading cross-6

traffic turning movement in the North-bound direction beginning 20 seconds after time zero.  If the
Offset Reference Point is the start of the first through movement, then the Offset would be set to 25%
and would reference the North-bound through/turning movement.

By default, the Offset Reference Point refers to a movement along the artery, that is, along one of
the directions of travel represented in the diagram window.  Check the "References Side-Street Move-
ment" box to specify that the Offset Reference Point refers to a movement from the side street of this
diagram.

The Offset Reference Points "start of first through movement" and "start of green phase" are
identical for all protected Turn Phase Sequences except for the one where both directions of travel have
leading turning movements.  In all other cases, the beginning of the first through movement coincides
with the beginning of service to the artery.  Similarly, the reference points "end of last through move-
ment" and "end of green phase" are identical except for where both directions of travel have lagging turn
phases.

The Offset Reference Point may be edited in the Intersection Parameters dialog or directly on the
Diagram Window by selecting the intersection and clicking the right mouse button and selecting "Offset
Reference Point" from the pop up menu. You may also select the intersection and press Ctrl+O to edit
the Offset Reference Point.

The default Offset Reference Point may be specified in the Defaults page of the Preferences
dialog (see page 128), and setting it as a Diagram/Arterial Parameter overrides the default.  Setting it as
an intersection parameter, in turn, overrides the Diagram/Arterial Parameter, so different intersections
can have different Offset Reference Points if you wish.

Changing the Offset Reference Point does not affect the value of the intersection signal Offsets;
however, it does affect the point to which the signal Offset refers.  Thus, changing the Offset Reference
Point does shift the signal in time, resulting in an effective change in Offset, but the values of the Offset
itself is unchanged.  This effective change will apply at any intersections linked to the current intersec-
tion (see below).

The Offset Reference Point does not affect the reference point of the Offsets of the green band
bands (on Time-Space diagrams).  These always refer to the point at which the green bands begin, which
will be near the front of the platoon if a queue has built up.  However, since changing the Offset
Reference Point does effectively shift the intersection signals in time, this change will cause TS/PP-Draft
to reset the Offsets of any green bands that start at the intersection to their default value.
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Protected Turn Phase Sequence.  The protected cross-traffic Turn Phase Sequence is a
drop down list box that determines the order in which the through and protected turning movement phase
(if it exists) occur for each direction of travel.  These are left-turns in right-hand Drive Rule regions (the
United States and Europe), right-turns in left-hand Drive Rule regions (Great Britain and Australia).  The
key words are "Lead", "Lag", "Lead+Lag", and "None".  These refer to the protected cross-traffic turning
movement with respect to the opposing through movement. Thus, a "Lead" for North-bound, protected
Turn Phase Sequence means that the cross-traffic turning movement of the North-bound traffic leads
(i.e., is served before) the opposing South-bound through movement.  "None" indicates that there is no
protected cross-traffic turning phase in the corresponding direction of travel.  "Lead+Lag" indicates that
there are two turning phases in the cycle for the cross-traffic turning movement, one that leads the
opposing through and one that lags.  In this case, you will need to set the Splits separately for each turn
phase.

"Split-Lead" and "Split-Lag" are special cases of "Lead" and "Lag", and for most purposes, they
work exactly the same.  However, there are some special rules enforced to ensure "split phasing."  When
a turning phase is set to one of these, the turning phase in the opposite direction is automatically set to
the other, and the Splits and Clearance Times for the through and cross-traffic turn are automatically
forced to be equal.

There is also an associated check box labeled "Permitted" with which specify whether cross-
traffic turns are permitted during the opposing through phase.  This is used on Platoon-Progression dia-
grams only to determine the actual flow of the opposing through movement.

The default Turn Phase Sequence is set in the Defaults page of the Preferences dialog, but any
intersection can override the default.

The protected cross-traffic Turn Phase Sequences may be edited in the Intersection Parameters
dialog or (with one restriction) directly on the diagram window by selecting the intersection and clicking
the right mouse button and selecting "Phase Sequence" or "Side-Street Phase" from the pop up menu.
You may also select the intersection and press Ctrl+P to edit the Phase Sequence.  The latter method is
usually the simplest for finding phase sequences  leading to the widest green bands.  The restriction is
that in the diagram window you may only exchange the order in which existing protected turning move-
ments occur with respect to the opposing through movements; you may not add or remove protected
turning movements.

If you have checked the One-way box in the Diagram/Arterial Parameters dialog for one of the
directions of travel, then TS/PP-Draft assumes the artery is a one-way street and sets the protected turn
Phase Sequences to "None."  In this case, you cannot modify the protected turn Phase Sequences.

On Platoon-Progression diagrams only:
To specify a permitted cross-traffic turn, set the protected Turn Phase Sequence to "None"

(meaning no protected turn phase), and check the corresponding Permitted box.  TS/PP-Draft uses the
permitted movement model developed for TRANSYT-7F to determine the actual flow (based on the
Design Speed and flow of the opposing through movement).

On Time-Space and Time-Location diagrams only:
If you have started a new green band at the intersection, changing the Turn Phase Sequence

causes TS/PP-Draft to reset the Offset of the New Green Band(s) to their default values.
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Exclusive Pedestrian Phase Sequence.  This is a drop down list box that determines the
order in which the exclusive pedestrian movement (if it exists) occurs with respect to the service to the
vehicular traffic movements.  It is used only on extended Time-Space and Platoon-Progression diagrams.

The choices for the exclusive pedestrian phase (EPP) are "Lead", "Lag", and "None," with
"Lead" meaning the EPP leads (i.e., is serviced before) the vehicular traffic phase. Similarly, "None"
means there is no EPP.

You may have up to two EPPs in a cycle.  For clarity, one is associated with the North-South
phase, and the other with the East-West phase.  Since TS/PP-Draft treats an EPP as an "all red" phase,
you may use either (or both) to model any other type of all red phase.

You should take care about which EPP you use (North-South or East-West); they are not the
same--especially if the Offset Reference Point is either "Start of the arterial phase" or "End of the arterial
green phase."  The North-South EPP is referenced with respect to the North-South vehicular movements,
and the East-West EPP is referenced with respect to the East-West vehicular movements. Thus, a leading
North-South EPP is similar to a lagging East-West EPP. In fact, they are the same unless the Offset
Reference Point is either "Start of the arterial phase" or "End of the arterial green phase" because these
reference points include the EPP. For example, on a North-South artery, if the Offset Reference Point is
"Start of the arterial phase" and there is a leading North-South EPP, then the Offset references the start of
the EPP.

Similarly, on a North-South artery, if the Offset Reference Point is "Start of the arterial phase"
and there is a lagging East-West EPP, then the Offset references the end of the EPP.

Turn On Red.  This is a check box indicating whether (checked) or not (unchecked) a with-
traffic turn-on-red is permitted.  These are right-turns where the Drive Rule is Right-Hand Side (North &
South America, China and continental Europe), left-turns where the Drive Rule is Left-Hand Side (Great
Britain, Australia, New Zealand, South Africa, and much of Asia).  (See page 127 for details about the
Drive Rule). The Turn-on-Red option is used on Platoon-Progression diagrams only.

TS/PP-Draft uses the permitted movement model developed for TRANSYT-7F to determine the
actual flow of the with-traffic turners (based on the flow of the opposing movements, cross-traffic
turning  and through).7

Splits.  The Splits are the fraction of the Adjusted Cycle Length that is allotted to each move-
ment.  They are measured in seconds or percent of the Adjusted Cycle Length of the intersection being
considered, as specified in the Units of Measurement page of the Preferences dialog described on page
126.  In that dialog box, you may also set the number of decimal places to which the splits are shown.
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Figure 119 The Splits Bar on the Timings page provides a
simple means of editing splits.

For your convenience, TS/PP-Draft will warn you if you should change the split for the signal
phase associated with a particular movement to something less than the Minimum Split.  It will also warn
you if you should change the split to something less than the total (Yellow + All Red) Clearance Time or
the total (Flashing Don't Walk + All Red) Clearance Time for that phase.

TS/PP-Draft will warn you if the sum of the Splits is not equal to the Cycle Length.  You may
choose a strict test of the Splits of both rings summing to the Cycle Length or to allow the splits of just
one ring to sum to the Cycle Length.  The option between the strict test or the more lenient test is on the
Desktop page of the   Preferences dialog box.

Be warned: The Splits are stored internally as percent of the Adjusted Cycle Length, even if they
are entered in seconds.  This allows you to change the Cycle Length without worrying immediately about
adjusting the Splits, and it helps TS/PP-Draft avoid situations where the sum of the Splits exceeds the
Cycle Length.  As a consequence, if you enter the Splits in seconds and later changes the Cycle Length,
the Splits will assume new values in seconds, maintaining their values in percent unchanged.

You can prevent this behavior for some splits by checking the Fixed box.  When a split is fixed,
TS/PP-Draft will assure that its value in seconds remains unchanged even if the cycle length is changed.
Instead, it will adjust all the non-fixed splits proportionately.

You may also edit the
Splits on the Splits Bar on the
Timings page of the  Intersection
Parameters dialog box by using
the left mouse button to drag the
clearance interval of a given
phase to the right or left to in-
crease or decrease the split of
that phase.  This is especially
convenient because as you do so,
TS/PP-Draft adjusts the other
non-fixed splits to ensure that the
splits add up to the Adjusted Cy-
cle Length and, in doing so, it
ensures that these splits are at
least as great as their Minimum
Splits, the sum of their Yellow +
All Red Clearance Times, and
their Flashing Don't Walk + All
Red Clearance Times.

If there is no protected
turning movement, TS/PP-Draft
does not allow you to adjust the
turning Split.  Similarly, if there is no exclusive pedestrian phase, TS/PP-Draft does not allow you to
adjust the exclusive pedestrian Split.  If there are two protected phases for a cross-traffic turning
movement, the two turning Splits may be set independently.  To do this, set the Turn Phase Sequence to
"Lead+Lag."

When using split phasing (page 84), changing the Split of either the through movement or the
cross-traffic turning movement automatically changes the Split of the other movement as well.
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Where there are no protected turning movements on the side-street, the through Splits along the
side-street are automatically determined by the difference between the Adjusted Cycle Length and the
sum of the Splits of the through and turning movements on the artery.

You have the option of having TS/PP-Draft display the Splits associated with each phase directly
on the Diagram Window.  See the Layout page of the Preferences dialog for more details (page 119).

 Since the Splits are measured in percent of the Adjusted Cycle Length, changing the Adjusted
Cycle Length (doubling or halving the Cycle Length) will alter the number of seconds corresponding to
each non-fixed Split, but the percents will remain unchanged.

If the arterial Design Speed for one of the directions of travel has been set to zero, TS/PP-Draft
assumes a one-way street, and does not display the Split for the nonexistent through movement. 

On Time-Space and Time-Location diagrams only:
If you have started a new green band at the intersection, then changing the Splits causes TS/PP-

Draft to automatically reset the Offset and Width of the new green band(s) to their default values.

Fixed Splits.  TS/PP-Draft allows you to declare certain splits as fixed. When a split is fixed,
TS/PP-Draft will assure that its value in seconds remains unchanged even if the Cycle Length is changed.
Instead, it will adjust all the non-fixed splits proportionately.

When all splits are declared as fixed, this has the same effect as having no splits fixed. When the
Cycle Length, TS/PP-Draft will adjust all splits so that their fraction of the Cycle Length is unchanged.
This is also true when the sum of the fixed splits exceeds the new Cycle Length (in which case, it is not
possible for the fixed splits to have the same value, in seconds, with the new Cycle Length). In this case,
TS/PP-Draft will warn you that even the fixed splits are being adjusted.

Design Speed.  This is the average speed of the traffic at the intersection.  Along the artery, it
is the speed of the traffic downstream from the intersection, and on the cross street, it is the speed of the
traffic upstream from the intersection.  It is measured in the units specified in the Units of Measurement
page of the Preferences dialog described on page 126 (miles/hour, feet/second, kilometers/hour, etc.).

This parameter is helpful on arteries where the average speed is not constant throughout the
length of the diagram.

Click the  button next to the speed to determine the actual travel speed using one or more
Trip Logs (page 38).  This button is enabled only if there are trip logs involving travel between this and
the neighboring intersections.  You may select which trip logs to use in the calculation from a list of all
trip logs that include these two intersections.  The figure below illustrates some of the features of the list
of trip logs.
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The average speed from a trip log is equal to the travel distance between the intersections divided
by the time elapsed between passing the centers of the intersections.  If the trip log includes a delay (e.g.,
due to stopping at a queue), the calculated speed is reduced accordingly.  The average speed from
multiple trip logs is equal to the total travel distance (the travel distance between the intersections times
the number of trip logs) divided by the total time elapsed between passing the centers of the intersections.

To ensure that the slope of the green band on Time-Space diagrams reflects the actual node-to-
node travel time, you should use the trip logs to calculate both the Design Speed and the Distance
between the intersections.

When you change the Design Speed along the artery at an intersection, the program offers to
change all downstream Design Speeds to match.

The Design Speed along the artery determines the slope of the green bands (for Time-Space dia-
grams) or the platoon density bands (for Platoon-Progression diagrams).

The Design Speed on the cross streets helps determine the flow of vehicles on permitted (unpro-
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Green Band Action Description

Continue The band passes through (both red and green time) un-
changed (except possibly for the Design Speed).

Start The band breaks and starts all over again.

Stop The band terminates.

Taper The band passes through green time but not red time

Taper/Start The band "tapers" if any part of it arrives on green time,
otherwise it "starts".

Clip  Like Taper, but the upstream band is clipped as well.

Clip/Start  Like Taper/Start, but the upstream band is clipped as well.

Table IV.  The Green Band Actions and their meanings.

ected) cross-traffic turns.   The Design Speed also determines the actual Saturation Flow for each lane8

group.  See "Phase Sequence" for more information on permitted cross-traffic turns.

In  Travel Time and Delay Reports, the Design Speed along the artery is used to calculate
the delay in arrival to the next intersection and the distance traveled to reach the design speed.  The

Design Speed may also be displayed on  Speed vs. Distance plots.

Green Band Action.  The Green Band Action is a drop down list box on Time-Space dia-
grams.  It indicates the action that the green band takes at a particular intersection for either direction of
travel.  The Green Band Actions are given in Table IV.

You may edit the Green Band Action directly on the diagram window by selecting the intersec-
tion and clicking the right mouse button and selecting "X-bound Band" from the pop up menu (where X is
the direction of travel of the band to be altered, North, South, East, or West). You may also select the
intersection and press Ctrl+F or Ctrl+R to edit the Band Action.

When you change the Green Band Action, TS/PP-Draft offers to apply this change to all
intersections downstream.

The default
Green Band Action is
set in the Defaults
page of the Prefer-
ences dialog, but any
intersection on any
diagram can override
the default.

If you have
checked the One-way
box for one of the
directions of travel,
then TS/PP-Draft
assumes the artery is
a one-way street. In
this case, you cannot
specify the Green
Band Action in the
nonexistent direction
of travel.



TS/PP-Draft 6.0: Time-Space/Platoon-Progression Diagram Generator

A with-traffic turn is a 
9

• right-turn in right-hand Drive Rule regions (North & South America, China and continental Europe).
• left-turn in left-hand Drive Rule regions (Great Britain, Australia, New Zealand, South Africa, and much of

Asia).
See page 127 for details.

92

Starting new green bands is especially useful on complex arteries where it is decidedly impossi-
ble to provide each direction of travel with a wide, continuous green band.  In these situations, you may
choose to do the next best thing: stop the traffic at only one intersection.

You may start green bands from the side street left- and right-turning movements as well as the
arterial through movement.  Side-street green bands are considered in Fine-Tuning the Offsets.

Judicious use of this parameter also allows you to simulate special cases such as a two-way street
becoming a one-way street at a particular intersection and vice versa.  For this purpose, you may stop the
green band at a boundary intersection (and start it at an interior intersection), but all other green band
parameters (Offset, Width, and Design Speed) at the boundary intersections are controlled in the
Diagram/Arterial Parameters dialog.

Offset of New Green Band.  This is the position of the new green band that starts at this
intersection.  The green band can be shown on Time-Space and Time-Location diagrams only.  The
Offset references the point at which the green band begins at this intersection and is measured in seconds
or percent of the Adjusted Cycle Length of this intersection, as specified in the Setup: Units of Measure-
ment dialog (page 126).

The default value of the Offset is the beginning of the green time for corresponding movement
(through, left- or right-turn) in the appropriate direction(s) of travel at the intersection, plus the Start Up
Lost Time.  This will be near the front of the platoon if a queue has built up at the intersection.

You may start green bands from the side street left- and right-turning movements as well. For a
cross-traffic turning green band, the default value of the Offset is the beginning of the green time for the
cross-traffic turn movement in the appropriate direction(s) of travel at the intersection, plus the Start Up
Lost Time.  For a with-traffic  turning green band, the default value of the Offset is the beginning of the9

green time for through movement in the appropriate direction(s) of travel at the intersection, plus the
Start Up Lost Time.  Again, this will be near the front of the platoon if a queue has built up at the
intersection.

Doing any of the following causes TS/PP-Draft to reset the new green band Offset to its default
value:

(1) Changing the Start Up Lost Time.

(2) Changing the Adjusted Cycle Length, Offset, Offset Reference Point, protected Turn Phase
Sequences, or Splits at this intersection.

To help avoid internal conflicts, the Offset is stored internally in percent of the Adjusted Cycle
Length.  Changing the Adjusted Cycle Length (doubling or halving the Cycle Length) will change the
number of seconds corresponding to the Offset, but the percent will remain unchanged.
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Width of New Green Band.  This is the width (in seconds) of the new green band that starts
at this intersection.  The green band is shown on Time-Space and Time-Location diagrams only.

The default value of the Width is equal to the duration of the green time that is allotted to the
corresponding movement (through, left- or right-turn) in the appropriate direction(s) of travel at this
intersection (i.e., the through Split minus the Start Up and Clearance Lost Times).

You may start green bands from the side street left- and right-turning movements as well. For a
cross-traffic turning green band, the default value of the Width is equal to the duration of the green time
that is allotted to the cross-traffic turn movement in the appropriate direction(s) of travel at this intersec-
tion (i.e., the cross-traffic turn Split minus the Start Up and Clearance Lost Times). For a with-traffic
turning green band, the default value of the Width is equal to the duration of the green time that is
allotted to the through movement in the appropriate direction(s) of travel at this intersection (i.e., the
through Split minus the Start Up and Clearance Lost Times).

Doing any of the following causes TS/PP-Draft to reset the width of the new green band to its
default value:

(1) Changing the Start Up or Clearance Lost Time.

(2) Changing the Adjusted Cycle Length, Splits, or protected Turn Phase Sequences at the
intersection.

Number of Lanes.  This is the number of lanes available for storing the queue of the corre-
sponding lane group.  It is used on Platoon-Progression diagrams only.  The queue length is calculated as
NL/n where

N = Number of vehicles in queue
L = Vehicle Length
n = Number of lanes for the lane group

The actual Saturation Flow is calculated from the Number of Lanes using the method prescribed
in Chapter 9 of the Highway Capacity Manual.

Use the associated Shared check box to indicate a shared lane.

When you change the number of through lanes, TS/PP-Draft offers to apply this change to all
intersections downstream once you exit the Intersection Parameters.

In preparing  Travel Time and Delay Reports and  Trip Log Plots, TS/PP-Draft detects
which intersections each trip log passes through by determining whether the trip passes close to the
center of the intersection.  "Close" means roughly within the intersection's radius, allowing some
tolerance for error in the GPS measurements.  If there is no median, the intersection's radius is the
Number of Lanes multiplied by the Lane Width.  But if there is a wide median, this calculation gives a
width too narrow, and TS/PP-Draft may incorrectly decide that a trip log bypasses an intersection it
really passes through.  For this case, multiple GPS measurements, taken on the opposite sides of the
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median or on opposite corners, allow TS/PP-Draft to estimate the intersection width including the
median.  See How Trip Logs are Processed (page 131) for more details.

Caution!  If the queue at an intersection backs up beyond the upstream intersection, then usually
the flow and queues on the Platoon-Progression diagram will be inaccurate.  The flow and queue can still
be accurate if the queue backs up into the upstream intersection

(1) during the green time of the upstream intersection, and 
(2) when there are no vehicles leaving the upstream intersection.

Restriction (2) means that at the time when the queue backs up into upstream intersection, there are no
vehicles arriving at the upstream intersection and there is no queue waiting at the upstream intersection. 
These criteria are strict, so a queue backing up into the upstream intersection usually indicates that you
should not trust the diagram.  Unless you are sure these criteria are met, you should either adjust the
timing parameters of the diagram to prevent the back up or not use a Platoon-Progression diagram at all
for that artery.

Queue Lane Group.  Use this set of radio buttons to select the lane group for which you wish
to see the queue on the Platoon-Progression diagram. You may choose Through, Left-Turn, Right-Turn,
or Maximum (meaning whichever of the three is largest).

You may assign a color to each lane group's queue in the Colors page of the Preferences dialog.
This is useful when you have elected to the show the maximum queue and wish to distinguish which lane
group is contributing the maximum queue.

The queue is determined from the actual Saturation Flow and the Number of Lanes of the lane
group using the method prescribed in Chapter 9 of the Highway Capacity Manual.

You may edit the Queue Lane Group in the Intersection Parameters dialog or directly on the
Diagram Window by selecting the intersection and clicking the right mouse button and selecting "X-
bound Queue" from the pop up menu (where X is the direction of travel of the band to be altered, North,
South, East, or West). You may also select the intersection and press Ctrl+F or Ctrl+R to edit the Queue
Lane Group in the forward and reverse directions, respectively.

Caution!  If the queue at an intersection backs up into the upstream intersection, the flow and
queues on the Platoon-Progression diagram usually will be inaccurate. They can still be accurate if the
queue backs up into the upstream intersection 

(1) during the green time of the upstream intersection, and 
(2) when there are no vehicles leaving the upstream intersection. 

Restriction (2) means that when the queue backs up into the upstream intersection, there are no vehicles
arriving at the upstream intersection nor a queue waiting at the upstream intersection. These criteria are
strict, so a queue backing up into the upstream intersection usually indicates that you shouldn't trust the
diagram. Unless you are sure these criteria are met, you should either adjust the timing parameters to
prevent the back up or not use a Platoon-Progression diagram at all for that artery.
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Figure 126. Sample volumes at an intersection
to illustrate the format of a Volumes File.  See
the text for more details.

Approach Left Through Right

North 153 638 84

East 79 497 76

South 95 552 89

West 83 411 65

Table V. The contents of an example Volumes File.  See text for more details.

Volumes.  The volume is the number of vehicles completing a movement in an hour.  It is
measured in vehicles per hour. These are totals, not per-lane averages.  The actual volume TS/PP-Draft
uses is the value entered in the Volumes page of the Intersection Parameters dialog box multiplied by the
Volume Multiplier entered in the Lane Group Parameters dialog box.

The Volume is used only on Platoon-Progression diagrams and for importing and exporting
UTDF files (see page 133).  TS/PP-Draft uses the Volume to determine the platoon density bands and
also to calculate the actual Saturation Flow using the method prescribed in Chapter 9 of the Highway
Capacity Manual.

You may use the  button to read the volumes from a Volume File.  Use the

 button to save the volumes in a Volume File.
A Volumes File is a file that contains the hourly approach volumes for a single intersection. 

TS/PP-Draft can read volumes from two different
types of Volumes Files: Text File and PETRA
Data File. TS/PP-Draft can write volumes in the
Text File format.

An example Volume Text File will serve
to illustrate the format.  For an intersection with
the volumes as shown in Figure 126, an applica-
ble Volume File is shown in Figure 126.  This is
the format in which TS/PP-Draft saves a Volume
File.

For reading volumes from a file, TS/PP-
Draft uses less strict rules:

(1) The first line of the file is as-
sumed to contain column labels,
and it is ignored.

(2) The next four lines contain
approach volumes in the order
shown above (i.e., North, East, South, then West). Note that the labels refer to the
approach direction, not the direction of travel.
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L Thru   R

N, 153, 638.0 84

Yeast 79, 497 76,

   S 95 552, 89

west 83 411 65   

Table VI. Illustrating that TS/PP-Draft tolerates sloppily formatted Volumes Files, this erratic
Volume File is equivalent to the one in Figure 126.

(3) The first column of each of the approach volumes lines is ignored (because it is assumed
to contain the approach label).

(4) The second, third, and fourth columns of the approach lines contain the volumes for the
left-turn, through, and right-turn movements, in that order. The volumes must be sepa-
rated by either a space, tab, or comma, and can have any amount of additional "white
space" (spaces or commas). Note that the column alignment is not important. What is
important is that there be four columns, the first with some sort of label and the follow-
ing three with numbers. Volumes of 0 are accepted.

(5) Note that although TS/PP-Draft ignores the contents first line and the first column of the
file, nonetheless it does insist that there be something there. It is ok to leave the first line
blank (since even a "blank" line has an end-of-line character), but it is not ok to leave the
first columns blank. Moreover, since the space character is a column delimiter, the label
in the first column must not contain any spaces (although it may be surrounded by any
number of spaces).

Because of the looser rules used for reading files, TS/PP-Draft considers the erratic file  in Table
VI to be equivalent to the one given in Figure 126.  Of course, TS/PP-Draft would never write such an
unappealing file, but you are free to do so and may still expect TS/PP-Draft to read it without complaint.

A PETRA Data File is a Volumes File created by PETRA, a program to retrieve, analyze, and
report on data collected with hand-held traffic counters from JAMAR Technologies. For more informa-
tion about PETRA or the traffic counters, contact

JAMAR Technologies, Inc.
151 Keith Valley Road
Horsham PA 19044, USA
(215) 491-4899.

When you read hourly volumes from a PETRA Data File, TS/PP-Draft prompts you to select the
hour during which to read the volumes and to choose which "banks" or "groups" are to be included.  You
may choose from
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Intersection Peak Hour Choose the hour with the peak total volumes for the
intersection

Approach Peak Hour For each approach, choose the hour with the peak
approach volumes

Movement Peak Hour For each movement, choose the hour with the peak
movement volumes

Hour Starting At (Time) Choose the hour starting at the time selected in the
drop-down list box

Typically, the different banks on the turning movement counter could be used to distinguish the
types of vehicles in a particular movement. For example, bank 0 (the primary bank) might be reserved for
automobiles, and bank 1 (the secondary bank) might be reserved for heavy trucks.

Saturation Flows.  The saturation flow is the number of vehicles that would complete a
movement in an hour if:

(1) There is a constant queue, and
(2) The movement has 100% green time. (No red time or opposing flow for permitted left- or
right-turners).

The ideal Saturation Flow is measured in vehicles per hour-green per lane. Note that these are
per-lane averages, not totals. TS/PP-Draft uses the Saturation Flow only on Platoon-Progression
diagrams.  It calculates the actual, total Saturation Flow (not the per-lane average) based on the entered
ideal Saturation Flow using the method prescribed in Chapter 9 of the Highway Capacity Manual
(HCM).

In the Intersection Parameters dialog, TS/PP-Draft shows either the ideal Saturation Flow or the
actual Saturation Flow, depending on which Saturation Flow radio button is selected. You may enter only
the ideal Saturation Flow in this dialog; the actual Saturation Flow is a calculated value.  You may select
which type of flow is shown by default on the Desktop page of the Preferences dialog.

According to the HCM, the actual saturation flow, s, is given by

0 w HV g p bb a RT LTs = s  N f  f  f  f  f  f  f  f

0Here, s  is the ideal, per-lane saturation flow, N is the number of lanes in the lane group, and the

xadjustment factors f  reduce the actual saturation flow due to various conditions such as lane width,
heavy vehicles, approach grade, parking lanes, bus blocking, area type, and left and right turns. TS/PP-

0 RT LTDraft lets you enter N and s  in the Intersection Parameters dialog.  TS/PP-Draft calculates f , and f  for
you, and the rest of the factors are entered in the Lane Group Parameters dialog. The Highway Capacity

0Manual suggests using 1900 for s .

Whenever you change the ideal Saturation Flow of the through movements along the artery,
TS/PP-Draft sets the corresponding Downstream Saturation Flow to match the actual Saturation Flow.
TS/PP-Draft is assuming that the number of feeding lanes equals the number of receiving lanes.
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See also R.M. Shanteau's "Using Cumulative Curves to Measure Saturation Flow and Lost
Time", ITE Journal, Oct. 88, for a lucid explanation of saturation flow and guidelines on how to measure
it.

Downstream Saturation Flow.  This is the number of vehicles that can travel in an hour on
the artery downstream from the intersection (assuming a constant demand).  This is the total saturation
flow, not a per-lane average.

This number will be different from the actual saturation flow of the through movement when the
number of feeding lanes does not equal the number of receiving lanes.  This often occurs when the
through movement shares a lane with a turning movement.  TS/PP-Draft assumes that in most cases these
lane numbers are equal, so it resets the downstream saturation flow whenever the corresponding
saturation flow or Number of Lanes is changed.

TS/PP-Draft uses this for Platoon-Progression diagrams to determine the dot density on the
screen.  The dot density is a measure of the degree of saturation on the artery corresponding to N/S where 

N = The vehicle flow (vehicles/hour) on the artery at a certain time.
S = The (downstream) Saturation Flow Baseline of the artery.

The Highway Capacity Manual suggests using 1900 vphg for each lane.

See Flow Baseline on Platoon-Progression Diagrams (page 62) for more details on how the intersection's
Downstream Saturation Flow is used to determine the saturation flow baseline.

Phase & Movement Parameters

These are parameters which affect only the signal phase associated with a particular movement.
They are displayed in the Phase & Movement Parameters dialog box where you can examine and change
them at will.

To view the Phase & Movement Parameters for a given movement of the selected intersection,

use one of the phase buttons (e.g., ) on the Timings page of the  Intersection Parameters dialog.   
These buttons may be either “flat” or protruding, depending on your preference in the Desktop page of
the Preferences dialog.  If they’re flat, they protrude only when the mouse cursor is over them.

Changing the values of certain parameters alters the values of other parameters. For example, if
you change the Start Up Lost Time for a particular phase, TS/PP-Draft resets the Offset and Widths of
any the green bands associated with that phase to their default values.  See Affecting & Affected
Parameters.
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Once you've set the parameters in the Phase & Movement Parameters dialog box as desired, you
may use the Controls for restricting the application of the Phase & Movement Parameters to apply some
or all of these values to other
movements on this or all ap-
proaches of this or all intersec-
tions along this are all arteries. 
You may also opt to apply these
parameters to the other move-
ments only when the (initial or
pre-edited) phase numbers are
identical or to change only those
parameters in the other move-
ments whose initial (i.e., pre-ed-
ited) values are identical.

These controls give you a
great deal of flexibility in extend-
ing the Phase & Movement Pa-
rameters to other movements, but
please use them with caution.  
They can make many changes throughout the network.  Use the Edit: Undo command to recover from any
unintended changes.

Minimum Split.  The Minimum Split for the signal phase associated with a particular
movement is used to help you ensure that the split for that phase always equals or exceeds a certain
value.  The Minimum Split is measured in seconds, whereas the actual split is measured in the units of
your choice.

When using split phasing (page 84), changing the Minimum Split of either the through movement
or the cross-traffic turning movement automatically changes the Minimum Split of the other movement
as well.

You have the option of having TS/PP-Draft display the Minimum Splits associated with each
phase directly on the Diagram Window.  See the Layout page of the Preferences dialog (page 119) for
more details.

FDW Clearance Time.  The FDW (Flashing Don't Walk) Clearance Time for the signal
phase associated with a particular movement is used to determine the effective Offset of the intersection's
signal for certain Offset Reference Points.  It is measured in seconds.  The default FDW Clearance Time
may be specified on the Defaults page of the Preferences dialog box (page 128).

When using split phasing (page 84), changing the FDW Clearance Time of either the through
movement or the cross-traffic turning movement automatically changes the FDW Clearance Time of the
other movement as well.

TS/PP-Draft will warn you if you should change the split for the signal phase associated with a
particular movement to something less than the FDW and All Red Clearance Times for that phase.
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Yellow Clearance Time.  The Yellow Clearance Time for the signal phase associated with a
particular movement is used to determine the effective Offset of the intersection's signal for certain
Offset Reference Points.  It is measured in seconds.  The default Yellow Clearance Time may be
specified on the Defaults page of the Preferences dialog box (page 128).

When using split phasing (page 84), changing the Yellow Clearance Time of either the through
movement or the cross-traffic turning movement automatically changes the Yellow Clearance Time of
the other movement as well.

TS/PP-Draft will warn you if you should change the split for the signal phase associated with a
particular movement to something less than the Yellow + All Red Clearance Times for that phase.

The Yellow Clearance Time may be be viewed directly on the Diagram Window in the Color of
your choice.

All Red Clearance Time.  The All Red Clearance Time for the signal phase associated with
a particular movement is used to determine the effective Offset of the intersection's signal for certain
Offset Reference Points.  It is measured in seconds.  The default All Red Clearance Time may be
specified on the Defaults page of the Preferences dialog box (page 128).

When using split phasing (page 84), changing the All Red Clearance Time of either the through
movement or the cross-traffic turning movement automatically changes the All Red Clearance Time of
the other movement as well.

TS/PP-Draft will warn you if you should change the split for the signal phase associated with a
particular movement to something less than the Yellow + All Red Clearance Times for that phase.

The All Red Clearance Time, along with the arterial red time, may be be viewed directly on the
Diagram Window in the Color of your choice.

Start Up Lost Time.  The Start Up Lost Time for the signal phase associated with a particular
movement is used on Platoon-Progression diagrams for calculating the flow, and on Time-Space
diagrams for calculating the default Offsets and Widths of any green bands associated with that move-
ment.  

Most accurately, for Platoon-Progression diagrams, the Start Up Lost Time is the time (in
seconds) at which a straight line drawn through the "cumulative curve" crosses the time axis.  The
TRANSYT-7F manual describes it as the time from the start of green until the first vehicle crosses the
stopline, but this definition is not really correct.  For a lucid explanation of this and guidelines on how to
measure it, see R.M. Shanteau's "Using Cumulative Curves to Measure Saturation Flow and Lost Time",
ITE Journal, Oct. 88 or M|O|S|T.

For Time-Space diagrams, the Start Up Lost Time has a somewhat different definition, as
explained in the figures below, which detail how it can be calculated from Trip Logs.

The default value is set in the Defaults page of the Preferences dialog (page 128), but any
diagram can override the default.
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Driver Type Description
Start Up
Lost Time

Clearance
Lost Time

Conservative Drivers avoid fast starts and/or close headways. 4 sec 3-4 sec

Normal Average driver behavioral patterns. 3 sec 2 sec

Aggressive Drivers typically make fast starts, follow closely and
use most or all of the change period.

2 sec 0-1 sec

Table VII.  The TRANSYT-7F recommended values for the Start Up and Clearance Lost Times.

Table VII shows the TRANSYT-7F recommended values of the Start Up Lost Time for various

driving conditions.
On Time-Space and Time-Location diagrams, changing the Start Up Lost Time causes TS/PP-

Draft to reset the Offset and widths of any associated green bands to their default values.  Their default
values are determined by the split for the corresponding movement (through, left- or right-turn) at the
intersection at which the green band originates.

Click the  button next to the Start Up Lost Time to determine the actual travel Start Up Lost
Time using one or more Trip Logs.  This button is enabled only if there are trip logs involving travel
passing through this intersection and for which the calculated start up lost time is even plausible (less
than 8 seconds).  You may select which trip logs to use in the calculation from a list of all trip logs that
satisfy this criterion.  You should select only those trip logs for which the vehicle was stopped at the
signal and was the first in the queue.  The figure below illustrates some of the features of the list of trip
logs.
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The start up lost time calculated from a trip log is equal to the time elapsed from the beginning of green
for the through movement at the intersection to the point a straight line drawn through the downstream,
constant-speed section of the trip log crosses the center of the intersection.  (See illustration)  This is an
accurate calculation of the true Start Up Lost Time only if the vehicle was stopped at the signal and was
the first in the queue.
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Clearance Lost Time.  The Clearance Lost Time for the signal phase associated with a
particular movement is used on  Platoon-Progression diagrams for calculating the flow, and on  Time-
Space and Time-Location diagrams for calculating the default Widths of any green bands associated with
the movement.  

The Clearance Lost Time is the time (in seconds) at the end of the green when the intersection is
not effectively used by any movement.  The TRANSYT-7F manual defines is as the time from when the
last vehicle crosses the stopline until the start of red, but this definition is not really correct.  For a lucid
explanation of this and guidelines on how to measure it, see R.M. Shanteau's "Using Cumulative Curves
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to Measure Saturation Flow and Lost Time", ITE Journal, Oct. 88 or M|O|S|T.  This definition is the
most accurate for the Clearance Lost Time on Platoon-Progression diagrams.

For Time-Space diagrams, the Clearance Lost Time has a somewhat different definition,
analogous to that explained in the figures associated with the Start Up Lost Time, which can be calcu-
lated from Trip Logs.

The default value is set in the Defaults page of the Preferences dialog (page 128), but any
diagram can override the default.

Table VII shows the TRANSYT-7F recommended values of the Clearance Lost Time for
various driving conditions.

On Time-Space diagrams, Each time you change the Clearance Lost Time, TS/PP-Draft resets
the Widths of any associated green bands to their default values.

Phase Number.  The Phase Number for the signal phase associated with a particular movement
is a number greater than 0 used to 
• label the phase on the Diagram Window (if you've opted to view the splits directly on the

diagram),
• label the phase on diagram  Reports,
• label and determine the "ring" of the phase on the Splits Bar on the Timings Page of the 

Intersection Parameters dialog box, and
• identify signal phases when Importing or Exporting UTDF files (see page 133).

Often when you create new diagrams or add new intersections to an artery, the default phase
numbers for the various phases will all be wrong.  In this case, you may find it easier to use the Phase
Number buttons on the Timings Page of the  Intersection Parameters dialog box to "edit" all the phase
numbers as a group.

Lane Group Parameters

These are parameters which affect only the volume and saturation flow calculation associated
with a particular lane group. They are used on  Platoon-Progression diagrams only. They are displayed in
the Lane Group Parameters dialog box where you can examine and change them at will.

To view the parameters for a given lane group of the selected intersection, use one of the lane

group buttons (e.g., ) on the Volumes page of the  Intersection Parameters dialog.  These buttons
may be either “flat” or protruding, depending on your preference in the Desktop page of the Preferences
dialog.  If they’re flat, they protrude only when the mouse cursor is over them.
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Once you've set the pa
rameters in the Lane Group Pa-
rameters dialog box as desired,
you may use the Controls for re-
stricting the application of the
Lane Group Parameters to apply
some or all of these values to
other lane groups on this or all
approaches of this or all intersec-
tions along this are all arteries. 
You may also opt to change only
those parameters in the other lane
groups whose initial (i.e., pre-
edited) values are identical.

These controls give you a
great deal of flexibility in extend-
ing the Lane Group Parameters to
other lane groups, but please use
them with caution.  They can
make many changes throughout
the network.  Use the Edit: Undo
command to recover from any
unintended changes.

Volume Multiplier.  The Volume Multiplier for a particular lane group is used to multiply the
volume for that lane group wherever the volume is used in TS/PP-Draft.  This is especially useful when
you wish to study what would happen to the progression along an artery when all volumes at an intersec-
tion (or at all intersections) are increased or decreased by a particular factor.

Peak Hour Factor.  The Peak Hour Factor for a particular lane group is used in calculating the
actual saturation flow rate for that and any opposing lane groups.  It relates the peak rates of flow to the
hourly volume.  The Peak Hour Factor is defined as the ratio of the total hourly volume to the peak rate
of flow within the hour:

PHF = V/Vp

where

PHF = Peak Hour Factor,
V = hourly volume (vph)
Vp = Peak rate of flow (within the hour) (vph)

When field data are not available, the HCM recommends using a value of 0.90 for the Peak Hour Factor.
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Average Lane Width.  The Average Lane Width for a particular lane group is used in
calculating the actual saturation flow rate for that lane group.  It determines the saturation flow rate
adjustment factor for lane width.

The lane width is measured in units set in the Units of Measurement page of the  Preferences
dialog box (feet, yards, meters, etc., see page 126).  The default value is 12 feet (3.6 m).

Heavy Vehicles.  The percent heavy vehicles for a particular lane group is used in calculating
the actual saturation flow rate for that lane group.  It determines the saturation flow rate adjustment
factor for heavy vehicles.

When field data are not available, the HCM recommends using a value of 2% for the Heavy
Vehicles.

Conflicting Peds.  The volume of Conflicting Peds for a particular lane group is used in
calculating the actual saturation flow rate for that lane group.  It helps determine the saturation flow rate
adjustment factor for with-traffic turns.  It is measured in pedestrians per hour.

When field data are not available, the HCM recommends assuming a value of 0 peds/hr for the
Conflicting Peds unless field data indicate otherwise, in which case the recommendation is

Level of Pedestrian Traffic Conflicting Peds (peds/hr)

None 0

Low 50

Moderate 200

High 400

Approach Grade.  The Approach Grade (percent) for a particular lane group is used in
calculating the actual saturation flow rate for that lane group.  It determines the saturation flow rate
adjustment factor for approach grade.

When field data are not available, the HCM recommends using a value of 0% for the Approach
Grade.

Has On-Street Parking.  The Has On-Street Parking check box and the number of Parking
Maneuvers per hour for a particular lane group are used in calculating the actual saturation flow rate for
that lane group.  It determines the saturation flow rate adjustment factor for the existence of a parking
lane adjacent to that lane group.
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When field data are not available, the HCM recommends using a value of 20 per hour for the
Parking Maneuvers where parking exists and 0 per hour where there is no parking.

Buses Stopping.  The number of Buses Stopping (buses per hour) for a particular lane group is
used in calculating the actual saturation flow rate for that lane group.  It determines the saturation flow
rate adjustment factor for the blocking effect of local buses that stop within the intersection area.

When field data are not available, the HCM recommends using a value of 0 buses per hour for
the Buses Stopping.

Central Business District Area Type.  The Central Business District (CBD) Area Type
check box for a particular lane group is used in calculating the actual saturation flow rate for that lane
group.  It determines the saturation flow rate adjustment factor for the area type (CBD or otherwise). 
Check this box if the intersection is in the CBD area, and leave it unchecked otherwise.

Use Default Lane Utilization.  The Use Default Lane Utilization check box and the Highest
Lane Volume (vehicles per hour) for a particular lane group are used in calculating the actual saturation
flow rate for that lane group.  They determines the saturation flow rate adjustment factor for lane
utilization.

When field data are not available, leave the Use Default Lane Utilization check box checked to
cause TS/PP-Draft to use the value recommended by the HCM based on the lane group movement and
number of lanes in the lane group.

Add/Cut an Intersection

The ability to add or cut an intersection is especially helpful when a new signal is being proposed
on an artery; using this option, you can quickly determine whether the new signal will coordinate easily
with the existing signals on the street using the current coordination parameters.

Use the  button in the Outline View to add a new Intersection to the current diagram/artery as
follows:

(1) Expand the diagram/artery in which you wish to add a new intersection (so that its intersections
are visible), then
(2) Select the intersection after which you wish to add a new intersection (or the diagram/artery, if
you want to add a new intersection before any current intersections), then

(3) Press the  button.

If you are adding an intersection an interior intersection, TS/PP-Draft will ask you to enter the
Distance from the Previous Intersection to the newly-added one. It then automatically calculates the 
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• right-turn in right-hand Drive Rule regions (North & South America, China and continental Europe).
• left-turn in left-hand Drive Rule regions (Great Britain, Australia, New Zealand, South Africa, and much of

Asia).
See page 127 for details.
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Distance from the newly-inserted intersection to the following one, if any, so the arterial length is
unchanged.

If you're adding a boundary intersection, TS/PP-Draft arbitrarily assigns the Distance, and you
must change it in the Intersection Parameters dialog. In doing this, TS/PP-Draft automatically recalcu-
lates the optimal Horizontal Scale (if it is unlocked) and the Distance to the first intersection from the left
margin.

Use the  button in the Outline View to delete the currently selected intersection. You may
also delete an intersection (and save it to the Windows Clipboard) using the Cut command under the Edit
Menu.

Cutting one of the interior intersections (not one of the boundary intersections) causes TS/PP-
Draft to reset the Distance between the intersections on either side of the one deleted.

Cutting one of the boundary intersections of the diagram causes TS/PP-Draft to reset the the
optimal Horizontal Scale (if it is unlocked) and the Distance to the first intersection from the left margin.

Link Intersections

An intersection link is an indication to TS/PP-Draft that some of the parameters between two or more
intersections are related.  You may link everything between the intersections or the Offsets only.  TS/PP-
Draft maintains the relationship between the parameters in linked intersections even when you are editing
one of the intersections.  The two types of links are discussed below:

Everything:
When you've linked everything between two intersections, TS/PP-Draft ensures that the Adjusted
Cycle Length, Offset, Splits, protected turn and pedestrian Phase Sequences, with-traffic  turn10

on red option, volumes and saturation flows, and number of through lanes are all identical for the
two intersections.  You can change any one of these parameters at either intersection and TS/PP-
Draft makes the equivalent change at the other.

Linking everything between two intersection indicates that the two intersections are
really just two representations of a single intersection.  This is useful for modeling signalized
networks or multiple intersecting arteries.  When you have two (or more) diagram windows
representing intersecting arteries, you should link everything between the common intersection(s)
so TS/PP-Draft can ensure that all the intersection parameters remain consistent.

When you have linked everything between two intersections in different diagram
windows, TS/PP-Draft relies on the directions of travel of the two arteries to maintain consis-
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tency between the directional parameters at the two intersections.  If you changing the Forward
Direction of one of these arteries, TS/PP-Draft must reset the directional parameters at the
intersections to restore consistency.  If you don't want TS/PP-Draft to do this, you must break the
link before changing the Forward Direction.  In either case, be wary of changing the Forward
Direction along an artery which has intersections linked to arteries in other diagram windows!

All Timings:
When you link all timings between two intersections, TS/PP-Draft ensures that the Adjusted
Cycle Length, Offset, Splits (and whether the splits are Fixed), protected turn and pedestrian
Phase Sequences, and with-traffic turn on red option are all identical for the two intersections.
You can change any one of these parameters at either intersection and TS/PP-Draft makes the
equivalent change at the other.

Linking all timings between two intersection indicates that the two intersections are
operating off a common controller.

Offsets only:
When you link intersections' Offsets only, any changes you make to the Offset of one intersec-
tion will apply to the Offset of the other intersection.

This is especially useful for modeling nearby intersections that operate from a common
signal controller, such as diamond interchanges.  Once the Offsets of two or more intersections
are linked, you may adjust any one of the Offsets to adjust all of them simultaneously.

In order to change the Offset of an intersection relative to its linked intersections, you
must (temporarily) break the link to that intersection.

Remember that changing the Offset Reference Point of a linked intersection results in an
effective change in Offset (even though the value of the Offset itself is unchanged).

On Time-Space diagrams only:
If you have started a new green band at any of the linked intersections, then changing the offset

causes TS/PP-Draft to reset the New Green Band Offset that begins at that intersection to the beginning
of the green time for the through (or left- or right-turn) movement in the appropriate direction of travel.

To link two intersections together, you may either

(1) Open the  Outline View, select one intersection in the diagram/artery list and drag it to
the one to which you wish to link it, or

(2) Open the  Network View, select one intersection (or node) and drag it to the one to
which you wish to link it

Either way, TS/PP-Draft will ask you to confirm which type of link you wish to make before
finally linking the intersections.

You may view a list of all intersection links in the Outline View.  
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Use the  button in the Outline View to find all links to the intersection selected in the
Arterial/Diagram Outline List. The links to the selected intersection are moved to the top of the Intersec-
tion Links List, and if necessary, the list is scrolled so the first link at the top of the list is visible.  

The Network View shows intersections with everything linked as a common intersection
between to arteries.

To view the diagram for the intersecting artery, select an intersection on a Diagram Window,
then click the right mouse button to view the pop-up menu. If the "Crossing Artery" command is enabled,
then you may choose it to jump to the Diagram Window of the artery that crosses at the currently
selected intersection.

TS/PP-Draft considers an intersection to have a crossing artery if Everything is Linked to an
intersection along an artery with a perpendicular Forward Direction. If there is no crossing artery, then
the "Crossing Artery" command is disabled.

Break Intersection Link

Use the  button in the Outline View to remove the link to an intersection
selected in the Intersection Links List. Only the link which you select is broken; any other linked
intersections remain linked.  Only the link which you select is broken; any other linked intersections
remain linked.

In the list of intersection links in the Outline View, the two types of links are distinguished by the
color and thickness of the lines symbolizing the link.  Thick red lines indicate everything is linked, and
thin green lines indicate that only the Offset is linked.

Templates

A template is the subset of the Diagram/Arterial Parameters which most affects how your
diagram appears. Specifically, a template consists of the diagram Size and Position, and the character
Fonts.  You may use templates to help ensure that all of your diagrams have a consistent appearance.

Use the Save command of the Template menu to extract the template from the current diagram
and save it in a file which you name. 

Use the Apply to One command of the Template menu to load a template from an existing file
and apply it to the currently selected diagram.

Use the Apply to All command of the Template menu to load a template from an existing file and
apply it to all diagrams in the currently open diagram date file.
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Optimization

Under the Optimize menu, there are several commands for automatically attempting to improve the
progression along the currently selected artery and the time required for timing plan transitions.

Optimize Arterial Offsets

This command under the Optimize Menu sets the intersection Offsets to try to get good progres-
sion in both directions of travel.  The Offsets are set such that the midpoints of either the green phase or
the red phase (red time for serving the pedestrians or the side street) are roughly simultaneous and the
green phases straddle, as close as possible, the "progression line."  I've heard this called the "Half-Cycle
Multiples" method.  

In the Optimize Arterial Offsets dialog, you may specify the intersection with the stable offset. 
The offsets of all other intersections will be adjusted to accommodate this one.  By default, the stable
offset intersection is one linked to a crossing artery, if there is one, or the first intersection in the
diagram.

You may also opt to "optimize the Protected Turning Phase Sequences".  In this case, the turning
phase sequences are set to roughly coincide with the interaction of the progression lines from the two
directions of travel.  

On arteries with more than, say, 10 signals, a timing pattern that seeks to provide a two-way
progression band through the entire artery typically creates some minor bands which make it part way,
perhaps most of the way, through the artery, but not all the way.  These minor bands may not be served
well by a timing plan that doesn't take them into account.  In this case, it might help to optimize the artery
in "sections," each with no more than a specified number of signals.  When the box "Optimize Artery in
Sections" is checked, the optimization process first treats the section of the artery with the most constrict-
ing signal (the one with the least arterial green time and fewest phase sequence options) and the specified
number of neighboring signals.  It optimizes the bands in this section while ignoring the rest of the artery. 
Then it works on surrounding sections of the artery, each with one intersection overlapping the neighbor-
ing section.  It optimizes these in similar fashion with the constraint that offset at the intersection
overlapping the neighboring section is held fixed.

If you have started a green band from any of the side street turning movements, the progression
of this band is not taken into account in selecting the offsets.  You may use the  Fine Tune Offsets
command to adjust the offsets taking into the progression of bands from the side street. 

It is often helpful to follow the "Optimize Arterial Offsets" command with one or more applica-
tions of the Fine Tune Offsets command. 

But these optimization and fine-tuning techniques may not produce optimal timings according to
everyone's way of thinking.  After using either command, you may choose Undo from the Edit menu, or
press Ctrl-Z, to restore the previous timing settings.  The direct editing of timing parameters (offsets &
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turning phase sequences) on the diagram window provide an easy way to "manually optimize" or fine
tune the timings, after or instead of the automatic optimization.

Fine Tune Offsets

This command under the Optimize Menu adjusts the intersection Offsets to try to improve the
progression in both directions of travel, giving preference to the beginning of the band and strong
preference to the possibly hypothetical band that makes it through the entire artery.  Partial credit is given
for bands that make it part way through the artery, and credit is deducted for inequities in the "progres-
sion quality" between the two directions of travel.

If you have started a green band from any of the side street turning movements, the progression
of this band is also taken into account in adjusting the offsets.

The band that makes it through the entire artery can be viewed by setting the downstream Green
Band Action at the arterial boundary intersections to Start, and setting then Green Band Action at all
intersections downstream to Clip.  This can be done quickly by right-clicking on the next intersection
downstream from the arterial boundary intersection and setting its Green Band Action to Clip; when you
finish, TS/PP-Draft will offer to change all downstream through Band Actions to match.

When fine tuning offsets, the Offset at one of the intersections is held stable.  The offsets of all
other intersections are adjusted to accommodate this one.  By default, the stable offset intersection is the
one specified the last time you opened the Optimize Arterial Offsets dialog, if ever, or it's one linked to a
crossing artery, if there is one, or it's the first intersection in the diagram.

Unlike the Optimize Arterial Offsets option, the fine tuning offsets is very sensitive to the
starting conditions.  You may find it best to
1. Apply the Fine Tune Offsets command once or twice, 
2. Adjust the phase sequence at one of the intersection (by selecting the intersection on the diagram,

right-clicking, and choosing Phase Sequence from the pop-up menu), then 
3. Repeat the Fine Tune Offsets command.

Repeating these steps multiple times may give a satisfactory set of timings.  But these optimiza-
tion and fine-tuning techniques may not produce optimal timings according to everyone's way of

thinking.  After using either command, you may choose Undo from the Edit menu, or press Ctrl-Z, to
restore the previous timing settings.  The direct editing of timing parameters (offsets & turning
phase sequences) on the diagram window provide an easy way to "manually optimize" or fine
tune the timings, after or instead of the automatic optimization.

Minimize Timing Plan Transition

This command under the Optimize Menu adjusts all the intersection Offsets as needed to
minimize the transition time to and from this timing plan while preserving the coordination
pattern.
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The Offsets are all shifted by the same amount (in seconds, thus preserving the coordina-
tion pattern) to try to ensure that they are as small as possible -- that as many intersections as
possible have offsets close to zero, and as few as possible have offsets just below the cycle
length.  If all timing plans are adjusted in this manner, the change in offset at each intersection
from one timing plan to the next will tend to be small, speeding up the time required to make the
transition between the timing plans.

You should consider using this option only if all coordinated signals are represented in
the currently opened diagram data file.  If a signal group in an adjacent control zone is also
coordinated with the current group of signals, but it is represented in a separate file, then using
this option might upset the relationship between the two signal groups.
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File Management

From the "File" pull down menu, you have various ways of managing the diagram data
files: new, open, merge, save, extract, print, etc.

New Diagram

Use the   button on the Tool Bar or the New command under the File Menu to clear
the diagram data file from memory and start with a new diagram.  This is necessary before you
can enter the parameters of a new diagram with a different number of intersection from the one
currently open.

It is not necessary to clear the current diagram from memory before opening a new
diagram data file; the new one will automatically replace the current one.

Before clearing the diagram data from memory, TS/PP-Draft detects whether it has been
modified since the last time it was saved. If so, TS/PP-Draft offers to save the diagram before
clearing it.

Open Diagram Data File

Use the  button on the Tool Bar or the Open command under the File Menu to open
a diagram data file.  Click the right part of the this button to open a recently-used diagram/arterial
file.  The Clear MRU List command at the bottom of this submenu clears the list of most recently
used files.
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Diagram Files The native and default file type. This file type is
upwardly compatible with future versions of TS/PP-
Draft.

.Dgm

AAP Files The file type of AAPEX of the Arterial Analysis
Package (available through McTrans). Helpful in
transferring the diagram/arterial parameters among
TRANSYT-7F, PASSER II-90, and other programs
supporting the AAP file format.  See page 137 for
further information about AAP files.

.AAP

Diagram Text File A text file which is used as a means of sharing
information with TEAPAC through PRETSPPD,
both from Strong Concepts
www.StrongConcepts.com. This file format is
likely to change in the future, based on user
feedback.

.DgT

Table VIII.  File types which TS/PP-Draft can Open and Merge.

By default, diagram data files have the extension ".Dgm", but you can change the
extension if you wish.  You may also select the type of file, choosing among the file types listed
in Table VIII.

The newly-open diagram will replace the one currently in memory. To prevent mishaps,
TS/PP-Draft detects whether the diagram currently in memory has been modified without having
been saved and, if so, offers to save the diagram before opening the new one.

The UTDF files are another convenient, and often preferable, way to share data with other
programs.  See page 133 for details.

Merge Diagram Data File

Use the Merge command under the File menu to merge a diagram data file on the disk
into the currently open diagram file.

You may merge any of the file types listed in Table VIII.
The Merge command is especially useful when you have more than one intersecting

arteries each represented by a diagram in a different file.  After loading the first and merging the
rest with it, you may establish links between the common intersections (see page 106).



User's Manual

117

Save Diagram Data File

Use the  button on the Tool Bar or the Save command under the File Menu to save the
diagram currently open. If the diagram file does not yet have a name, TS/PP-Draft asks you to
enter in the name of the file where you want it stored. By default, it will save it as a Diagram
File, but you may choose from any of the file types listed in the table below.

Diagram Files The native and default file type. This file type is
upwardly compatible with future versions of
TS/PP-Draft.

.Dgm

TSPPD 5.0 Diagram Files The native  file type of version 5.0 of TS/PP-
Draft. This file type is downwardly compatible
with the earlier version of TS/PP-Draft, but some
of the information (trip log properties, the Time-
Location diagram type, the size, position, and
zoom level of the Network View, etc.) in the
current version cannot be saved in this file type.

.Dgm

TSPPD 4.0 Diagram Files The native  file type of version 4.0 of TS/PP-
Draft. This file type is downwardly compatible
with the earlier version of TS/PP-Draft, but some
of the information (trip logs, annotations, geo-
graphic coordinates, etc.) in the current version
cannot be saved in this file type.

.Dgm

TSPPD 3.0 Diagram Files The native  file type of version 3.0 of TS/PP-
Draft. This file type is downwardly compatible
with the previous version of TS/PP-Draft, but
some of the information (phase numbers, mini-
mum splits, all red & yellow clearance times,
etc.) in the current version cannot be saved in
this file type.

.Dgm

Diagram Text File A text file which is used as a means of sharing
information with TEAPAC through PRETSPPD,
both from Strong Concepts
www.StrongConcepts.com. This file format is
likely to change in the future, based on user feed-
back.

.DgT
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AAP Files The file type of AAPEX of the Arterial Analysis
Package (available through McTrans). Helpful in
transferring the diagram/arterial parameters
among TRANSYT-7F, PASSER II-90, and other
programs supporting the AAP file format.  See
page 137 for further information about AAP
files.

.AAP

Bitmap Files A graphics file convenient for sharing graphics
with other Windows programs. TS/PP-Draft can
write Bitmap Files but cannot read them.  The
Picture file can be a preferable format for this
purpose.

.Bmp

Coordinates File A text file containing the geographic coordinates
of all the intersections in the system.  This file
can be imported into mapping software to verify
the coordinates.  The file has one intersection
with its set of coordinates per line.  The coordi-
nates are North Latitude and East Longitude (de-
grees). The rest of the line contains the intersec-
tion ID Number and the Name of the intersec-
tion.

.Txt

Picture Files The graphics file type also called a Windows
Enhanced Metafile.  This file type is helpful in
transferring diagrams as images to word proces-
sors or graphics programs. Compared to a Bit-
map file, the Picture file has the advantage that it
can be subsequently resized without loss of reso-
lution after loading it into another program.

.EMF

Once the diagram has a file name other than the default, TS/PP-Draft will automatically
overwrite that file without warning.  (Use the "Save As . . ." command to save the diagram to a
file with a different name.  Each time it overwrites an existing file, TS/PP-Draft saves a backup
copy of the existing file under a subfolder named "~Backup of last saved files~".  Thus when you
save MyArtery.Dgm, TS/PP-Draft keeps a backup of the original file with the name
"~Backup of last saved files~\MyArtery.Dgm".

The UTDF files are another convenient, and often preferable, way to share data with other
programs.  See page 133 for details.
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Save Diagram Data File As . . .

The "Save As . . ." command under the File menu will store the diagram currently in open
in a file with a different name.  TS/PP-Draft asks you to enter the file name, and assumes the
extension ".Dgm" if you don't specify an extension.  By default, it will save it as a Diagram File,
but you may choose from any of the file types listed in the table above.

"Save As . . ." is different from "Save" in that "Save As . . ." does not automatically
overwrite the file with the default file name.  Your diagram has a default file name if you loaded
it from a data file or have already saved it.  In this case, you should use the Save As command
instead of the save command when you want to save your diagram to a different file, i.e., you
don't want to overwrite the file with the default file name.

The UTDF files are another convenient, and often preferable, way to share data with other
programs.  See page 133 for details.

Extract Diagram

Use the Extract command under the File menu to extract just the currently selected dia-
gram/artery and save it to a different diagram data file.

This can be useful when you wish to move a diagram from one data file to merge in
another.  You may also use the Cut and Paste commands under the Edit Menu for this purpose.

UTDF Files

The Import/Export command in this submenu lets you open or save files in the Universal
Traffic Data Format, 2.1.  This is useful in sharing data with other programs that support this
format, such as Synchro and traffic signal control systems from Naztec, Gardner, Eagle, and
Peek.  See page 133 for details.  If the UTDF files already opened have more than one timing
plan, the Select Timing Plan command lets you choose the current timing plan reflected in the
diagrams.
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Closing the Diagram Data File

Use this command in the File Menu to close the currently open diagram file without
exiting TS/PP-Draft.

Printing the Diagram

Use the  button on the Tool Bar or the Print command under the File Menu to print
the diagram(s) currently open.  

If you’ve zoomed in on a section of the diagram, so TS/PP-Draft is treating the diagram
as split into pages, you may select which page(s) to print.

If you have more than one diagram/artery in the currently open diagram file, you may
print all diagrams, just the currently selected diagram, or you may specify which diagrams to
print.

Exit TS/PP-Draft

Use the Exit command under the File menu to exit TS/PP-Draft.
Before exiting the program, TS/PP-Draft detects whether the diagram currently in

memory has been modified since the last time it was saved.  If so, TS/PP-Draft offers to save the
diagram before quitting.
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Preferences

The Preferences dialog box is accessible through the Preferences command under the
View menu.  In the dialog, you may specify various parameters that control the units of measure-
ment, layout of the arterial diagram, trip log plots, and Travel Time & Delay Report, diagram
colors, default parameters, and default diagram data directories.  You may save these so that
TS/PP-Draft can use them each time it is run.

Layout

The parameters of the Layout page of the Preferences dialog determine the appearance of

the arterial diagram,  Speed vs. Distance or Time vs. Distance Plots from trip logs, and the

 Travel Time and Delay Reports from trip logs.  The layout parameters are grouped in sub
pages: Offsets, Splits, Bands, Time Grid, Misc., and Trip Log Plots.

Show Offsets.  This set of radio buttons indicates whether the intersection Offsets are
displayed on the diagram, and if so, where.  You may choose

• Below the Intersection Names.  In this case, you may specify the number of rows or lines
used to display the Offsets on the diagram.  This is useful if you have closely-spaced
intersections or so many intersections that the offsets tend to run together.

• Next of Offset Reference Points.  In this case, you may opt to label the offsets with the
initials "OS."  This is useful if you're also showing the splits on the diagram; the label
helps to distinguish the offset from the splits.

• Don't Show Offsets.  In this case, the offsets are not explicitly displayed anywhere on the
diagram; although, you may still infer them using the grid or a scale.

If the offsets are shown on the diagram, you may also opt to show the offset units using the Show
Offset Units check box.  If the units are not shown, the offset text uses a little less space on the
diagram, reducing clutter.
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Show Offsets on )))) Lines.  This parameter indicates the number of rows or lines
which TS/PP-Draft uses to display the Intersection Offsets on the diagram, if you have opted to
Show the Offsets.

By default, TS/PP-Draft shows the offsets on one line, but you may increase this number
if you have closely-spaced intersections or so many intersections that the names tend to run
together.  When showing the offsets on more than one line, TS/PP-Draft alternates lines to
reduce the likelihood that neighboring intersection's offsets will overlap.

Show (Arterial) Splits.  This check box indicates whether the Splits for the signal
phases along the artery are shown on the diagram (along with a movement arrow or abbreviation)
for each intersection.  When checked, the Splits are displayed in the Split Units (seconds or
percent) you have selected in the Units of Measure page.

Show Side Street Splits.  This check box indicates whether the Splits for the signal
phases along the side streets are shown on the diagram (along with a movement arrow or
abbreviation) for each intersection.  This option is available only if you've also opted to Show the
Arterial Splits.

When checked, the Splits are displayed in the Split Units (seconds or percent) you have
selected in the Units of Measure page.

Show Minimum Splits.  This check box indicates whether the Minimum Splits for
the signal phases along the artery (and optionally along side streets) are shown on the diagram
(along with the phase number) for each intersection.  This option is available only if you've opted
to Show the Arterial Splits.

Show Split Units.  This check box indicates whether the Splits Units should be
displayed on the diagram along with the Splits and a movement arrow or abbreviation for the
signal phases along the artery at each intersection.  This option is available only if you've opted
to Show the Arterial Splits on the diagram.

If you've also opted to Show the Side Street Splits or to Show Minimum Splits), the
Splits Units will be shown along with them as well.

Split Label.  This set of radio buttons indicates how the Splits for the signal phases are
labeled on the diagram, with either 
• a movement arrow, or 
• a two-letter abbreviation (e.g., NT, SL, ET, WL), or
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• or the phase number, for each intersection.
This option is available only if you've also opted to Show the Arterial Splits.

Show Splits on Just One Cycle.    This check box indicates whether the Splits
should be labeled on all cycles in the diagram or on just one cycle to reduce clutter.  
This option is available only if you've also opted to Show the Arterial Splits as labels on the
diagram.

Show Band Speeds.  This is a check box indicating whether, on Time-Space and
Time-Location diagrams, the Design Speeds of the green bands are shown explicitly when
drawing the diagram (e.g., "32.2 mph" or "45.7 kph").

When checked, the Design Speed is displayed on the diagram at the beginning of the
arterial green bands and at every intersection where the Design Speed changes.

Show Band Widths.  This check box on the Layout page of the Preferences dialog
indicates whether, on Time-Space and Time-Location diagrams, the widths (seconds) of the
displayed green bands are shown explicitly on the diagram.  

Depending on the green Band Action, the band width can change throughout the diagram,
new bands can start (or stop), and bands can split into multiple sub-bands.  Using this option lets
you see the exactly how it changes, since it shows you the width of every band drawn on every
link in the diagram.

If you've opted to show the band widths, you may choose to have the band widths labeled
with initials "BW."  This can help distinguish the displayed band widths from any offsets or
splits that may also be shown on the diagram.  You may also include the band width units
(seconds) in the display of the band widths.

Show One Band Only.  This check box indicates whether, on  Time-Space and Time-
Location diagrams, just one green bands is shown for each direction of travel, starting in the first
(or lowest) cycle.

This can provide for a less cluttered appearance of the diagram, allowing you to focus on
just the one band.  A disadvantage is that it can be more difficult to see how the bands from the
opposite directions of travel interact at each intersection, which can be useful in deciding whether
to change to a leading, lead-lag or lagging protected turn sequence.

When this box is checked, only one green band is displayed on the diagram in each
direction of travel.  If you have opted to show green bands from side street turning movements,
one band is shown for each movement.  This band begins in the first, or lowest, cycle on the
diagram.  If you have opted to start a new green band at a particular intersection, the new band
starts in the first cycle, independent of which cycle the upstream arrives in.
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When this box is not checked, a green band is displayed on the diagram in each cycle for
each direction of travel

Color-Fill the Interior of the Band.  This check box indicates whether, on  Time-
Space and Time-Location diagrams, the green bands are color-filled.

This makes the bands more prominent, but results in slower screen refreshes.
When this box is checked, the solid green bands are displayed with the color of your

choosing.
When this box is not checked, hollow green bands are displayed, with only the starting

and ending edges visible.

Time Marker.  This is a set of radio buttons specifying how regular time intervals
(determined by the Seconds Per Mark parameter) are marked in drawing the diagram.  It may be
set to "Tick Marks" or "Grid Lines."

You may set the spacing between the time intervals with the Seconds Per Time Mark
parameter.

Seconds Per Time Marker.  This parameter determines the interval (or spacing)
between the regular time markers in drawing the diagram.

Show Minor Time Mark.  Use this check box on the Layout page of the  Preferences
dialog to show a minor or secondary time marker in addition to the principal time marker.

If this box is checked, you may specify the interval or spacing (in seconds) between the
minor time markers in the diagram.

When the principal Time Marker is Tick Marks, the minor time marker is shorter tick
marks.  When the principal Time Marker is Grid Lines, the minor time marker is dotted grid
lines.

Show Date and Time.  This is a check box indicating whether the date and time are
placed at the top in drawing the diagram.

Show Intersection Names on )))) Lines.  This parameter indicates the number
of rows or lines which TS/PP-Draft uses to display the Intersection Names on the diagram.
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By default, TS/PP-Draft shows the names on two lines, alternating to reduce the liklihood
that neighboring intersection's names will overlap.  You may increase this number if you have
closely-spaced intersections or so many intersections that the names tend to run together.

Show Distances between Intersection.  This check box indicates whether the
Distances between intersections are placed along the bottom of the diagram, below the intersec-
tion names.

If the Distances are are shown, you may select the number of rows or lines TS/PP-Draft
uses to display the Distances on the diagram.  This is useful if you have closely-spaced intersec-
tions or so many intersections that the distances tend to run together.

Show Distances on )))) Lines.  This parameter indicates the number of rows or
lines which TS/PP-Draft uses to display the Distances between Intersections on the diagram, if
you have opted to Show the Distances.

By default, TS/PP-Draft shows the distances on one line, but you may increase this
number if you have closely-spaced intersections or so many intersections that the distances tend
to run together.  When showing the distances on more than one line, TS/PP-Draft alternates lines
to reduce the likelihood that neighboring intersection's distances will overlap.

Show Travel Times between Intersections.  This check box indicates whether the
Travel Times between intersections are placed along the bottom of the diagram, below the
intersection names.

The Travel Time is defined as the Distance between the intersections divided by the
Design Speed.

If the Travel Times are shown, you may select the number of rows or lines TS/PP-Draft
uses to display the Travel Times on the diagram.  This is useful if you have closely-spaced
intersections or so many intersections that the times tend to run together.

Show Travel Times on )))) Lines.  This parameter indicates the number of rows
or lines which TS/PP-Draft uses to display the Travel Times between Intersections on the
diagram, if you have opted to Show the Travel Times.

By default, TS/PP-Draft shows the times on one line, but you may increase this number if
you have closely-spaced intersections or so many intersections that the times tend to run together. 
When showing the times on more than one line, TS/PP-Draft alternates lines to reduce the
likelihood that neighboring link's times will overlap.
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Platoon Flow Patterns.  This set of radio buttons indicates the style of dot pattern
used on Platoon-Progression diagrams to depict the flow bands. You may choose Dot Patterns (in
which the dot density is proportional to the vehicle density) or Solid Colors.

The Dot Patterns often look better on monochrome devices (notably, printers).

Use Standard Scales.  This is a set of check boxes indicating whether TS/PP-Draft is
restricted to standard scales in setting the default Horizontal and Vertical Scales.

If this is checked for the Vertical Scale, then the Vertical Scale will be something like 10
seconds/inch or 50 seconds/cm, depending on the units of measurement, diagram size, and font
size.  Otherwise, it will be whatever scale is necessary to show exactly the desired number of
cycles on the diagram, with no "wasted" space.

If this is checked for the Horizontal Scale, then the Horizontal Scale will be something
like 200 meters/cm or 500 feet/inch, depending on the units of measurement, diagram size, and
total Distance between intersections. Otherwise, it will be whatever scale is necessary to show all
the intersections on the diagram, with no "wasted" space.

Show Date and Time in each Trip Log Title and Run Legend Label.   

Check this box to include the date and time of each trip log in its label on the  plot.  When
there are many trip logs included in the plot, unchecking the box reduces the clutter in the labels.

Always Show Run Number in Legend Labels.    A single trip log can include

more than one run through the artery.  Each run is displayed in the  trip log plot.  
Uncheck this box to include the run number in the trip log label only when the trip log

includes more than one run through the artery.  When this box is checked, the run number is
always included in the label, even when the trip log includes only one run.  This can give the
labels a more uniform appearance.

Show List of Trip Logs in Plot Title.  The  trip log plot includes a
• Legend - along the right hand side of the plot.  The legend gives a detailed list of each run

of each trip log included in the plot, showing which color and line style shows the
corresponding trajectory.

• Title - at the top of the plot.   The Title gives the name of the arterial diagram and,
optionally, a list of all the trip logs (but not the runs) included in the plot.



User's Manual

127

Use this check box to indicate whether you'd like this list of included trip logs in the plot title. 
When there are many trip logs included in the plot, unchecking the box reduces the clutter in the
title.

TT & D Reports.  Use this check list to choose which items to include as columns in

the   Travel Time and Delay Reports from trip logs.

Printout

The parameters on this page of the  Preferences dialog determine the how the diagram  prints.
The Printout parameters include: 
• whether to Show the Diagram File Name and Today's Date & Time 
• whether to Show the Vertical Scale, 
• the diagram's Orientation on the page.

Show Diagram File Name.  This check box indicates whether TS/PP-Draft prints the
name of the diagram file on the page when you print the diagram.  If this is checked, then TS/PP-
Draft prints the name of the diagram data file and the current day, date and time across the top of
the page before printing the diagram.

Show the Vertical Scale.  This check box indicates whether TS/PP-Draft prints the
vertical scale of the diagram file on the page when you  print the diagram.

If this is checked, then TS/PP-Draft prints the vertical scale along the right margin of the
diagram before printing the diagram.

Orientation.  Use this set of radio buttons to set the default page orientation (Portrait or
Landscape) the printer will use when you print diagrams. You may override this default using
either the Printer Setup command of the File Menu or by clicking the Settings button in the

Printer dialog that appears after selecting the  button on the Tool Bar or the Print command
under the File Menu.



TS/PP-Draft 6.0: Time-Space/Platoon-Progression Diagram Generator

128

Units of Measurement

In the Units of Measurement page of the Preferences dialog, you may set the units in
which some quantities are entered and expressed. The quantities affected by the Units of
Measurement are Horizontal and Vertical Scales, Design Speed, Distance from Previous
Intersection, Splits, Offset, and Vehicle Length.

For offsets and splits, you may also set the number of decimal places to which the values
are shown.

Changing the Units of Measurement will change the numerical values but not the physical
values of these quantities. Thus, if the Distance between two intersections is declared as 300 feet,
then changing the Distance unit from feet to yards causes TS/PP-Draft to display the Distance
between the intersections as 100 yards--the number is changed, but the physical distance is
unaltered. Consequently, you are free to change the Units of Measurement at any moment
without affecting the diagram currently open or any saved on the disk. You may, for example,
develop a diagram with English units and change to Metric units before creating the report of
diagram/arterial parameters.

Diagram Size Unit.  This unit is either inches or centimeters (cm) and is used to
express the diagram size and margins as well as the denominator of the horizontal and Vertical
Scales. Thus, if the Distance unit is set to feet, and the diagram length unit is set to inches, then
the Horizontal and Vertical Scales will be measured in feet per inch and seconds per inch
respectively.

Distance Unit.  The Distance Unit is used to express the Distance from the previous
intersection and the numerator of the Horizontal Scale.  It may be set to feet, yards, miles, meters,
or kilometers.

Speed Unit.  The Speed Unit is used to measure the Design Speed and all speeds in the
Travel Time and Delay Report.  It may be set to either feet/second, yards/second, miles/hour,
meters/second, or kilometers/hour.

Offset Unit.  The Offset Unit is used for to measure the Offsets of the signals and, on
Time-Space diagrams, of the green bands (arterial and new).  It may be set to either percent of the
Cycle Length or seconds.  To avoid conflicts, TS/PP-Draft stores the Offsets internally as
percent, so changing the Cycle Lengths will change the Offset even if it is measured in seconds. 
If the Offset unit is set to seconds, TS/PP-Draft allows the Offsets to be entered in seconds;
however, it then converts them to percent.
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You may also set the number of decimal places to which the offset is shown.

Splits Unit.  The Split Unit is used to measure the Splits.  It may be set to either percent
of the Cycle Length or seconds.  To avoid conflicts, TS/PP-Draft stores the Splits internally as
percent, so changing the Cycle Lengths will change the Splits even if they are measured in
seconds.  If the Splits unit is set to seconds, TS/PP-Draft allows the Splits to be entered in
seconds; however, it then converts them to percent.

You may also set the number of decimal places to which the splits are shown.

Vehicle Length and Lane Width Unit.  The Vehicle Length Unit is used to
measure the average lengths of vehicles in the queue and the Average Lane Width of lane groups. 
It may be set to feet, yards, miles, meters, or kilometers.

Drive Rule.  This set of radio buttons indicates the driver's side rule, or the side (Right-
Hand Side or Left-Hand Side) on which drivers are required to maintain their vehicles along two-
way streets.

In North & South America, China and continental Europe, this should be the Right-Hand
Side.  In Great Britain, Australia, New Zealand, South Africa, and much of Asia, this should be
the Left-Hand Side.

In this document, cross-traffic turn is a generic term referring to left-turns for right-hand
Drive Rule, right-turns for left-hand Drive Rule.

Generally, you should set the Drive Rule once when you first run TS/PP-Draft and then
not change it again (although it is harmless to change the parameter then change it back, even
when a diagram data file is  open).  Internally, parameters that correspond to turning signal
phases or movements (such as splits and yellow clearance times) and turning lane groups (such
as volumes and number of lanes) are associated generically with either "with-traffic turns" or
"cross-traffic turns".  They are not stored as, for example, volume of East-bound traffic turning
North.  The result is that if you change the Drive Rule, you will notice many parameter values
"switching" sides -- left-turn volumes will be found in the right-turn volume locations, and green
bands started from the side-street turning movement will progress in the opposite direction down
the artery.  This can be pretty confusing and might lead to unexpected results.  For this reason,
you set this parameter once early on and then not change it again unless you need to work in a
region with the other Drive Rule.
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Colors

In the Colors page of the Preferences dialog, you may set the colors used by TS/PP-Draft
in displaying the various regions of diagrams (e.g., arterial red time, time markers, text, green
bands, etc.).

In the Diagram Region list box, select the region whose color you wish to view or edit. If
you would like more than one region to share a common color, you may select multiple regions
by pressing the Shift or Control key down while clicking regions. Edit the color for the selected
region(s) by clicking the Edit Color(s) button to pop up the Edit Color dialog.

Default Parameters

In the Default page of the Preferences dialog, you may set the default values of some
parameters.  These are the Offset Reference Point (page 67), Start Up (page 98) and Clearance
Lost Times (page 101), Flashing Don't Walk (page 97), Yellow (page 98), and All Red (page 98)
Clearance Times, Vehicle Length (page 69), Dispersion Factor (page 70), Protected Turn Phase
Sequence (page 84), Green Band Action (page 89), and the Zoom Factor.

You may override these defaults for any diagram in the Diagram/Arterial Parameters
dialog, the Intersection Parameters dialog (Green Band Action), or in the Tool Bar (Zoom
Factor).

The parameters are set to their default values when you start up TS/PP-Draft.

Desktop

On the Desktop page you may set parameters that determine the appearance of the TS/PP-
Draft desktop.  

The Desktop parameters include: whether the Tool Bar, Status Bar, and pop-up Hints are
visible at start up.  

You also have an choice of which type of Saturation Flow (ideal or actual) is viewed by
default in the Intersection Parameters dialog.

You may specify whether the movement buttons on the Intersection Parameters dialog are

“flat” or protruding.  These buttons include the phase and movement (e.g., ) buttons on

the Timings Page, and the lane group buttons (e.g., ) on the Volumes page of the  Intersec-
tion Parameters dialog.  If they’re flat, they protrude only when the mouse cursor is over them,
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reducing clutter on the screen somewhat.  If they protrude, it’s more obvious that they’re there
available to display associated parameters.

And you may choose whether to use a strict test of the Splits of both rings summing to the
Cycle Length or to allow the splits of just one ring to sum to the Cycle Length.  Whichever test
you use, the strict test or the more lenient test, TS/PP-Draft will issue a warning to you if the test
isn't passed.
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How Trip Logs are Processed

Here are some general comments and definitions on how various items are determined
from trip logs in generating, for example, Travel Time & Delay Reports.

A trip log is mainly a series of consecutive GPS readings, each consisting of geographic
longitude & latitude, altitude, speed, heading, and time.   A trip log also includes a name or title
and the time of day at which the signal cycle started, that is, the time of day when the signal
offset zero occurred.  This time is determined during the clock synchronization step.

A stop is counted when the speed drops to or below 5 mph (8 km/hr) after having
exceeded 15 mph (about 24 km/hr).  This definition is subject to change, though, as I get more
feedback from users.

A run begins when the trip log "enters" the artery, and it ends when the trip log "leaves"
the artery.  A single trip log may include more than one run through an artery.

A trip log enters the artery when it "passes through" an intersection that's not the down-
stream neighbor of the previously passed-through intersection, if any.  It leaves the artery when it
"passes through" an intersection that's not the upstream neighbor of the subsequently passed-
through intersection, if any.  Thus is it possible for runs to begin and/or end inside the artery, not
just at the boundary intersections.  Generally you'll want runs to traverse the entire length of the
artery, so you'll enter at one boundary intersection and leave at the other boundary.  I recommend
you start recording the trip logs at least 6 to 8 seconds before entering the first intersection and
continue recording at least 6 to 8 seconds after passing through the final intersection, to ensure
that there are GPS readings straddling the intersection geographic center.  These should be
moving seconds, to help ensure that there's at least one reading on each side of where TS/PP-
Draft thinks is the center of the intersection.  The extra recording time helps account for the fact
that the current readings may not be exactly at your true location, and TS/PP-Draft and you may
not perceive the center of the intersection to be at exactly the same location either, due to GPS
uncertainty and other possible sources of error.

Be generous with the extra recording time -- more is safer.  I usually start recording 1 or 2
minutes before I enter the artery, and continue to record 1 or 2 minutes after I leave.  Trip logs
grow at a slow rate, one reading (24 bytes) per 1 or 2 seconds, depending on the type of GPS, and
the time wasted in processing unnecessary readings while subsequently generating plots or
reports is usually negligible, so the penalty for starting to record too early and continuing to
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record too late is essentially nothing compared to the penalty for starting the recording too late or
ending it too early.

To pass through an intersection is defined as getting "close enough" to the "geographic
center" of the intersection.

The geographic center of an intersection is the average of all the measurements or GPS
readings entered for that intersection.  This is taken to be the center of the intersection.  Be sure
to add these measurements in pairs that straddle the center of the intersection.  If you later add
additional GPS readings to increase the accuracy of the geographic center, you may regenerate
the Travel Time & Delay Report to take advantage of the greater accuracy.

Close enough means the distance from the point of closest approach, or where two
consecutive GPS readings straddle the geographic center of the intersection, is less than or equal
to the "half-width" of the intersection plus a little slop to account for GPS uncertainty.

The half-width of the intersection is determined by the greater of the following:
• the number of lanes times the lane width, for each approach,
• the extent or envelope of the measurements or GPS readings entered for the geographic

coordinates of the intersection.
Since there's no provision at present to enter the width of a median strip, taking GPS readings on
diagonally opposite corners of the intersection so the envelope can be calculated is usually the
most effective way to enter the median width.  You may right-click on the Network View and
check the item "Show Intersection Extents" to view the effective extent of the intersections.  This
is a circle centered at the intersection geographic center with a radius equal to the half-width of
the intersection.  A trip log must cross this region to count as passing through the intersection. 
Viewing the extent makes it easier to diagnose why a trip log is either skipping an intersection or
passing through one twice. You can also detect when an extent is too large, usually due to a bad
or misplaced coordinate measurement.
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Importing/Exporting UTDF Files

TS/PP-Draft can import and export ASCII files in the UTDF (Universal Traffic Data
Format) version 2.1. These files can be used to transfer diagram parameters to and from other
programs supporting the UTDF, such as Synchro and traffic signal control systems from Naztec,
Gardner, Eagle, and Peek.  See also “Importing/Exporting UTDF Files with Synchro” in the
online help for tips on working with these files in Synchro.

Use the Import/Export command of the UTDF submenu of the File menu to open the
Universal Traffic Data Format Files dialog.  In this dialog box you may specify the names of the

various UTDF files: Layout, Lanes, Timing, Phasing, and Volume.  Use the  button next to
each file name to browse for an existing file or to simply choose the desired directory for your
files.  You may leave a file name blank to exclude it from the importing or exporting of data.

Once you've specified the UTDF file names, use the  button to import the data

from the files, replacing any diagram/arterial file currently in memory.  Use the 
button to export the currently open diagram/arterial file to the UTDF files.  When you've finished
and are satisfied that the files have been properly imported or exported, use the  to exit the dialog
box.

Each of the UTDF files can be one of two different styles with different extensions, as
described in the table below.

UTDF File Extension Description Comments

.CSV Comma-delim-
ited variables

These files are usually a bit smaller.  In the case of
the Layout data, this file style can contain the
names of streets.

.DAT Column-aligned
variables

These files are easier for a human to read in a
word processor or text editor.  In the case of the
Layout data, this file style cannot contain the
names of streets.

For most of the five different files in the set of UTDF files, which of these styles or
extensions you choose is really a matter of preference.  Spreadsheet or other programs often
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handle one of these file styles more easily than another.  But as noted in the table, for the Layout
file, the choice makes another important difference: the comma-delimited Layout file can contain
the names of streets, whereas the column-aligned cannot.  Therefore, it is generally preferable to
use the comma-delimited style for the Layout file.

UTDF File
Type

Extension Description

Layout Either .CSV or .DAT,
but .CSV is
recommended

Stores intersection locations and connections. 
The .CSV file can contain the names of streets,
but the .DAT file cannot.  Therefore, it is gener-
ally better to use the .CSV style for the Layout
file.

Lanes Either .CSV or .DAT Stores lane and fixed information

Timing Either .CSV or .DAT Stores timing plan information that varies by time
of day.  If there is more than one timing plan,
then after you import the file you may use Select
Timing Plan command from the UTDF submenu
of the File menu to choose the timing plan cur-
rently reflected in the diagram windows.

Phasing Either .CSV or .DAT Stores timing plan information that doesn't
change with time of day.

Volume Either .CSV or .DAT Stores one or more volume counts. TS/PP-Draft
can extract an hourly volume from a specified
period of time.  See below for more information.

If you're importing a Volumes file with the UTDF set, TS/PP-Draft will need to extract an
hourly volume.  Use the controls in the box labeled "Use Average of Volume Counts" to specify
the date and time of the range of volumes counts you wish TS/PP-Draft to average.  If you wish
to use just one volume count, without using an average, then set the From date and time to be the
start  of the volume count, and set the To date and time to be the end of the count (typically, one
hour after the start). If there's only one volume count in the Volumes file, then you only need to
set the From date and time to be any time before or up to the start of the count, and To date and
time can be any time after the count.

Detailed information about UTDF files can be found in the document UTDF2_1.doc in
the Docs subdirectory of the TS/PP-Draft directory (typically, C:\Program Files\TS-PP-
Draft\Docs).  This file isn't installed by default.  To install this file, choose the "Custom" setup
option when you run the TS/PP-Draft 6.0 Setup program.
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A few notes concerning TS/PP-Draft's use of the UTDF files are in order:

1. Some information in TS/PP-Draft, such as the diagram Size, Position, Scales, and Fonts,
and the intersection Green Band Action, is not stored in the UTDF files.  Upon reading
the files, TS/PP-Draft either uses the Default Parameters or makes reasonable guesses to
fill in the missing information.  But you should be aware that these parameters may not be
set the way you expected.

2. TS/PP-Draft doesn't specifically handle intersections with actuated signals.  It expects
each signal to have, or be modeled as having, a fixed cycle length that is either equal to
the network-wide cycle length or half or twice that cycle length.  When TS/PP-Draft
encounters an actuated signal in the UTDF files, it will add up the splits (or minimum
splits, if necessary) and choose an adjusted cycle length that's nearest to the sum of splits.

3. When reading UTDF files, TS/PP-Draft calculates the travel distance between intersec-
tions as the sum of the length of straight lines drawn between the nodes (including bends
and unsignalized intersections).  This calculation excludes any hills or grades, and it
excludes any curves or turns between the intersections that aren't explicitly in the UTDF
files as bends.  If your streets have any of these characteristics, the travel distances
TS/PP-Draft calculates will be too small, and you'll need to manually adjust these
distances in the  Intersection Parameters dialog.

4. The UTDF files can have unsignalized intersections.  As TS/PP-Draft traces through the
intersections in UTDF files, finding the signalized arteries, it can sometimes take a wrong
turn at an unsignalized T-intersection.  This is because the UTDF files sometimes contain
misleading information about which are the through movements and which is the side
street.  At unsignalized intersections, TS/PP-Draft uses the angles of the various ap-
proaches to determine which approaches are along the main artery.  The two approaches
that are most directly opposite (180/ apart) are called the artery, and the third approach is
labeled the side street.  If the UTDF files indicate that legs of the intersection form more
of a Y than a T, it's possible that the side-street and one of the arterial approaches will be
closer to being in opposite directions than the two arterial legs, and TS/PP-Draft will
guess that the side street is actually the opposing approach of the main artery.  At signal-
ized intersections, this isn't a problem because TS/PP-Draft uses the phasing information
to determine which approaches are along the artery.  If this happens to you, you might
want to change the angle of approaches in your UTDF files so arterial legs are closer to
opposite directions or remove the unsignalized intersection entirely from the UTDF file
so TS/PP-Draft won't be confused.  If you're using Synchro, you can change the angles of
the approaches by dragging the neighboring nodes.
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5. TS/PP-Draft allows node ID numbers (page 75) as high as 2,147,483,647, but Synchro
requires them to be in the range 1...9999, so if you're exporting UTDF files to import into
Synchro, you'll want to keep them within the lower range.

6. Upon importing UTDF files, TS/PP-Draft chooses a forward direction for each artery
(North, for N-S arteries, and East, for E-W arteries).  Although you may not specify
TS/PP-Draft's choice, you may "flip a diagram over," reversing the orientation of the
diagram so that all intersections appear in the opposite order, by right clicking on a
selected diagram and choosing the Flip Diagram Orientation command from the pop-up
menu.

7. Some programs, including Synchro, are very sensitive to the directional labeling of
approaches (N, NE, NW, etc.) upon importing UTDF files.  If an approach is not labeled
in the way it expects, then the program won't read the corresponding number of lanes,
volumes, timings, phasings, etc., for that approach.  But the UTDF file specification gives
no guidance on how to assign approach labels, so programs don't necessarily follow the
same rules.  To work around this ambiguity, you may rectangularize the grid before
exporting the UTDF files by checking the box "Export a strictly rectangular grid".  This
ensures that the links between intersections in the UTDF files all lie along horizontal or
vertical lines, no diagonal lines.  In this case, the intersection positions will be (artifi-
cially) rearranged as needed to ensure that all streets run strictly North-South or East-
West.

This is usually not a concern when exporting a file that was originally imported as
a UTDF file.  In this case, TS/PP-Draft will retain the approach labeling in the original
file.

When TS/PP-Draft imports UTDF files, it treats these labels with a grain of salt,
so if it expects an approach to be labeled NE, but finds information under the N label
instead, it takes that to be the applicable label.
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AAP Files and Reference Files

AAP files are the native file format of the Arterial Analysis Package.  They may be loaded and
modified in AAPEX of the AAP (available through McTrans), thus providing a means of sharing
data with other signal timing programs.  

When saving AAP files, TS/PP-Draft asks you whether it should use a reference file.  If
you Imported the diagram from an AAP file, then that file is the default reference file.

The purpose of a reference file is as follows.  There is no one-to-one correspondence
between diagram data and AAP data; each file format contains some data the other lacks.  When
saving an AAP file, TS/PP-Draft makes reasonable assumptions to fill in the missing data.  The
saved AAP file data will be reasonable, but may not be exactly what you intend.  To avoid this,
TS/PP-Draft can refer to an existing AAP file (the reference file) upon filling in the missing data. 
Ideally, the reference AAP file describes the same artery.

If you don't use a reference file, you should review the exported file in AAPEX to make
sure all the data is accurate.  Note especially the Arterial Parameters, Timing Plan (the phase
codes), the Approach Data (Number of Lanes, Peak Hour Factors, Sneakers, Saturation Flows
and their adjustment factors, Storage, and Minimum Phase Times), and the Run Instructions.

AAP files are helpful in transferring the diagram/arterial parameters among TRANSYT-
7F, PASSER II-90, and other programs supporting the AAP file format.

For more information on using TS/PP-Draft with the AAP, see "TS/PP-Draft and the
Arterial Analysis Package" on page 156.
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CopyFromDgmFile Utility

CopyFromDgmFile is a utility program for TS/PP-Draft 6.0 users.  Its purpose is to
transfer selected intersection or traffic signal parameters from one diagram file (*.Dgm) to
another.  This is useful if you maintain multiple timing plans for a given set of intersections.

Ideally, parameters that are the same for all timing plans (e.g., intersection geometry,
yellow & all-red clearance times, etc.) would be stored in a separate file that would be accessible
to all diagram files for those arteries.  You could change the parameters from within one diagram
file, and the changes would automatically be reflected in all diagram files that use the common
parameters.

This utility gives the next best thing: You can change the common parameters within one
diagram file, then use this utility to "apply" those changes to other diagram files.

Using CopyFromDgmFile

Before using CopyFromDgmFile, please keep a backup copy of the .Dgm files you'll be
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modifying.  You'll want to have something to fall back on if something goes wrong.  Before
saving a file, the program will make a backup of the file in the subfolder named "~Backup of
last saved files~", so you can use that to recover from an unwanted change, but it's a
good idea to keep your own backup anyway in case you don't notice right away that something is
wrong.

Checking the boxes next to the bold-faced parameter group headings selects or unselects
all parameters in that group.

The window is sizeable, so you can drag the edge to enlarge it and get a better view of the
settings.

How it Works

The program uses the intersection ID number to match intersections between the two
files.

For every intersection in the source file, it looks for an intersection with a matching ID in
each diagram/artery in the target file. If it finds one, it copies the selected parameters from the
source intersection to the target intersection, using the "forward" direction of their arteries to
determine what their orientations of the approaches are (N,S,E, or W).  The timing parameters
are copied for each movement using this orientation.

Caveats

There is no check to verify that the phase numbers match before data is copied.
If an given ID is used for more than one intersection in the source file (that is, if the

intersection appears in more than one diagram), there is no check to verify that those intersec-
tions are linked or have identical parameters.
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Frequently Asked Questions

Special procedures

OK, I've got a GPS receiver.  Now what do I do with it? See the tutorial on How to
Perform a Travel Time and Delay Study (page 11) for step by step instructions on how to operate
with the GPS receiver.

In addition to these studies, you can use recorded trip logs to
• Take measurements of the geographic coordinates of intersections.
• Plot trajectories on the diagram windows, graphically showing where delay occurs, which

signals you've stopped at, and where you entered or left the green bands.

• Prepare  Travel Time and Delay Reports.

• Make  Plots of Speed vs. Distance or Travel Time vs. Distance.
• Measure the travel distance between intersections.
• Calculate the "optimal" relative offset between intersections for a given direction of

travel.
• Calculate the average speed between intersections.
• Calculate the Start-Up Lost Time for the through movements at an intersection.

I have separate diagram files for two intersecting arteries in separate
files.  How do I link them together at their common intersection?  Use the File:Open
command to open the first diagram, then use the File:Merge command to merge the second
diagram with the first.  Finally, to link the two diagrams together at their common intersection,
open either the Outline View or the Network View, and drag the intersection from one diagram
to the common intersection in the other diagram (see page 106).

How do I transfer my diagram to a document in my word-processor (or
desk-top publisher or graphics presentation program)?  If your word processor
supports pasting graphics from the Windows Clipboard, then the easiest way is to copy (using the
Copy command under the Edit menu) your diagram to the Clipboard, then paste it in your word
processor.  If your word processor does not support pasting graphics files, then you might try
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reserving some white space on one page in your document, and set your diagram size and
margins so that when you may draw your diagram to the printer, it fits in that white space.  Then
run that page through your printer a second time to print the document.

How do I transfer data between TS/PP-Draft and Synchro? TS/PP-Draft and
Synchro can share street, traffic, and signal data through a set of text files in the UTDF (Univer-
sal Traffic Data Format) version 2.1.  Both TS/PP-Draft and Synchro can read and write these
files.  For details on how to read or write these files with TS/PP-Draft, see page 133.  For details
on how to read or write these files with Synchro, see the section “Importing/Exporting UTDF
Files with Synchro” in the online help.

How do I transfer my existing diagram data to the AAP?  To transfer diagram
data created with TS/PP-Draft (that is, data that wasn't originally created in the AAP and
transferred to TS/PP-Draft) to the AAP, simply 

(1) Open up the diagram data file and save it to an AAP file (by changing the file type to
AAP File in the Save File dialog).  

(2) In the Save File dialog, ensure that the subdirectory where TS/PP-Draft will export the
AAP file is where the AAP looks for its data files.  

(3) Answer "No" when TS/PP-Draft asks you whether to use a reference file (unless you
have an existing AAP file for that artery, but even then, it's not necessary).  The file you export
can then be loaded by the AAP.

How do I work with multiple timing plans for my signalized network? There
is a companion utility, CopyFromDgmFile, that simplifies the management of multiple timing
plans.  It's purpose is to transfer selected intersection or traffic signal parameters from one
diagram file (*.Dgm) to another.

Ideally, parameters that are the same for all timing plans (e.g., number of lanes, yellow &
all-red clearance times, etc.) might be stored in a separate file that would be accessible to all
diagram files for those arteries.  You could change the parameters from within one diagram file,
and the changes would automatically be reflected in all diagram files that use the common
parameters.

CopyFromDgmFile gives the next best thing: You can change the common parameters
within one diagram file, then use CopyFromDgmFile to apply those changes to other diagram
files.

The CopyFromDgmFile program is in the same folder with TS/PP-Draft.  The section on
page 139 gives more details on how to use it.

Some of the intersections are so closely spaced on the diagram that their
text is overlapping and unreadable.  What can I do? In most cases, the best way to
deal with this is to manipulate the Horizontal Scale and the Distance from the left margin to the
first intersection to zoom in on the crowded section of the diagram.  TS/PP-Draft provides an
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easy way to do this: Move the mouse cursor between two intersections and left-drag a box around
the crowded intersections or a section of the diagram.  This changes the horizontal scale and the
distance from the left margin to the first intersection to effectively zoom in on the selected
intersections.  In this mode, think of the diagram as spanning multiple pages.  Use the Page Up & 
Page Down keys or the arrow buttons on the Tool Bar to jump from page to page.  When you
print, you have the option to print one or all pages.  There should be enough overlap between the
pages that you can tape them together to make one long diagram.

If you'd prefer the diagram fit all on one window or page, a combination of other options
should help:
1. Set the diagram Width to be as wide as necessary to separate the crowded intersections. 

If you want to print the diagram, set the width to the full width of the page.  If you don't
care about printing, set the width to be even wider.  As you change the diagram width,
TS/PP-Draft adjusts the Horizontal Scale, if it's not locked, to fill up the entire width of
the diagram -- the boundary intersections will be at the edges of the diagram without any
extra space.

2. Choose a smaller font size for the overlapping text.  For a very small font sizes, set the
font name to "Small Fonts."

3. When the text at the bottom of the diagram is overlapping, allow the text to straddle
multiple lines using the controls on the Preferences: Layout: Misc. page.

How do I delete a diagram file?  Simply delete the corresponding *.Dgm file in
Windows Explorer.

Modelling special situations

How do I model a school zone (with a reduced speed) beginning mid
block?  TS/PP-Draft allows you to change the downstream band Design Speed at signals, but
not between signals.  There are two options here:

1 Insert phantom intersections at the boundaries of the school zone (e.g., at 150 ft from the
actual intersection).  Set the through split along the artery to be 100% of the cycle length,
and name the intersections "SchZone" or "SZ" so you'll know what it is.  Then set the
band Design Speed downstream of the phantom intersections to the lower speed (e.g., 20
mph) in the appropriate directions of travel.  This will allow you to see a band on the
diagram with a kink in it marking the change of speed.

2 Calculate the average speed for the two links that include the school zone and set the
band Design Speed to that.  This will give a straight band on the diagram along the entire
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link, but the slope will correspond to the correct travel time.  The average speed is the
link distance divided by the total link travel time, so this works out to

SZ SZ SZAverage Speed = l / ( l /S  + (l - l )/S )
where

l is the total link length or distance between intersections

SZl  is the length of the school zone within the link (e.g., 150 ft.)

SZS  is the speed within the school zone (e.g., 20 mph)
S is the speed in the link outside the school zone

The units have to be converted to ensure consistency.

How do I model a diamond interchange? or Is there an easy way to model
two nearby signals working off a common controller?  The easiest way to work with a
diamond interchange is to enter it as two, nearby intersections with "linked" Offsets (explained
on page 106).  This way, the Offsets at the two intersections will move "as one."  For example,
suppose you have an North-South artery with a diamond interchange.  Then at the first intersec-
tion (at the Eastbound on- and off-ramps), set the protected Protected Turn Phase Sequence to
"None" in the Northbound direction, and to "Lead" (or "Lag") in the Southbound direction.  If the
signal is set so that the through traffic has a constant green after passing under the overpass, then
set the Southbound through Split to 100%.  Similarly, at the second intersection (at the West-
bound on- and off-ramps) set the protected cross-traffic turn  phase to "Lead" (or "Lag") in the11

Northbound direction and to "None" Southbound direction, and, if appropriate, set the North-
bound through Split to 100%.   Start by setting both Offsets to zero, link the intersections
(Offsets only), then set the Offset (at either intersection) to the correct value.  If the Offset
Reference Point is set to "Start of second through movement" at the two intersections and one (or
both) have a "Lead" protected cross-traffic turn phase, then start by setting the Offset equal to the
cross-traffic turn Split at whichever intersection(s) has/have the "Lead" protected cross-traffic
turn phase before linking the intersections.

If you wish, the nearby intersections can have other signal timings linked in addition to
the Offsets: Offset Reference Points, Adjusted Cycle Length, Splits (and whether the splits are
Fixed), Protected Turn and Pedestrian Phase Sequences, and With-traffic Turn on Red options. 
In this case, TS/PP-Draft ensures that all timing parameters for the two intersections remain
identical. You can change any one of these parameters at either intersection and TS/PP-Draft
makes the equivalent change at the other.

How do I set up time-space diagrams for three arteries that intersect
around a triangular block? or How do I handle an artery which changes direc-
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tions as it runs through my grid?  Suppose you have three arteries, A, B, and C, intersect-
ing around a triangular block as shown in the figure below.
1. In A's arterial diagram, set the Forward Direction to North. 

Set B's to East.
2. Set C's Forward Direction to either North or East, your

choice.  In the C arterial diagram, at the A intersection,
locally override the Forward Direction setting it to East, and
at the B intersection, locally override the Forward Direction
setting it to North.

3. Link everything between the arterial diagrams at their com-
mon intersections.

How do I declare a split phase, or phasing in
which the North-bound and South-bound movements do not overlap?  Set the
North-bound Protected Turn Phase Sequence to "Split-Lead", and that in the South-bound
direction to "Split-Lag". Set the North-bound and South-bound through Splits to their correct
values.

See the discussion below for information on how to declare North-bound and South-
bound movements which are not consecutive (that is, the North-bound movements are followed
by the West-bound movements, and the South-bound movements are followed by the East-bound
movements.

How do I set the phase sequence to indicate that the North-bound through
& left phase and the South-bound through & left phase are not consecutive? 
TS/PP-Draft doesn't have a straight-forward way to do this, but you can trick TS/PP-Draft into
simulating this on the diagram.  To do this, set the North-bound protected Protected Turn Phase
Sequence to "Lead", and that in the South-bound direction to "Lag".  Set the North-bound and
South-bound through Splits to their correct values.  Then set the North-bound cross-traffic turn12

Split to the sum of the North-bound through Split and the though Split of the phase (East or
West) that immediately follows the North-bound phase.  Similarly, set the South-bound cross-
traffic turn Split to the sum of the South-bound through Split and the though Split of the phase
(East or West) that immediately follows the North-bound phase.  For example, if the approaches
are served in the order North-bound, East-bound, South-bound, then West-bound, then both the
North- and South-bound cross-traffic turn Splits should be equal to their respective though Splits
plus the East-bound through Split.  When you use this trick, TS/PP-Draft will give incorrect
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values for the North- and South-bound cross-traffic turn Splits in the Intersection Parameters
dialog and on the reports of the parameters, but at least the diagram will look correct.

How do I declare an "overlapped" cross-traffic turn phase, that is, a
cross-traffic turn movement served by both leading and lagging phases?  Earlier
versions of TS/PP-Draft had no straight-forward way to do this.  Now you can simply set the
Protected Turn Phase Sequence to "Lead+Lag."

Troubleshooting

The "Lead-Lead" intersections are drawn in the wrong order with respect
to the "Lead-Lag" intersections on my diagram. Can you explain this?  Sure.  What
you're thinking of as green time is actually the red time, and vice versa.  The signals in TS/PP-
Draft's diagrams may be drawn differently from those that you're used to.  They're not like
PASSER's!  In TS/PP-Draft, the green time is shown in the background color and the red time is
shown in the foreground color.  This way, the green time (which does not impede traffic flow)
looks just the same as the space between the intersections (which also does not impede traffic
flow), and you can think of the foreground color or red time (the only thing that does impede
traffic flow) as obstacles or barriers to the through traffic.

What does this "Splits' sum not equal to Cycle Length" warning mean? 
This warning message occurs when the sum of the Splits (through, protected turn, and exclusive
pedestrian) is not equal to the Cycle Length.  There are two common causes of this warning:
1 You're not using the Splits Units you intend.  The splits may be measured in either

percent of the Adjusted Cycle Length or seconds.  When using percent, the sum of the
splits must be 100%; when using seconds, the sum of the splits must be the Adjusted
Cycle Length.

2 You have a protected cross-traffic turning movement in one direction and no protected
cross-traffic turn in the opposite direction, but you forgot to "include" the turn split in the
through split. In this case, the through split in the one direction should be equal to the
opposing through split plus the turn split.

Remember that the through Splits in the directions with Protected Turn Phases are
the total through Split in those directions.  That is, they should include the turn Split of
any shared turning phases. For example, when you have a protected cross-traffic turning
movement in one direction and no protected cross-traffic turn in the opposite direction,
you'll get this warning if you forget to include the turn Split in the through Split.  In this
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case, the through Split in the one direction should be equal to the opposing through Split
plus the turn Split.  You can use the rule Equal cross sums! While viewing the Splits in
the intersection parameters dialog, the through and turn Splits for opposing directions of
travel are displayed in the four corners of a box.  Regardless of the turning Phase Se-
quences (Lead, Lag, or None), the sums of the Splits in opposing corners of the box
should always be equal.

Actually, an exception to this rule occurs when the cross-traffic Turn Phase
Sequence is "Lead+Lag," in which case there are two cross-traffic  turn phases, one13

leading and one lagging the opposing through, and each will have its own Split.  In this
case, you'll need to sum the two corresponding turn Splits before applying the rule.

You may choose a strict test of the Splits of both rings summing to the Cycle Length or to
allow the splits of just one ring to sum to the Cycle Length.  The option is on the Desktop page of
the   Preferences dialog box.  Whichever test you use, the strict test or the more lenient test,
TS/PP-Draft will issue a warning to you if the test isn't passed.

I have a "Lead-None" intersection which is being drawn as a "Lead-Lag"
intersection on the diagram.  You probably have Splits whose sum is not equal to the Cycle
Length. As explained in answer to the previous question, the most common cause of this is
forgetting that the through Split in the direction with the protected cross-traffic turn  phase is the13

total through Split in that direction, that is, it should be equal to the sum of the opposing through
Split and the accompanying cross-traffic turn Split. You can think of these two numbers as "cross
sums": While viewing the Splits in the intersection parameters window, the through and turning
Splits for opposing directions of travel are displayed in the four corners of a box. Regardless of
the Turn Phase Sequences (Lead, Lag, or None) the sums of the Splits in opposing corners of the
box should always be equal. That is, cross sums should be equal!

Actually, an exception to this rule occurs when the cross-traffic Turn Phase Sequence is
"Lead+Lag," in which case there are two cross-traffic turn phases, one leading and one lagging
the opposing through, and each will have its own Split.  In this case, you'll need to sum the two
corresponding turn Splits before applying the rule.

I can't connect to my GPS receiver through my USB-to-Serial adapter.  Version
5.0 had a problem working with at least some USB-to-Serial adapters, but this problem was fixed
in version 6.0.

Although the different brands of USB-to-Serial adapters are not the same, every one that
I'm aware of works with TS/PP-Draft.  I'm not aware of any brands that don't work.  If it turns out
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that yours really doesn't work with TS/PP-Draft (but works fine with other programs), I'll swap
you, as I'd like to get my hands on one that doesn't work so I can use it for testing and debugging. 
If you don't want to swap, let me know what model you have, and I'll buy one for myself.

To date, every time a user has reported this problem with version 6.0, we've tracked it
down to something else:
• The wrong serial port was selected.  It seems that most USB-to-Serial adapters pick a

serial port other than COM1 or COM2.  Many pick COM4 or COM5.  In Windows'
Device Manager under Ports (COM & LPT) you should find the USB-to-Serial adapter
listed -- often that listing will tell you which serial port it's using.

• The wrong Type of GPS Receiver was selected.  This is a common problem with Garmin
GPS receivers.  The Garmins can communicate with TS/PP-Draft in either of two modes:
NMEA-compliant or Garmin (Proprietary).  While each of these modes has its advantages
and disadvantages, the important thing is that both the GPS receiver and TS/PP-Draft
agree on which mode to use.  By default, they don't agree.  Garmin receivers are set to the
Garmin (Proprietary) mode by default, and TS/PP-Draft is set to the NMEA-compliant
mode.  In the Garmin eTrex Legend, you can view (and change, if desired) the mode by
choosing Main Menu: Setup: Interface.

While tracking with the GPS receiver, I don't see my current position on
the diagram. or My recorded trip logs don't appear on the diagram.  You need to
set the Geographic Coordinates of the intersections.  To display your current position on a
diagram or the Network View, TS/PP-Draft needs two pieces of information: (1) where you are
now geographically, and (2) where the intersections are geographically.  Comparing these two,
TS/PP-Draft can tell where you are in relation to the signals on the diagram or the Network View
and show your position.  The same is true for displaying trip logs on a diagram or the Network
View, with the exception that the your geographic position is not "current."  At trip log is a
recorded series of geographic coordinates each with a time stamp.

The GPS receiver provides the first piece of information, where you are now geographi-
cally, whenever you're tracking.

You must provide the second piece of information, where the intersections are geographi-

cally, by clicking the  button in the Intersection Parameters window.  If you do
this while you're tracking with the GPS receiver, you may then click the

 button to take the current GPS reading as a measurement of the

intersection's coordinates.  Otherwise, you may click the   button to manually
enter the geographic coordinates of the center of the intersection.

For the purposes of displaying recorded trip logs as trajectories on a diagram or on the
Network View, or for generating a Travel Time & Delay Report, it doesn't matter which order
these two pieces of information are collected.  But for the purpose of seeing your current position
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displayed on the diagram or on the Network View while tracking with the GPS receiver, the
intersections' Geographic Coordinates must be collected first.

I recorded a trip log, but it's empty.  or  I connected my GPS and everything
seemed to work fine for a few minutes, but after a while, the connection stopped
working.  Turn off any power saving features of your laptop that might interrupt the serial port
connection.

While tracking with the GPS receiver, the marker on the diagram shows
me at the wrong point in the cycle.  For example, it shows me passing through a
signal just after it turned red, but actually I was well in the green time.  Assuming
the Cycle Length and Splits in TS/PP-Draft are set correctly, you need to synchronize the clocks
between the traffic signals and the GPS satellites.  Effectively, this tells the program when, in
absolute clock time, the network-wide zero occurs in the signal cycle.

The Travel Time & Delay Report says that my recorded trip log stops
before an intersection then resumes at the next intersection downstream. or The
TT&D Report says that my trip log started at intersection X, but it actually
started at the previous intersection upstream.  See How Trip Logs are Processed (page
131) for additional comments and definitions as background to this topic.

The general cause of this problem is that your trip log passes too far from where the
Geographic Coordinates of center of the intersection is declared to be located, so TS/PP-Draft
thinks that the trip bypassed the intersection (e.g., along a side street or through a parking lot). 
Any of a number of things can cause this, and each has its own solution.  Most of them can be
detected by carefully inspecting the Network View.  We'll consider them step by step.

1. Open the Network View.  If you see the trip log plotted on the Network View (as a thin,
blue line), then skip to Step 4.

2. Right-click on the Network View.  If the command "Layout Grid with GPS" is grayed
out, then there is one or more intersections whose Geographic Coordinates have not yet
been specified.  To display your trip logs on a diagram or the Network View, TS/PP-Draft
needs two pieces of information: (a) your geographic position at a series of times, and (b)
where the intersections are geographically.  Comparing these two, TS/PP-Draft can tell
where you travelled in relation to the signals on the diagram and show your path.

The trip logs provide the first piece of information, your geographic position at a
series of times.

You must provide the second piece of information, where the intersections are

geographically, by clicking the  button in the Intersection Parameters
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window.  If you do this while you're tracking with the GPS receiver, you may then click

the  button to take the current GPS reading as a measurement

of the intersection's coordinates.  Otherwise, you may click the  button
to manually enter the geographic coordinates of the center of the intersection.

For the purposes of displaying recorded trip logs as trajectories on a diagram or on
the Network View, or for generating a Travel Time & Delay Report, it doesn't matter
which order these two pieces of information are collected.  But for the purpose of seeing
your current position displayed on the diagram or on the Network View while tracking
with the GPS receiver, the intersections' Geographic Coordinates must be collected first.

3. Right-click on the Network View and choose "Layout Grid with GPS."  This should make
the trip logs visible on the Network View.

4. Since the trip log is visible in the Network View, we know that it's a least reasonably
close to the declared coordinates of the center of the intersections.  The problem, then, is
it's not quite close enough.  Make sure that the nodes in the Network View are roughly
where you expect them with respect to the trip log.  If there's one outlying node, then it's
possible that the geographic coordinates of that intersection is incorrectly specified, either
because the wrong value was entered or because you took a GPS reading on one side of
the intersection but forgot to take a corresponding reading on the opposite side.  See Step
2 for more information about specifying the Geographic Coordinates of the intersections.

5. Right-click on the Network View and check the item "Show Intersection Extents" to view
the effective extent of the intersections.  This is a circle centered at the intersection with a
radius equal to the half-width of the intersection.  A trip log must cross this region to
count as passing through the intersection.  Viewing the extent makes it easier to diagnose
why a trip log is either skipping an intersection or passing through one twice. You can
also detect when an extent is too large, usually due to a bad or misplaced coordinate
measurement.

6. Make sure the Number of Lanes and Lane Widths are set correctly at each intersection for
each direction of travel along the artery.  TS/PP-Draft uses these numbers to estimate the
intersection width.

7. If the problem still persists, it might be that there's a fairly wide median unaccounted for
in the intersection width estimate.  At present, TS/PP-Draft has no provision for you to
enter the median width directly, but you can effectively enter the total intersection width. 
Do this by using the GPS receiver connected to the computer and clicking the

 button to add measurements for the geographic coordinates of
the center of the intersection, as discussed in Step 2.  Add the measurements in pairs,
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straddling the intersection.   It's usually best to walk the four corners of the intersection,
adding the GPS reading at each corner as a measurement.  If you prefer to do this while
riding along in a vehicle, be sure the vehicle is driving along the outside lane in each
direction.

8. If the problem still persists, and if you manually entered the geographic coordinates of the
intersections, then there are several likely errors.
a. It might be that you took GPS measurements for the geographic coordinates of the

intersections while travelling in one direction, but forgot to match these with GPS
measurements while travelling in the opposite direction.  If this is the case, it
should be evident in the display of the trip log on the Network View.  If the
intersection coordinates are specified with just one GPS reading, there will be an
overall bias, and trip logs in both directions of travel will probably be off to one
side -- the same side -- of the node centers.  If this is the case, you'll need to travel
the artery in the opposite direction, specifying the geographic coordinates of each
intersection using the GPS receiver, as discussed in Steps 2 and 6.  Remember
that it's best to add GPS readings in pairs that straddle the intersection center.

b. It might be that the geographic coordinates of the intersections are specified using
a different geodetic datum than the trip log.  Most GPS receivers use WGS-84 by
default, and if you manually the geographic coordinates of the intersections, you
may have used a different geodetic datum.  If this is the case, it should be evident
in the display of the trip log on the Network View.  Does the trip log pass each
node near its center or on the correct side of the node, depending on the Drive
Rule?  If the intersection coordinates are in a different geodetic datum than the
trip log, there will be an overall bias, and trip logs in both directions of travel will
probably be off to one side -- the same side -- of the node centers.  If this is the
case, you'll need to respecify the geographic coordinates of each intersection using
the GPS receiver, as discussed in Steps 2 and 6.  This will ensure you're using the
same geodetic datum for both the coordinates and the trip logs.  It's best to add
GPS readings in pairs that straddle the intersection center.

c. It might be that the geographic coordinates of the intersections are specified with
insufficient precision.  A precision of about 0.0002 minutes of arc, which corre-
sponds to about 1 foot (30.5 cm) north and south, should be sufficient.  If this is
the problem, it should also be evident in the display of the trip log on the Network
View.  The trip log will tend to pass fairly far from the center of each node,
missing it by varying distances, sometimes passing to the right and other times
passing to the left.  If this is the case, you'll need to respecify the geographic
coordinates of each intersection using sufficient precision.

9. If the problem still persists, I probably haven't made TS/PP-Draft sufficiently tolerant of
the imprecision of GPS readings.  Please let me know, and send me your diagram data
file, so I can fix this problem.
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I've just recorded some trip logs, but I don't see them on the Network
View.  There are several things that can cause this.

1. Make sure you've set the Geographic Coordinates of the intersections.  To display your
trip logs on a diagram or the Network View, TS/PP-Draft needs two pieces of informa-
tion: (1) your geographic position at a series of times, and (2) where the intersections are
geographically.  Comparing these two, TS/PP-Draft can tell where you travelled in
relation to the signals on the diagram and show your path.

The trip logs provide the first piece of information, your geographic position at a
series of times.

You must provide the second piece of information, where the intersections are

geographically, by clicking the  button in the Intersection Parameters
window.  If you do this while you're tracking with the GPS receiver, you may then click

the  button to take the current GPS reading as a measurement

of the intersection's coordinates.  Otherwise, you may click the  button
to manually enter the geographic coordinates of the center of the intersection.

For the purposes of displaying recorded trip logs as trajectories on a diagram or on
the Network View, or for generating a Travel Time & Delay Report, it doesn't matter
which order these two pieces of information are collected.  But for the purpose of seeing
your current position displayed on the diagram or on the Network View while tracking
with the GPS receiver, the intersections' Geographic Coordinates must be collected first.

2. Right-click on the Network View and choose "Layout Grid with GPS."  If this command
is grayed out, then there is one or more intersections whose Geographic Coordinates have
not yet been specified.  (See item (1) above).

When I import UTDF files, my artery is split into two or more sub-arter-
ies.  What should I do?  I know of several things that can cause this.

(1) Make sure you're using the current version of TS/PP-Draft.  Version 4.0.0.11 fixed a
problem that could occur at Y intersections -- in tracing the artery through the intersection, the
program could sometimes have trouble choosing which two legs have the through movements
and which one is the side street.

You can check which version of TS/PP-Draft you're using with the About command in
the Help Menu.  Then check the web site www.tsppd.com for the latest version.  If necessary,
you can download the file www.tsppd.com/SetupTSPPD5.Zip and install it (by extracting
the files to a temporary folder and running the Setup program in that folder).
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(2) If you've divided your network into "zones" in Synchro, and you're writing just one
zone to the UTDF files, make sure every node (including bends!) along the artery is in that zone. 
It's easy to forget to assign a zone to a bend, and in this case, Synchro won't include the bends as
declared nodes in the Layout file, but they'll be referenced as connecting nodes of the neighbor-
ing intersections.  TS/PP-Draft will find some intersections referencing nonexistent (or unde-
clared) nodes, and will have to split the artery there.

(3) A problem can arise at a K intersection.  Whenever TS/PP-Draft encounters a 4-
legged intersection in a UTDF file, it assumes that the movements from each approach to
adjacent legs are turning movements.  This assumption isn't correct at a K intersection, and the
program will end up splitting an artery there.  I haven't decided how to fix this one yet, and if
you're interested in discussing it with me, I would welcome your thoughts.

When I import UTDF files, the streets don't have names.  Make sure the
Layout data file is a .CSV (comma separated variable) style file. The .DAT-style file for Layout
data doesn't contain any street names in it, only the .CSV-style file has street names.  See page
133 for more details.

When I try to view a timings report, I get an error message "The filename,
directory name, or volume label syntax is incorrect."  
or 

When I try to print a diagram or a timings report, I get an error message "The
filename, directory name, or volume label syntax is incorrect."  You probably don't
have a printer driver installed for your operating system.  To generate a preview of the timings
report, TS/PP-Draft must query the printer driver for some properties of your printer.  If the
operating system has no printer installed, these queries return this error message.

To install a printer driver, click on the My Computer icon on the desktop, and select
Printers: Add Printer.

I can't run TS/PP-Draft.  When I try to start it, it immediately closes.  Or it
warns me that it's running in Demo mode, but closes as soon as I click OK. 
Version 6.0 needs a printer driver installed to initialize of its report generator.  Make sure you
have a printer driver installed.  If you don't have a printer, then "install" any printer driver to a
File (instead of on the network or parallel or serial port).  I like installing a Postscript printer
(e.g., the HP 4550 Color PS) to a file because it gives me an easy way to create pdf files.

One user reported this problem even though he already had a printer installed.  It turned
out that when he selected a different printer as the default, everything worked just fine.  We're
not sure what was wrong with the original default printer.  Also, when he installed a Postscript
printer to a file and selected that as the default, everything worked fine.
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Notes on Compatibility

Speech Recognition Engine.  TS/PP-Draft uses SAPI 5 (Speech Application
Programming Interface version 5) to interact with the speech recognition engine. Various
incarnations of MS Office XP include Speech Tools by default, which has an SAPI 5 compatible
speech recognition engine. Speech Tools is accessible from the Control Panel. See the operating
system's online help for more details on installing and using the Speech Tools. If you don't
already have one, the TS/PP-Draft 6.0 installation CD also includes Microsoft's free SAPI 5
speech recognition engine. This engine is a bit too large to include in the downloadable version
of TS/PP-Draft, but if you ask me, I'll email it to you.

Mapping Software.  You can import and, in some cases, export the geographic
coordinates of the intersection into mapping software.  The coordinates appear on the map as
push pins or bubble labels. For exporting coordinates, you create the pushpins in the mapping
software and label them.  Be sure to include the intersection ID Number near the beginning of the
label.

Although I'm sure there are others out there, I've tried only two:
• Microsoft Streets & Trips  -- This one tends to have considerably more accurate maps

than the DeLorme product, but the 2002 version can only import the intersection coordi-
nates; it can't export.  One user has reported that other versions (2003, and 2000) are
similarly restricted, and the 2000 version could export, but only in a proprietary file
format.  Also, connecting the GPS receiver to perform live navigation is not practical, as
the software accepts a GPS reading only once every 15 or 16 seconds.

• DeLorme Street Atlas -- This one can both import and export the intersection geographic
coordinates.  When you create points for exporting coordinates, be sure to include the
intersection ID Number in the label (if there's more than one number in the label, let the
ID Number be the first).  This way, TS/PP-Draft will be able to import the geographic
coordinates.  I found the user interface for importing and exporting to be pretty non-
intuitive -- it was difficult to figure out how to do it at first.  The live navigation with a
GPS receiver works well, but the maps tend to be considerably less accurate than the
Microsoft product.

GPS Receiver.  Compatible GPS receivers include any receiver that complies with the
NMEA (National Marine Electronics Association) 0183 Standard and the (serial cable version or
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the USB version of the) Earthmate from DeLorme (available for around $125). The majority of
GPS receivers comply with the NMEA 0183 Standard. TS/PP-Draft has been tested with GPS
receivers from Magellan, Garmin, and Pharos and they all work great for the most part. DeLorme
has a USB version of the Earthmate. One can download "COM Port Emulation Drivers for the
USB Earthmate GPS Receiver" from the DeLorme web site that should allow it to operate with
TS/PP-Draft, but I haven't verified this yet.  If you don't have a USB port, DeLorme also sells a
serial interface cable, but I suspect that any serial to USB adaptor will work just as well. See the
discussion under GPS Setup Page for more information.

Arterial Analysis Package.  TS/PP-Draft provides you a means of cooperating with
the Arterial Analysis Package (AAP).  You can open and save *.AAP files directly in TS/PP-
Draft.  This lets you look at and modify AAP data directly from within TS/PP-Draft, and it gives
you an easy way to transfer TS/PP-Draft diagram data to the AAP.  For a discussion on opening
and saving files (including AAP files), see page 113.
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A cross-traffic turn is a 
14

• left-turn in right-hand Drive Rule regions (North & South America, China and continental Europe).
• right-turn in left-hand Drive Rule regions (Great Britain, Australia, New Zealand, South Africa, and much of

Asia).
See page 127 for details.
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Appendix A

Changing this: Will change this: To this default value:

Horizontal
Scale

Distance to first intersection
from left margin

Such that the first intersection is just next to
the left margin.

Cycle Length Vertical Scale (if it isn't locked) Such that exactly the desired number of Cy-
cle Lengths are displayed on the diagram.

Width of the green band(s) The Split of the corresponding movement(s)
(through or cross-traffic turn ), minus the14

Start Up and Clearance Lost Times, at the
intersection(s) where the green band(s)
originates.

Start Up Lost
Time

Offset and width of the green
bands(s)

The Offset & Width of the green time of the
corresponding movement(s) (through or
cross-traffic turn), minus the Start Up and
Clearance Lost Times, at the intersection
where the green band(s) originates.

Clearance Lost
Time

Width of the green band(s) (See above description)

One-way Protected Turn Phase Sequences
of all the intersections (if the
One-way box is checked)

"None" (one-way street, no separate cross-
traffic turning movements)
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Distance bet-
ween two
intersections,
adding an inter-
section, or 
cutting a
boundary inter-
section.

Horizontal Scale (if the intersec-
tion is not the first one and the
Scale is unlocked)

Such that all the intersections may be seen
on the screen without any "extra" space.

Distance to first intersection
from left margin

Such that the first intersection is just next to
the left margin.

Offset, Refer-
ence point for
Offsets

Offset of the green band(s) (See above description)

Adjusted Cycle
Length

Width of the green band(s) (See above description)

Offset of green band (at boun-
dary intersections only)

(See above description)

Splits Offset & width of the green
band(s)

(See above description)

The Split of the overlapping
movement (if using split phas-
ing)

Sets it to be equal.



User's Manual

Changing this: Will change this: To this default value:

161

Protected Turn
Phase
Sequence

Offset of the green band(s) (See above description)

The Protected Turn Phase Se-
quence in the opposite direction
and the Splits of the overlapping
movements (if using split phas-
ing)

Sets the opposing Protected Turn Phase Se-
quence to be the opposite (Split-Lead or
Split-Lag) and sets the Splits of the overlap-
ping movements to be equal.

Minimum
Splits and
Clearance
Times

The Minimum Splits and Clear-
ance Times of  the overlapping
movements (if using split phas-
ing)

Sets it to be equal.

Through Ideal
Saturation flow

Downstream Saturation Flow Sets it to match the total through Saturation
Flow.

Number of
Through Lanes


